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Foreword
Microsoft Excel debuted 30 years ago in 1985. It wasn't the first spreadsheet program – VisiCalc had de-
buted in 1979. It certainly wasn't the most popular spreadsheet program – Lotus 1-2-3 had 89% market 
share by the late 1980s. But Microsoft had one thing in its favor – it was based on a graphical interface 
from the beginning. There was never a DOS-style text-based version of Excel. 

If you had a long view in 1985, going with a GUI from the beginning was brilliant. But it had to be painful 
in 1985, originally on the Mac and then in early versions of Windows. The computing power was not fast 
enough to repaint the screen. In many cases, Lotus 1-2-3 would calculate ten times faster than Excel.

It wasn’t until the mid-1990s, when computing power caught up, that Excel became a viable contender. 
1993 to 1997 were some golden years in spreadsheet development. Every new version of Lotus 1-2-3 and 
Excel introduced some killer features. Pivot tables, subtotals, new functions and VBA macros all debuted in 
Excel during this period.

As Excel battled for market share, Microsoft had to make sure that they were 100% compatible with Lotus 
1-2-3. That meant making the same mistakes as Lotus (there was no February 29 in 1900) and replicating 
all of the less-than-useful functions used in Lotus.

In the course of writing Special Edition Using Excel 2007, I had to research and document every single func-
tion in Excel. There were some that were hard to explain (FACTDOUBLE and SQRTPI) and some that were 
easy to explain but left you scratching your head. For example, who in real life could use the =ROMAN() 
function? I guess the Vatican could use =ROMAN in naming future popes. Movie production companies 
could use =ROMAN() to put the copyright at the end of the movie credits. And the NFL folks could use 
=ROMAN() to figure out the names of the upcoming Super Bowls. That is not a big audience of Excellers 
who could find a use for =ROMAN().

I am frequently on the road, doing half-day or all-day Power Excel seminars for groups like the Institute of 
Managerial Accountants or the Institute of Internal 
Auditors. I love these live seminars. The right tip will 
help someone save an hour a week – 50 hours a year. I 
often interject some humor. I have a variety of spread-
sheet quips and gags that get added to the seminar. 
One that I used many years ago: “If you have to present 
bad financial news, Excel has a function for you: Hide 
column B, and you can escape the president’s office 
before he figures out what is going on." It brings laugh-
ter every time.

I keep a spreadsheet listing the books I've authored. It was a few years ago that I realized I would soon be 
writing book #40, and that the =ROMAN(40) is XL.
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Illustration: Chank Diesel

I figured this would be a milestone – and thus this book was born. My 40 favorite Excel tips. Some good 
Excel stories. Szilvia Juhasz added 30 more Excel tips to coincide with the 30th birthday of Excel. There are 
some Excel jokes from Jordan Goldmeier, some tweets collected by Debra Dalgleish, and an awesome col-
lection of Excel-themed cocktails from Szilvia Juhasz.

The spreadsheet in 2015 has a promising future. Yes, Excel is again facing competition from Google Docs 
and Tableau. But that competition brings innovation. Look at the amazing new features like Power Pivot, 
the feature formerly known as Power Query, and 3D Maps that have debuted since 2010. It is another 
golden age for spreadsheet development.

Introduction
This book is broken into these sections.

Part 1 – Bill’s Top 40 Tips - my favorite 40 tips that I cover in my Power Excel seminars.

Part 2 – 40 Keyboard Shortcuts - so many of the votes from the readers were for keyboard shortcuts that 
they are all provided together.

Part 3 – 30 More Tips for the 30th Anniversary of Excel. Szilvia Juhasz adds her favorite tips and tips from 
readers.

Part 4 – Excel Fun - Excel cocktails, jokes, tweets, and stories.

The files used in this book are available for download from mrx.cl/40bookfiles.

You will see a number of shortlinks in this book in the format of mrx.cl/short. The idea is that it will be 
easier for you to type mrx.cl than a long URL.  (Thanks Felix Jelen in Chile for securing the .cl suffix for me.)

Bill will do videos to go with each of his 40 tips. Search at http://mrx.cl/billonyoutube.

Illustration: Em DeMarco
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Part 1 - Bill’s Top 40 Tips
#1 Double-Click the Fill Handle to Copy a Formula
You have thousands of rows of data. You’ve added a new formula in the top row of your data set, some-

thing like this =PROPER(A2&" "&B2), 
as shown below. You now need to 
copy the formula down to all of the 
rows of your data set.

Many people will grab the Fill 
Handle and start to drag down. 
But as you drag down, Excel starts 
going faster and faster. Starting in 
Excel 2010, there is a 200-microsec-
ond pause at the last row of data. 
200 microseconds is long enough 
for you to notice the pause but not 
long enough for you to react and 

let go of the mouse button. Before you know it, you’ve dragged the Fill Handle way too far.

The solution is to double-click the Fill Handle! Go to exactly the same spot where you start to drag the Fill 
Handle. The mouse pointer changes to a black plus sign. Double-click.

Excel looks at the surrounding data, finds the last row with data today, 
and copies the formula down to the last row of the data set.
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In the past, empty cells in the column to the left would cause the “double-click the Fill Handle” trick to stop 
working just before the empty cell. But as you can see below, names like Madonna, Cher, or Pele will not 
cause problems. Provided that there is at least a diagonal path (for example, via B76-A77-B78), Excel will 
find the true bottom of the data set.

In my live Power Excel seminars, this trick always elicits a gasp from half the people in the room. It is my 
number-one time-saving trick.

Alternatives to Double-Clicking the Fill Handle

This trick is an awesome trick if all you've done to this point is drag the Fill Handle to the bottom of the 
data set. But there are even faster ways to solve this problem:

●● Use Tables. If you would select one cell in A1:B112 and press Ctrl+T, Excel will format the range as a 
table. Once you have a table, simply enter the formula in C2. When you press Enter, it will be copied to 
the bottom.

●● Use a complex but effective keyboard shortcut. This shortcut requires the adjacent column to have no 
empty cells. While it seems complicated to explain, the people who tell me about this shortcut can do 
the entire thing in the blink of an eye.

Here are the steps:

1. From your newly entered formula in C2, press the Left Arrow key to move to cell B2.

2. Press Ctrl+Down Arrow to move to the last row with data. In this case, B112.

3. Press the Right Arrow key to return to the bottom of the mostly empty column C.
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4. From cell C112, press Ctrl+Shift+Up Arrow. This selects all of the blank cells next to your data, plus the 
formula in C2.

5. Press Ctrl+D to fill the formula in C2 to all of the blanks in the selection. (Note that Ctrl+R fills right, 
which might be useful in other situations.)

As an alternative, you can get the same results by pressing Ctrl+C before step 1 and replacing step 5 with 
Ctrl+V.
Thanks to the following people who suggested this tip: D. Carmichael, Shelley Fishel, Dawn Gilbert, @Knutsford_admi, Francis 
Logan, Michael Ortenberg, Jon Paterson, Mike Sullivan and Greg Lambert Lane suggested Ctrl+D. Bill Hazlett, author of Excel for 
the Math Classroom, pointed out Ctrl+R. It was Em DeMarco's cartoon posted on Twitter that was the inspiration for hiring illustra-
tors for this book.
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#2 Filter by Selection
The filter dropdowns have been in Excel for decades, but there is a much faster way to filter. Normally, you 
select a cell in your data, choose Data, Filter, open the dropdown menu on a column heading, uncheck 
Select All, then scroll through a long list of values, trying to find the desired item.

Microsoft Access invented a concept called Filter by Selection. It is simple. Find a cell that contains the 
value you want. Click Filter by Selection. The filter dropdowns are turned on, and the data is filtered to the 
selected value.

Nothing could be simpler.

Guess what? The Filter by Selection trick is also built into Excel, but it is hidden and mislabeled.

Here is how you can add this feature to your Quick Access Toolbar. Look at the top left of your Excel screen 
for the tiny row of icons with Save, Undo, and Redo. 
Right-click any of those icons and choose 
Customize Quick Access Toolbar.

There are two large listboxes in the dialog. Above 
the left listbox, open the dropdown and change 
from Popular Commands to Commands Not In the 
Ribbon.

In the left listbox, scroll to the command called 
AutoFilter and choose that command. That’s right – the icon that does Filter by Selection is mislabeled as 
AutoFilter.

In the center of the dialog, click the Add>> button. The AutoFilter icon will move to the right listbox. Click 
OK to close the dialog.
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Here is how to use the command. Say that you want to see all West region sales of Widgets. First, choose 
any cell in column B that contains West. Click the AutoFilter icon in the Quick Access Toolbar. 

Excel turns on the filter dropdowns and automatically chooses only West from column B. 

Next, choose any cell in column E that contains Widget. Click the AutoFilter icon again.
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You could continue this process. For example, choose a Utilities cell in the Sector column and click 
AutoFilter.

Caution: It would be cool if you could multi-select cells before clicking the AutoFilter icon, but this 
does not work. If you need to see sales of Widgets and Gadgets, you could use Filter by Selection 
to get Widgets, but then you have to use the Filter dropdown to add Gadgets. Also. Filter by 
Selection does not work if you are in a Ctrl+T table.

How can it be that this cool feature has been in Excel since Excel 2003, but Microsoft does not document 
it? It was never really an official feature. The story is that one of the developers added the feature for inter-
nal use. Back in Excel 2003, there was already a Filter icon on the Standard toolbar, so no one would bother 
to add the apparently redundant AutoFilter icon.

Of course, this feature was added to Excel 2007’s right-click menu, but three clicks deep: Right-click a 
value, choose Filter, then choose Filter by Selected Cell’s Value.

Bonus Tip: Total Visible
After you’ve applied a filter, it would be great to see the total of the visible cells.

Select the blank cell below each of your numeric columns. Click the AutoSum button.
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Instead of inserting SUM formulas, Excel inserts =SUBTOTAL(9,…) formulas. The formula below shows you 
the total of only the visible cells.

Insert a few blank rows above your data. Cut the formulas from below the data and paste to row 1 with the 
label of Total Visible.

Now, as you change the filters, even if the data fills up more than one full screen of data, you will see the 
totals at the top of your worksheet.
Thanks to Sam Radakovitz on the Excel team for Filter by Selection – not for suggesting Filter by Selection, but for formalizing 
Filter by Selection!
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#3 The Fill Handle Does Know 1, 2, 3…
Why does the Excel Fill Handle pretend it does not know how to count 1, 2, 3?

The Fill Handle is great for filling months, weekdays, quarters and dates. Why doesn’t it know that 2 comes 
after 1?

In case you’ve never used the Fill Handle, try this: Type a month name in a cell. Select that cell. In the lower-
right corner of the cell is a square dot. Click the dot and drag right or drag down. The tooltip increments to 
show the last month in the range.

When you let go of the mouse button, the months will fill. An icon appears giving you additional options.
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The Fill Handle works great with months, 
days…

The fill handle works with quarters in many 
formats:

To do both quarters and years, you have to 
start with a number, then Q, then any punctua-
tion (period, space, apostrophe, dash) before 
the year.

But when you type in 1 and grab the Fill Handle, Excel gives you 1, 1, 1, 1, 1, …. Many 
people tell me to enter the 1 and the 2, select them both, then drag the Fill Handle. 
But there is a faster way. 

The secret trick is to hold down Ctrl! If you hold down Ctrl while dragging, Excel will 
fill 1, 2, 3.

Note: Huntsville Alabama’s Andrew Spain of Spain Enterprise taught me a cool variation on this 
trick. If you start dragging without Ctrl, you can press Ctrl during the drag. A+icon appears at the 
bottom of the drag rectangle to indicate that you are going to fill instead of copy.

How were we supposed to figure out that Ctrl makes the Fill Handle count instead of copy? I have no idea. 
I picked up the tip from Row 6 at an IMA seminar in Kent, Ohio. It turns out that Ctrl seems to make the Fill 
Handle behave in the opposite way. If you Ctrl+drag a date, Excel will copy instead of Fill.

I've heard another trick: type 1 in A1. Select A1 and the blank B1. Drag. Excel fills instead of copies.
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Right-Click the Fill Handle for More Options

If you right-click and drag the Fill Handle, a menu appears with more options, like Weekdays, Months, and 
Years. This menu is great for dates.

What if your payroll happens on the 15th and on 
the last day of the month? Put in both dates. Select 
them both. Right-click and drag the Fill Handle. 
When you finish dragging, choose Fill Months.

Teach the Fill Handle a New List

The Fill Handle is a really handy tool. What if you could use it on all sorts of lists? You can teach Excel a new 
list, provided that you have anywhere from 2 to 240 items. Here is the easy way:

1. Type the list in a column in Excel.

2. Select the list.

3. Select File, Options, Advanced. Scroll almost to the bottom, and click Edit Custom Lists.



THE TOP 40	 11 

1

In the Custom Lists dialog, click Import.

Excel will now understand your list as well as it 
understands Sunday, Monday, Tuesday.

Type any item from the list 
(it does not have to be the 
first item).

Grab the Fill Handle and 
drag. Excel will fill from 
your list.

I use this trick for lists that should be in Excel, such as a list of the U.S. States and a list of the letters of the 
alphabet.
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Bonus Tip: Fill 1 to 100,000 in a Flash

What if you have too many items to drag the Fill 
Handle? Follow these steps:

1. Type the number 1 in a cell.

2. Select that cell.

3. On the Home tab, toward the right, in the Editing 
group, open the Fill dropdown and choose Series.

4. Select Columns.

5. Enter a Stop Value of 100000.

6. Click OK.

What if you have to fill 100,000 cells of bagel flavors?

1. Type the first bagel flavor in A1.

2. Select A1.

3. Type A100000 in the Name box and press Shift+Enter. This selects from the current cell to A100000.

4. Home, Fill, Series…. Click AutoFill in the Type box.
 Thanks to the young lady in row 6 at the Meonske Conference in Kent, Ohio for suggesting this feature.

#4 Fast Worksheet Copy
Yes, you can right-click any sheet tab and choose Move or Copy to make a copy of your worksheet. But that 
is the very slow way to copy a worksheet.

The fast way: Hold down the Ctrl key. Drag the worksheet tab to the right.

The downside of this trick is that the new sheet is called January (2) instead of February – but that is the 
case with the Move or Copy method as well. In either case, double-click the sheet name and type a new 
name.
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Ctrl+drag February to the right to create a sheet for March. Rename February (2) to March.

Select January. Shift-select March to select all worksheets. Hold down Ctrl and drag January to the right to 
create three more worksheets. Rename the three new sheets.

Select January. Shift-select June. Ctrl+Drag January to the right, and you’ve added the final six worksheets 
for the year. Rename those sheets.

Using this technique, you can quickly come up with 12 copies of the original worksheet.

Illustration: Walter Moore

Bonus Tip: Worksheet Name in a Cell
If you want each report to have the name of the worksheet as a title, use 

=TRIM(MID(CELL("filename",A1),FIND("]",CELL("filename",A1))+1,20)) &" 
Report"

The CELL() function in this case returns the full path\[File Name]SheetName. By looking for the right square 
bracket, you can figure out where the sheet name occurs.

Now You Are Making Copies Too Quickly

You've heard of the  Manager's 15 minute rule, right? Any time your manager asks you for something, he 
or she comes back 15 minutes later and asks for an odd twist that he or she did not specify the first time. 
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Now that you can create worksheet copies really quickly, there is more of a chance that you will have to 
make changes to all 12 sheets instead of just one sheet, when your manager comes back.

I will show you an amazingly powerful but incredibly dangerous tool called Group mode.

At this point, you have 12 worksheets that are mostly identical. You need to add totals to all 12 worksheets. 
To enter Group mode, right-click on the January tab and choose Select All Sheets.

The name of the workbook in the title bar now indicates you are in Group mode.

Anything you do to the January worksheet will now happen to all the sheets in the workbook.

Why is this dangerous? Because if you get distracted and you forget that you are in group mode, you 
might start entering January data and overwriting data on the 11 other worksheets!

When you are done adding totals, don’t forget to right-click a sheet tab and choose Ungroup Sheets.

Bonus Tip: Create a SUM that Spears Through All Worksheets
So far, you have a workbook with 12 worksheets, one for each month. All of the worksheets have the 
same number of rows and columns. You want a Summary worksheet in order to total January through 
December.

The formula is =SUM(January:December!B4).
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la would have to include apostrophes around the sheet names: =SUM('Jan 2018:Mar 2018'!B4)

Thanks to Othneil Denis for suggesting 3D formula and Olga Kryuchkova for suggesting Group mode.

#5 Compare Sheets Side by Side with Synchronous Scrolling
This feature appeared in Excel 2003 with very little fanfare. Say that you have two workbooks that you 

want to compare side by side. You aren’t 
looking for a VLOOKUP, but just want to 
“eyeball” the two workbooks. Open both 
workbooks. On the View tab, choose View 
Side by Side.

For whatever reason, Excel defaults to ar-
ranging the first workbook in the top half 
of the screen and the second workbook 
in the bottom half of the screen, which 

clearly means that someone on the Excel team does not know the meaning of “Side by Side.” 

The command doesn’t say, “View One Above the Other,” does it? While this choice annoys me, it is easy 
enough to truly get them side by side: Just select View, Arrange All, 
Vertical, OK.

At this point, one workbook is on the left half of your monitor, and 
the other workbook is on the right half. I have this monster 1080p 
monitor, which means that each workbook is only taking up a quar-
ter of the screen real estate. So, for those of you with monitors more 
than twice as wide as your worksheet, hover over the right edge of 
the left workbook. You will see the mouse pointer below. Click and 
drag left. 

Then drag the left edge of the right workbook to the left.
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You end up with this arrangement of the two workbooks:

But this is nothing new. Excel 97 offered Arrange All Vertical. There is the big difference, though:

Grab the scrollbar and scroll the right workbook down so it starts at row 8. Miraculously, the left workbook 
scrolls at the same rate, and both workbooks are showing row 8 through 17.

This is great, until one workbook adds or deletes a row.

Then, things are out of sync. The Harlem Globetrotters were added on the left, so now we need row 19 on 
the left and row 18 on the right to scroll together.

The key is to temporarily turn off Synchronous Scrolling. This was turned on when you used View Side by 
Side. It is in the View tab, in the Window group, but these three icons collapse when the Excel window nar-
rows, so you are likely to only see the icons, and not the words.
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Turn off Synchronous Scrolling. Get the two workbooks lined up again. Turn on Synchronous Scrolling. As 
shown below, row 26 on the left is matched with row 25 on the right.

As you continue to scroll, the rows will remain lined up.

Can I Compare Sheet1 and Sheet2 of the Same Workbook?

Yes. Make sure you only have one workbook open. From the View tab, select New Window. It now appears 
that you have two workbooks open. One has :1 in the title bar, and one has :2 in the title bar. Select Sheet1 
in :1 and Sheet2 in :2. Follow the View Side by Side steps from above. You will now be able to see both 
worksheets of the workbook side by side. When you are done, go to the :2 version of the file and click the X 
in the top right to close that window.

Note: You have not opened a second copy of the workbook. Think of the :2 as a second camera 
pointed at a different section of the workbook. 

Thanks to Anne Walsh, author of Your Excel Survival Kit, for suggesting this feature.
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#6 Turning Data Sideways with a Formula
Someone built this lookup table sideways, stretching across C1:N2. I realize that I could use HLOOKUP in-
stead of VLOOKUP, but I prefer to turn the data back to a vertical orientation.

Copy C1:N2. Right-click in A4 and choose the Transpose option from the Paste Options. Transpose is the 
fancy Excel word for “turn the data sideways.”

Illustration: Emily Jones

I transpose a lot. But I use Alt+E,S,E,Enter to transpose instead of the right-click.

There is a problem, though. Transpose is a one-time snapshot of the data. What if you have formulas in the 
horizontal data? Is there a way to transpose with a formula?

The first way is a bit bizarre. If you are trying to transpose 12 horizontal cells, you need to select 12 vertical 
cells in a single selection. Start typing a formula such as  =TRANSPOSE(C2:N2) in the active cell but do not 
press Enter. Instead, hold down Ctrl+Shift with your left hand and then press Enter. This puts a single array 
formula in the selected cells. This TRANSPOSE formula is going to return 12 answers, and they will appear 
in the 12 selected cells.

As the data in the horizontal table changes, the same values will appear in your vertical table.

www.allitebooks.com

http://www.allitebooks.org
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But array formulas are not well known. Some spreadsheet rookie might try to edit your formula and forget 
to press Ctrl+Shift+Enter.

To avoid using the array formula, use a combination of INDEX and ROW, as shown below. =ROW(1:1) is a 
clever way of writing the number 1. As you copy this formula down, the row reference changes to 2:2 and 
returns a 2. 

The INDEX function says you are getting the answers from C2:N2, and you want the nth item from the 
range.

In the figure below, =FORMULATEXT in column C shows how the formula changes when you copy down.

Thanks to Excel Ace and Tracia Williams for suggesting this feature.
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#7 Default Settings for All Future Workbooks
Do you have favorite worksheet settings in Excel? I do. There are things I do to every new workbook I 
create.

In a few minutes, you can teach Excel your favorite settings. Then, every time you create a new workbook 
with Ctrl+N or insert a new worksheet, the worksheet will inherit all of your favorite settings.

The key step is to save the workbook as a template into a specific folder with two specific names. 

Start with a blank workbook with a single worksheet.

Apply all your favorite settings. There are dozens of possibilities. Here are a few that I use:

On the Page Layout tab, change the Scale to Fit so the Width is 1 page. Leave the Height set to Automatic 
and width set to 1 Page.

Create a custom header or footer. Use the dialog launcher in the bottom right of the Page Setup group. Go 
to the Header/Footer tab. Choose Custom Footer. Type whatever is your company standard is in the footer. 
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Create custom margins. I like narrow margins – even more narrow than the built-in Narrow margin set-
tings. I’ve been using 0.25-inch margins 
since the 1990s, and they're automatically 
set for me because I've added that to my 
template.

Choose a theme. I like the colors from 
Slipstream, but I prefer the Effects from 
Office 2007-2010. 

The next settings seems a little over the top. When you set a pivot table default theme, it only applies to 
the current workbook. Excel never saves your prefer-
ence. Create a tiny two-cell data set. Create a pivot 
table. Change the default formatting. Delete the pivot 
table and the data set. The template will remember the 
setting.

Would you use Cell Styles more often if they weren’t so ugly? Do you hate that input cells are orange? Go 
to Cell Styles, right-click Input and choose Modify. Click the Format button and choose a different input 
color.

I've just shown you some of my habitual settings. I'm sure you have your own favorites. Maybe you always 
set up a name to define the tax rate. Add it to your template, and you will never have to set this up again. 
Turn off gridlines. Do whatever you always do.
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Once you've finished customizing your workbook, you need to figure out which file type you use most 
often. For people who never use macros, this is often XLSX. But I always use macros, so my default file type 
is XLSM. Maybe you want workbooks to open faster, and you use XLSB. There is a template format related 
to each of these file types – just change the extension as needed. So, for me, I save the workbook as XLTM. 
You might save it as XLTX.

As soon as you choose one of these file types, the Save As dialog box moves to a templates folder. You 
need to save the workbook in a different folder.

In the folder bar, type %AppData% and press Enter to get to the AppData\Roaming\ folder on your com-
puter. From there, navigate to Microsoft\Excel\XLSTART.

Save the workbook with the reserved name Book plus the appropriate extension.

Save As again and save the workbook in the same folder but use Sheet (plus the same extension) as the 
name.

Of course, you only have to set this up once. After you do it, any time you use Ctrl+N to create a new work-
book, the new workbook will inherit all of the settings from your template named Book. 

Why did you have to also save templates named both Book and Sheet? Any time you insert a new work-
sheet into an existing workbook, Excel uses the Sheet template.

My Rant About New and New…

I’ve been using Book.xltm for 20 years. Back in all versions of Excel from Excel 95 up through Excel 2003, 
the Excel Standard toolbar had an icon called “New”. Click that icon, and Excel load the Book template. 
Everything was great.

The File menu offered a different icon called “New…”. Hardly anyone used "New…" because it was half as 
many clicks to simply click the “New” icon on the Standard toolbar. “New” respects your custom settings in 
the Book template. “New…” does not.

Things fell apart in Excel 2007. When Microsoft moved to the ribbon, the good “New” icon was missing 
from the ribbon. People had to open the Office icon and choose the evil “New…”. Microsoft allegedly 
studied the Excel 2003 SQM (pronounced skwim, the result of the Customer Experience Improvement 
Program) data to figure out what belonged in the ribbon. But somehow, they massively screwed up and 
left “New” out of the Ribbon. The problem remained in Excel 2010.

Then, in Excel 2013, someone on the Office team decided that Excel should start by showing you a pane 
that has recent files and a bunch of templates. This is called the Start screen. Now, for the first time, 
Microsoft is shoving the Blank Workbook template in your face every time you open Excel. This is the evil 
Blank Workbook template that you would have had to use File, New… to get to in the past.

This stupid template does not inherit settings from Book.xltx and Sheet.xltx. This stupid template is built 
in. There is no way to change it. Microsoft had a great but obscure feature, and they’ve made it harder to 
use by shoving this useless Blank Workbook template down your throat when you open Excel 2013 or 
Excel 2016.

If you’ve set up custom Book and Sheet templates, do not click the Blank Workbook template. Simply dis-
miss this opening screen by using the Esc key, and your custom Book template will load.
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If you get tired of pressing Esc, go to File, Options, General. Uncheck Show the Start Screen When This 
Application Starts.

Thanks to Jo Ann Babin for an idea similar to this one.

#8 Recover Unsaved Workbooks
The Auto Recover feature is a lifesaver. It is turned on automatically in Excel 2010 and newer.
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Say it is 4:59 PM on Friday, and you are trying to get the heck out of work. You have a bunch of files open in 
Excel and issue the Alt+F+X command to exit Excel.

Illustrator: Sarah Lucia Jones

Standing between you and the after-work PowerPivotini happy hour are a bunch of dialogs like this one:

There is no need to save this file, so you click Don't Save.

Next file? Don't Save.

Next file? Don't Save.

Now you are in a rhythm, clicking Don't Save in perfect synchronization with Excel presenting the mes-
sage. Then, as you click Don't Save the last time, you realize that this workbook had a lot of unsaved chang-
es. And you really needed to save it. You should have clicked Save.

You look at your watch. It will take two hours to re-create all of those changes. Your happy hour plans are 
sunk. But wait! Excel has your back. If the workbook was open for at least 10 minutes and went through an 
AutoSave, Excel kept a copy for you.

Walter Moore
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Follow these steps to get it back:

1. Hold your breath.

2. Open Excel.

3. In the left panel, all the way at the bottom, choose Open Other Workbooks.

4. In the center panel, scroll all the way to the bottom of the recent files. At the very end, click Recover 
Unsaved Workbooks.

5. Excel shows you all the unsaved workbooks that it has saved for you recently.

6. Click one and choose Open.

7. If it is the wrong one, go back to File, Open and scroll to the bottom of the list.

8. When you find the right file, click the Save As button to save the workbook.

Unsaved workbooks are saved for four days before they’re automatically deleted.

Using AutoSave Versions to Recover Files Previously Saved

This might seem confusing, but Recover Unsaved Workbooks applies only to files that have never been 
saved. If your file has been saved, you will use AutoSave versions to get the file back.
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If you close a previously saved workbook without saving recent changes, one single AutoSave version is 
kept until your next editing session. To access it, reopen the workbook. Use File, Info, Versions to open the 
last AutoSave version. 

You can also search for the last AutoSave version using Windows Explorer. Excel Options specifies an 
AutoRecover File Location. (See the first screenshot in this topic). If your file was named Budget2018Data, 
look for a folder within the AutoRecover File folder that starts with Budget. 

While you are editing a workbook, you can access up to the last five AutoSave versions of a previously 
saved workbook. These can be opened on the Info tab under the Versions section. You may make changes 
to a workbook and want to reference what you previously had. Instead of trying to Undo a bunch of revi-
sions, or using Save As to save as a new file, you can open an AutoSave version. AutoSave versions will 
open in another window so you can reference, copy/paste, save it as a separate file, etc. 

Note: An AutoSave version is created according to the AutoRecover interval AND only if there are 
changes. So if you leave a workbook open for two hours without making any changes, the last 
AutoSave version will contain the last revision. 

Caution: Both the Save AutoRecover Information option and Keep The Last AutoSaved Version 
option must be selected in order to recover an AutoSave version. 

Note: Under the Manage Version options on the Info tab is the ability to Delete All Unsaved 
Workbooks. This is an important option to know about if you work on public computers. You may 
want to make sure you don’t leave copies of your work behind. Note that this option only appears 
if you’re working on a file that has never been previously saved. The easiest way to access it is to 
create a new workbook. 

Thanks to Beth Melton and Paul Seaman and for clarifying the differences between AutoRecover and Recover Unsaved Files.

#9 Perfect One-Click Charts
One-click charts are easy: Select the data. Press Alt+F1.
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But one-click charts are rarely the type of chart you need to create day after day. To make your life easier, 
you can change the settings on a chart and then teach Excel to produce your favorite chart in response to 
Alt+F1.

Say that you want to clean up the chart above. All of those zeros on the left axis take up a lot of space with-
out adding value. Double-click those numbers. Change Display Units from None to Millions.

To move the legend to the top, click the+sign next to the chart, choose the arrow to the right of Legend, 
then choose Top.

Change the color scheme to something that works with your company colors.
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Right-click the chart and choose Save As Template. Then, give the template a name. (I called mine 
ClusteredColumn.)

Select a chart. In the Design tab of the ribbon, choose Change Chart Type. Click on the Templates folder to 
see the template that you just created.

Right-click your template and choose Set As Default Chart.

The next time you need to create a chart, select the data and press Alt+F1. All your favorite settings will 
appear in the chart.
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Thanks to Areef Ali, Olga Kryuchkova, and Wendy Sprakes for suggesting this feature.

#10 Paste New Data on a Chart
You might be responsible for updating charts every month, week, or day. For example, in my last job, a 
collection of charts were updated during the month-end close process. The charts would track progress 
throughout the year. 

There is an easy way to add new data to an existing chart. Here, the chart shows data for January through 
May, and there is new data for June that is not on the chart.
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Rather than re-create the chart, you can paste new data on the chart. Select the new data in the work-
sheet, including the heading. Press Ctrl+C to copy.

Click on the chart and press Ctrl+V to paste the data on the chart. As shown below, the new data is added 
to the existing chart.

As you keep adding months to the right side, what if you want to remove data from the left side? Is there 
any way to Ctrl+X that data off the chart?

No, but there is another way. Select the chart. Outlines appear around the charted data in the worksheet. 
A blue box surrounds the data points for the charts, and in each corner of the blue box is a square dot. The 
square dot is a resizing handle.
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Click on the lower, left resizing handle in the blue box and drag to the right.

The data is removed from the left side of the chart.

You can use these resizing handles to resize or drag the blue box to change the data that appears on the 
chart. Of course, you could have dragged the bottom, right resizing handle to add June to the chart in 
the first place, but it is good to know this copy and paste trick in case the chart and data are on different 
sheets in the workbook.

Tip: If you wanted to remove East from the chart, you could click on any East column and press 
Delete on your keyboard to remove that series. To temporarily hide a series, you can hide the row 
or column where the underlying data is stored..
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Bonus Tip: Comparative Scatter Charts
The chart below is an X-Y scatter chart. Each blue dot represents a salaried employee. The numbers along 
the bottom of the chart are years of experience. 
The vertical position of the dot indicates salary. 

There is a second group of employees: assembly 
line workers. There are more workers in this cate-
gory than in the first category. Select the data for 
the second group, including the headings. Copy 
with Ctrl+C.

Click on the chart. In the Home tab, open the Paste Dropdown and choose Paste Special. In the Paste 
Special dialog, check the box Categories (X Values) in First Column. Click OK.

The result: You’ve added a new X-Y series to the chart. I changed the color of the second series and added 
a legend in this image.

Thanks to Access Analytic for the idea about pasting new data on a chart. Paul Seaman provided the Delete key tip.
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#11 Sort East, Central, and West Using a Custom List
At my last day job, we had three sales regions: East, Central, and West. The company headquarters was in 
the East, and so the rule was that all reports were sorted with the East region first, then Central, then West. 
Well, there is no way to do this with a normal sort.

Sort AZ, and you will have Central at the top. Sort the data ZA, and you will have West at the top.

I actually went to my manager to ask if he would rename the Central region. “To what?” he asked incredu-
lously. I replied that I didn’t care, as long as it started with F through V. Perhaps “Middle”? John shook his 
head no and went on with his day.

Illustration: Michelle Routt

So, over and over, I would sort the report, then Ctrl+X to cut the East region records and paste them before 
the Central region. If only I had known this trick. 
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The first thing to do is to set up a custom list with the regions in the correct order: East, Central, West. (See 
"#3 The Fill Handle Does Know 1, 2, 3…" on page 8 for instructions on setting up a custom list.)

Once the custom list is defined, open the Sort dialog using the Sort icon on the Data tab. Choose to sort by 
Region. Open the Order dropdown. You don’t want A to Z. You don’t want Z to A. You want Custom List….

Choose the East, Central, West custom list. One you’ve chosen that custom list, you can either sort it 
East, Central, West or West, Central, East.

The result: an easy way to sort a list into a nonstandard sequence.

At that old day job, we also had a product list that refused to sort correctly. PTC-610, PTC-710, PTC-860, 
PTC-960, PTC-1100 was the desired order. But the PTC-1100 always fell first in a text sort. A custom list 
would solve this problem as well.
Thanks to @NeedForExcel for suggesting this tip.
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#12 Sort Left to Right
Every day, your IT department sends you a file with the columns in the wrong sequence. It would take 
them two minutes to change the query, but they have a six-month backlog, so you are stuck rearranging 
the columns every day.

You can reorder the columns with a left-to-right sort.

1. Add a new row above the data. Type numbers to represent the correct sequence for the columns.

2. Select Data, Sort. In the Sort dialog, click the Options… button and choose Sort Left to Right. Click OK.

3. Specify Row 1 in the Sort By dropdown. Click OK.

The problem: The column widths do not travel with the columns.

But it is easy to select the data and Press Alt+O, C, A or select Home, Format, Column, AutoFit.
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Bonus: Another Way to Move columns

Select one cell in the column you want to move. 
(You can also do this with multiple columns.)

Press Ctrl+Space bar to select the whole column.

Shift+drag the edge of the selection to a new location. The columns move and get inserted where you 
drop them. The remaining data shifts over.

Tip: If you need to move rows, press Shift+Space bar to select the whole row. Follow with 
Shift+drag.

Bonus Tip: Use Power Query
If you really have to move columns every day, it would be better to use a macro or Power Query to solve 
the problem. Power Query will remember your steps. When you get a new file from IT tomorrow, you can 
simply ask Power Query to refresh the steps.

Power Query is built in to Excel 2016 (under Data, Load & Transform) and it's a free add-in for Excel 2013 
and Excel 2010. There are two different Power Query examples in this book: "#38 Load a File List into Excel 
with Power Query" on page 127 and "#20 Data Shaping (Unpivot) with Power Query" on page 197.

From a blank workbook, specify a new query from a file. Point to the file created by IT. While you are edit-
ing the query, right-click each column and select Move, To Beginning. Or simply grab the field heading and 
drag it to the correct place.

After you finish, select Close & Load from the Power Query home tab. Tomorrow, when there is a new file 
available from IT, just open your query file and choose Data, Refresh All. Power Query replays all the steps, 
including rearranging the order of the columns.
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#13 Sort Subtotals
This tip is from my friend Derek Fraley in Springfield, Missouri. I was doing a seminar in Springfield, and I 
was showing my favorite subtotal tricks.

For those of you who have never used subtotals, here is how to set them up.

Start by making sure your data is sorted. The data below is sorted by customers in column C.

From the Data tab, choose Subtotals. The Subtotal dialog box always wants to subtotal by the leftmost 
column. Open the At Each Change In dropdown and 
choose Customer. Make sure the Use Function box is set to 
Sum. Choose all of the numeric fields. 

When you click OK, Excel inserts a subtotal below each 
group of customers. But, more importantly, it adds Group 
and Outline buttons to the left of column A.

When you click the #2 Group and Outline button, the detail 
rows are hidden, and you are left with only the subtotal 
rows and the grand total. This is a beautiful summary of 

a detailed data set. Of course, at this point, the customers appear in alphabetic sequence. Derek from 
Springfield showed me that when the data is collapsed in the #2 view, you can sort by any column. In the 
figure below, a Revenue column cell is selected, and you are about to click the ZA sort button.
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The top customer, Wag More Dog Store, comes to the top of the data set. But it does not come to row 2. 
Behind the hidden rows, Excel actually sorted a chunk of records. All of the Wag More detail rows moved 
along with the subtotal row.

If you go back to the #3 view, you will see the detail records that came along. Excel did not sort the detail 
records but brought them in their original sequence.

To me, this is astounding on two fronts. First, I am amazed that Excel handles this correctly. Second, it is 
amazing that anyone would ever try this. Who would have thought that Excel would handle this correctly? 
Clearly, Derek from Springfield.

www.allitebooks.com

http://www.allitebooks.org
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Bonus Tip: Filling in a Text Field on the Subtotal Rows
Say that each customer in a data set is assigned to a single sales rep. It would be great if you could bring 
the sales rep name down to the subtotal row. Here are the steps:

1. Collapse the data to the #2 view.

2. Select all of the sales rep cells, from the first sub-
total row to the last customer subtotal row. Don’t 
include the Grand Total row. At this point, you have 
both the visible and hidden rows selected. You 
need just the blank rows or just the visible rows.

3. At the right side of the Home tab, open the Find 
& Select dropdown. Choose Go To Special. In the 
Go To Special dialog, choose Blanks. Click OK.

4. At this point, you’ve selected only the blank 
sales rep cells on the Subtotal rows. In my case, the 
active cell is A49. You need a formula here to point 
one cell up. So, as in the figure below, type =A48. 
Instead of pressing Enter, press Ctrl+Enter. This will 
enter a similar formula in all of the subtotal rows. In 
each case, it will bring the sales rep from the previ-
ous row down.

The results: The subtotal rows show the sales rep name in addition to the numeric totals.
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Bonus Tip: Formatting the Subtotal Rows
It is a little odd that Subtotals only bolds the customer column and not anything else in the subtotal row. 
Follow these steps to format the subtotal rows:

1. Collapse the data to the #2 view.

2. Select all data from the first subtotal to the grand totals.

3. Press Alt+; (which is the shortcut for Go To Special, Visible Cells Only).

4. Click OK. Format the subtotal rowsby applying Bold and a fill color.

Now, when you go back to the #3 view, the subtotal rows will be easy to spot.

Bonus Tip: Copying the Subtotal Rows
Once you’ve collapsed the data down to the #2 view, you might want to copy the subtotals to a new work-
sheet. If so, select all the data. Press Alt+; to select only the visible cells. Press Ctrl+C to copy. Switch to a 
new workbook. Press Ctrl+V to paste. All the subtotal formulas are converted to values.
Thanks to Patricia McCarthy for suggesting to select visible cells. Thanks to Derek Fraley for his "row 6" suggestion.
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#14 Easy Year-over-Year Report in a Pivot Table

Walter Moore

Let’s say you have two years’ worth of detail records. Each record has a daily date. When you build a pivot 
table from this report, you will have hundreds of rows of daily dates in the pivot table. This is not much of a 
summary.

Choose one of those date cells in the pivot table. From the Analyze tab in the ribbon, choose Group Field.

Because you are on a date field, you get this version 
of the Grouping dialog. In it, unselect Months and 
select Years.

The daily dates are rolled up to years. Move the 
Date field from ROWS to COLUMNS.
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The result is almost perfect. But instead of a grand total in column D, you probably want a percentage 
variance.

To get rid of the Grand Total column, on the Design tab choose Grand Totals, On for Columns Only. (I agree, 
this is one of the more awkward wordings in Excel.)

To build the variance column, you need to write a formula outside the pivot table that points inside the 
pivot table. Do not touch the mouse or arrow keys while building the formula, or the nasty GETPIVOTDATA 
function will appear. Instead, simply type =C5/B5-1 and press Enter.

Thanks to Александр Воробьев for suggesting this tip.
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#15 True Top Five in a Pivot Table
Pivot tables offer a Top 10 filter. It is cool. It is flexible. But I hate it, and I will tell you why.

Here is a pivot table showing revenue by customer. The revenue total is $6.7 million.

What if my manager has the attention span of a goldfish and wants to see only the top five customers?

To start, open the dropdown in A3 and select Value Filters, Top 10.
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The super-flexible Top 10 Filter dialog allows Top/Bottom. It can do 10, 5, or any other number. You can ask 
for the top five items, top 80%, or enough customers to get to $5 million.

But here is the problem: The resulting report shows five customers and the total from those customers in-
stead of the totals from everyone. 

But First, a Few Important Words About AutoFilter

I realize this seems like an off-the-wall question. If you want to turn on the Filter dropdowns on a regular 
data set, how do you do it? Here are three really common ways:

●● Select one cell in your data and click the Filter icon on the Data tab.

●● Select all of your data with Ctrl+* and click the Filter icon on the Data tab.

●● Press Ctrl+T to format the data as a table.

These are three really good ways. As long as you know any of them, there is absolutely no need to know 
another way. But here's an incredibly obscure but magical way to turn on the filter:

●● Go to your row of headers, go to the rightmost heading cell. Move one cell to the right. For some un-
known reason, when you are in this cell and click the Filter icon, Excel filters the data set to your left. I 
have no idea why this works. It really isn’t worth talking about because there are already three really 
good ways to turn on the Filter dropdowns. I call this cell the Magic cell.

And now, Back to Pivot Tables…

So, there is a rule that says you cannot use the AutoFilters when you are in a pivot table. See below? The 
Filter icon is grayed out because I’ve selected a cell in the pivot table.
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I never really considered why Microsoft grays this out. It must be something internal that says AutoFilter 
and a Pivot Table can’t coexist. So, there is someone on the Excel team who is in charge of graying out the 
Filter icon. That person has never heard of the Magic cell. Select a cell in the pivot table, and the Filter gets 
grayed out. Click outside of the pivot table, and Filter is enabled again.

But wait. What about the Magic cell I just told you about? If you click in the cell to the right of the last 
heading, Excel forgets to gray out the Filter icon!

Illustration: George Berlin

Sure enough, Excel adds AutoFilter dropdowns to the top row of your pivot table. And the AutoFilter oper-
ates differently than pivot table filters. Go to the Revenue dropdown and choose Number Filters, Top 10…. 
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In the Top 10 AutoFilter dialog, choose Top 6 Items. That’s not a typo….  If you want five customers, choose 
6. If you want 10 customers, choose 11.

To AutoFilter, the grand total row is the largest item in the data. The top five customers are occupying posi-
tions 2 through 6 in the data.

Caution: Clearly, you are tearing a hole in the fabric of Excel with this trick. If you later change 
the underlying data and refresh your pivot table, Excel will not refresh the filter, because, as far as 
Microsoft knows, there is no way to apply a filter to a pivot table!

Note: Our goal is to keep this a secret from Microsoft, because it is a pretty cool feature. It has 
been “broken” for quite some time, so there are a lot of people who might be relying on it by now. I 
know that David Gainer from the Excel team preordered this book, so this box is my rationalization 
to David for why he should not take this out.
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A Completely Legal Solution in Excel 2013+

If you want a pivot table showing you the top five customers but the total from all customers, you have to 
move your data outside of Excel. If you have Excel 
2013 or 2016, there is a very convenient way to do 
this. To show you this, I’ve deleted the original 
pivot table. Choose Insert, Pivot Table. Before click-
ing OK, select the box that says Add This Data to 
the Data Model.

Build your pivot table as normal. Use the drop-
down in A3 to select Value Filters, Top 10, and ask 
for the top five customers. With one cell in the 
pivot table selected, go to the Design tab in the 
ribbon and open the Subtotals dropdown. The 
final choice in the dropdown is Include Filtered 
Items in Totals. Normally, this choice is grayed out. 
But because the data is stored in the Data Model 
instead of a normal pivot cache, this option is now 
available.

Choose the Include Filtered Items in Total option, and your Grand Total now includes an asterisk and the 
total of all of the data.

This trick originally came to me from Dan in my seminar in Philadelphia. Thanks to Miguel Caballero for suggesting this feature.



48	 MrEXCEL XL

#16 Eliminate Pivot Table Annoyances
I am on an eight-year mission to convince the Excel team to offer a setting somewhere 
in Excel 2018 to allow people to specify whether they prefer Compact Layout, Outline 
Layout, or Tabular Layout. I began this mission after the team added Repeat All Item 
Labels to Excel 2010. I had been asking for that feature since 2002. Now that's been 
added, my new passion is to allow everyone who prefers Tabular to Compact to have a 
checkbox somewhere to make Tabular be the default. If you also prefer Tabular Layout, 
get ready to wait until Excel 2018. Plus two years for your IT department to decide to up-
grade. That puts the feature out to 2020 for most of us.

If you don't want to wait until the Excel team finally gets tired of my lobbying and adds 
the feature you can invest $30 today to buy an amazing add-in called Pivot Power 
Premium from Debra Dalgleish at Contextures.com. Here you see the Add-In's Set 
Preferences dialog, where you can specify the default layout plus dozens of other settings.

This add-in will force all new Values fields to Sum. You will never have to deal with Counts! 
Plus it offers a way to control the number format.

This add-in takes all the obscure pivot functionality 
that is buried deep in the Options dialog and exposes 
it in the Ribbon. Let’s stop talking about it. It is worth 
every penny of the $30 license fee. Just go buy it: 
http://mrx.cl/pppdebra.
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Ctrl+T Table Before Adding New Data
In almost every seminar, someone asks why their pivot tables default to counting a numeric field instead 
of summing. There are two possible answers: Either there are a few blank cells in the numeric column, or 
the person is selecting entire columns in the data set (such as A:C instead of A1:C16). 

I understand the logic behind the second possibility. If you choose all of columns A:C and you later want 
to add more records below the data, it takes only a simple Refresh to add the new data instead of having 
to find the Change Data Source icon. In the past, this made sense. But today, Change Data Source is right 
next to the Refresh button and not hard to find. Plus, there is a workaround in the Ctrl+T Table.

When you choose your data set and select Format as Table by using Ctrl+T, the pivot table source will grow 
as the table grows. You can even do this retroactively, after the pivot table exists.

This figure shows a data set and a pivot table. The pivot table source is A1:C16.

You want to be able to easily add new data below the pivot table. 
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Select one cell in the data and press Ctrl+T. Make sure that My Table Has Headers is checked in the Create 
Table dialog and click OK.

Some nice formatting is applied to the data set. But the formatting is not the important part.

You have some new records to add to the table. Copy the records.

Go to the blank row below the table and paste. The new records pick up the formatting from the table. The 
angle-bracket-shaped End-of-Table marker moves to C19. But notice that the pivot table has not updated 
yet.
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Click the Refresh button in the Pivot Table Tools Analyze tab. Excel adds the new rows to your pivot table.
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Bonus Tip: Ctrl+T Helps VLOOKUP and Charts
In this figure, the VLOOKUP table is in E5:F9. Item A106 is missing from the table and the VLOOKUP is re-
turning #N/A. Conventional wisdom says to add A106 to the middle of your VLOOKUP table so you don’t 
have to rewrite the formula.

Instead, use Ctrl+T to format the lookup table. Note that the formula is still pointing to E5:F9; nothing 
changes in the formula.

But when you type a new row below the table, it becomes part of the table and the VLOOKUP formula au-
tomatically updates to reflect the new range.
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The same thing happens with charts. The chart on the left is based on A1:B5 which is not a table. Format 
A1:B5 as a table by pressing Ctrl+T. Add a new row. The row is automatically added to the chart.

It is fairly cool that you can use Ctrl+T after setting up the pivot table, VLOOKUP, or chart, and Excel still 
makes the range expand.

Bonus Tip: Readable References with Ctrl+T 
Not only do these tables make refreshing the data easier, they also make reading formulas much easier! 
The only thing you need to do is to press Ctrl+T before writing the formula.

Let’s go back to the VLOOKUP formula from above. This time, convert your items table and your purchase 
table to an Excel table with Ctrl+T right from the start! To make things easier, give each table a friendly 
name using the Table Tools tab:

Now type in the VLOOKUP again without doing anything differently than you normally do, your formula in 
C2 now is =VLOOKUP([@Item],Items,2,0) instead of =VLOOKUP(B2,$E$5:$F$10,2,0)!

Even if the Items table is on a different worksheet, the formula is the same, instead of the less readable 
=VLOOKUP(B2,Items!$A$2:$B$7,2,0).

The [@Item] in the formula refers to the cell in the Item column of this table (in the same row as the formu-
la) and is therefore the same in the whole column. And Items refers to the whole items table (without the 
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headers). Best of all, you don’t need to type any of this. Once this is a table, Excel will place these names in 
your formula as you select the cells/ranges!

Let’s take this one step further. Add another column to the Sales table to calculate the revenue 
with the formula =[@Price]*[@Qty]. If you now want to calculate the total revenue, the formula is 
=SUM(Sales[Revenue]); which is really easy to understand, no matter where the data is or how many rows 
it covers!

Bonus Tip: Running Totals in Tables
A running total is, for a list of numeric values, a sum of the values from the first row to the row of the run-
ning total. Common uses of a running total are in a checkbook register or an accounting sheet. There are 
many ways to create a running total—two of which are described below.

The simplest technique is to, on each row, add the running total from the row above to the value in the 
row. So the first formula in row 2 is:

=SUM(D1,C2)

The reason we use the SUM function is because, in the first row, we are looking at the header in the row 
above. If we use the simpler, more intuitive formula of =D1+C2 then an error will be generated because 
the header value is text versus numeric. The magic is that the SUM function ignores text values, which are 
added as zero values. When the formula is copied down to all of the rows in which a running total is de-
sired, the cell references are adjusted accordingly:
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The other technique also uses the SUM function but each formula sums all of the values from the first row 
to the row displaying the running total. In this case we use a dollar sign ($) to make the first cell in the ref-
erence an absolute reference which means it is not adjusted when copied:

Both techniques are unaffected by sorting and deleting rows but, when inserting rows, the formula has to 
be copied into the new rows.

Excel 2007 introduced the Table which is a re-implementation of the List in Excel 2003. Tables introduced a 
number of very useful features for data tables such as formatting, sorting, and filtering. With the introduc-
tion of Tables we were also provided a new way of referencing the parts of a Table. This new referencing 
style is called structured referencing.

To convert the above example into a Table, we select the data we want to include in the Table and press 
CTRL+T. After displaying a prompt asking us to confirm the Table's range and whether or not there are ex-
isting headers, Excel converts the data into a formatted Table:

Note that the formulas we entered earlier remain the same.
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One of the useful features Tables offers is automatic formatting and formula maintenance as rows are 
added, removed, sorted, and filtered. It is the formula maintenance in particular that we will focus on and 
which can be problematic. To keep Tables working while they are manipulated, Excel utilizes calculated 
columns which are columns with formulas such as column D in the above example. When new rows are in-
serted are added to the bottom, Excel automatically populates the new rows with the “default” formula for 
that column. The problem with the above example is that Excel gets confused with standard formulas and 
does not always handle them correctly. This is made apparent when new rows are added to the bottom of 
the Table (by selecting the bottom right cell in the Table and pressing TAB):

This deficiency is resolved by using the newer structured referencing. Structured referencing eliminates 
the need to reference specific cells using the A1 or R1C1 referencing style and instead uses column names 
and other keywords to identify and reference the parts of a Table. For example, to create the same running 
total formula used above but using structured referencing we have:

=SUM(INDEX([Sales],1):[@Sales])

In this example we have a reference to the column name, “Sales”, along with the ampersand (@) to refer-
ence the row in the column in which the formula is located which is also known as the current row. 
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To implement the first example above where we added the running total value in the preceding row to the 
sales amount in the current row, you can use the OFFSET function:

=SUM(OFFSET([@[Running Total]],-1,0),[@Sales])

If the amounts used to calculate the running total are in two columns, for example one for “Debits” and 
one for “Credits”, then the formula is:

=SUM(INDEX( [Credit],1):[@Credit])-	SUM(INDEX( [Debit],1):[@Debit])

Here we are using the INDEX function to locate the first row’s Credit and Debit cells, and summing the 
entire column up to and including the current row’s values. The running total is the sum of all credits up to 
and including the current row less the sum of all the debits up to and including the current row.

For a more information on structured references in particular and Tables in general, we recommend the 
book Excel Tables: A Complete Guide for Creating, Using and Automating Lists and Tables by Zack Barresse 
and Kevin Jones.

When I asked readers to vote for their favorite tips, tables were popular. Thanks to Peter Albert, Snorre Eikeland, Nancy Federice, 
Colin Michael, James E. Moede, Keyur Patel, and Paul Peton for suggesting this feature. Peter Albert wrote the Readable References 
bonus Tip. Zack Barresse wrote the Running Totals bonus tip. Four readers suggested using OFFSET to create expanding ranges for 
dynamic charts: Charley Baak, Don Knowles, Francis Logan, and Cecelia Rieb. Tables now do the same thing in most cases.
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#17 Replicate a Pivot Report For Each Rep
Here is a great trick that I learned from my coauthor Szilvia Juhasz. 

The pivot table below shows products across the top and customers down the side. The pivot table is 
sorted so the largest customers are at the top. The Sales Rep field is in the Report Filter.

If you open the Rep filter dropdown, you can filter the data to any one sales rep.

This is a great way to create a report for each sales rep. Each report summarizes the revenue from a partic-
ular salesperson's customers, with the biggest customers at the top. And you get to see the split between 
the various products.

The Excel team has hidden a feature called Show Report Filter Pages. Select any pivot table that has a 
Report Filter. Go to the Analyze tab (or the Options tab in Excel 2007/2010). On the far left side is the large 
Options button. Next to the large Options button is a tiny dropdown arrow. Click this dropdown and 
choose Show Report Filter Pages.
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Excel asks which field you want to use. Select the one you want (in this case the only one available) and 
click OK.

Over the next few seconds, Excel starts inserting new worksheets, one for each sales rep. Each sheet tab is 
named after the sales rep. Inside each worksheet, Excel replicates the pivot table but changes the name in 
the Report Filter to this sales rep.

You end up with a report for each sales rep.

This would work with any field. If you want a report for each customer, product, vendor, or so on, add it to 
the Report Filter and use Show Report Filter Pages.
Thanks to Szilvia Juhasz for showing me this feature during a seminar I was teaching at the University of Akron many years ago. 
For the record, Szilvia was in row 1.
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#18 Use a Pivot Table to Compare Lists
When you think of comparing lists, you probably think of VLOOKUP. If you have two lists to compare, you 
need to add two columns of VLOOKUP. In the figure below, you are trying to compare Tuesday to Monday 
and Wednesday to Tuesday and maybe even Wednesday to Monday. It is going to take a lot of VLOOKUP 
columns to figure out who added and dropped from each list.

You can use pivot tables to make this job far easier. Combine all of your lists into a single list with a new 
column called Source. In the Source column, identify which list the data came from. Build a pivot table 
from the combined list, with Name in ROWS, RSVP in VALUES and Source in COLUMNS. Turn off the Grand 
Total row and you have a neat list showing a superset from day to day.
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Bonus Tip: Showing Up/Down Markers
There is a super-obscure way to add up/down markers to a pivot table to indicate an increase or a 
decrease.

Somewhere outside the pivot table, add columns to show increases or decreases. In the figure below, the 
difference between I6 and H6 is 3, but you just want to record this as a positive change. Asking for the 
SIGN(I6-H6) will provide either +1, 0, or -1.

Select the two-column range showing the sign of the change and then select Home, Conditional 
Formatting, Icon Sets, 3 Triangles. (I have no idea why Microsoft called this option Three Triangles, when it 
is clearly Two Triangles and a Dash.)

With the same range selected, now select Home, Conditional Formatting, Manage Rules, Edit Rule. Check 
the Show Icon Only checkbox.
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With the same range selected, press Ctrl+C to copy. Select the first Tuesday cell in the pivot table. From the 
Home tab, open the Paste Dropdown and choose Linked Picture. Excel pastes a live picture of the icons 
above the table. 

At this point, adjust the column widths of the extra two columns showing the icons so that the icons line 
up next to the numbers in your pivot table.

After seeing this result, I don't really like the thick yellow dash to indicate “no change”. If you don't like it 
either, select Home, Conditional Formatting, Manage Rules, Edit. Open the dropdown for the thick yellow 
dash and choose No Cell Icon.
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#19 Custom Chart Labels in Excel 2013
Using Excel custom chart labels is a great way to create a more insightful chart without having to show an-
other whole series. Consider the chart below, which has custom labels showing the year-on-year percent-
age change:

In Excel 2013 you can easily insert custom chart labels by using the new Value from Cells option found in 
the Label Options menu.
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To do this, set up your chart source data, like this:

Take special note of columns D and E as these are required for the labels.

A brief word on the Max column: This column simply returns the MAX from columns B and C for each row. I 
used  Max as a dummy series in this chart to dynamically position the labels just above the columns.

1. Select cells A26:D38 and insert a column chart

2. Select the Max series and plot it on the secondary axis by  double-clicking the Max series and then se-
lecting Format Data Series, Secondary Axis:
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3. Insert labels on the Max series, by right-clicking the series and selecting Add Data Labels:

4. Change the horizontal category axis for the Max series, right-click the series and select Data. Then select 
Max under Legend Entries and Edit under Horizontal Axis Labels:
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5. Select the labels in cells E27:E38 and click OK. (Don't worry if the chart doesn't look any different yet.)

6. Replace the default labels with your custom labels by right-
clicking the labels and selecting Format Data Labels:

7. From the Label Contains list choose Category Name.

8. To hide the Max series columns,  double-click the Max col-
umns in the chart to open the Format Data Point dialog box. 
Under Fill select No fill:

9. To tidy up the chart, hide the secondary axis by double-clicking it to open the Format Axis dialog box. 
Then select Axis Options and make sure Major Tick Mark Type, Minor Tick Marks Type, and Axis Labels are 
all set all to None:
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10. Also in the Format Axis dialog box, select Line Color and then select No Line. Then move the legend to 
the bottom by double-clicking the legend, choosing Legend Position, Bottom.

11. Get rid of the gridlines by selecting them and pressing the Delete key.

12. To format the legend point for Max to pick up the value in cell E26, right-click the columns and select 
Data, and then select Max under Legend Entries and click Edit.

In the Edit Series dialog box, with the Series Name textbox selected, click on cell E26 and then click OK.

Thanks to Excel MVP Mynda Treacy for this trip. Twice each year, Mynda offers an amazing online Excel Dashboarding Class. Check 
it out at http://mrx.cl/dashcourse.



68	 MrEXCEL XL

#20 Build Dashboards with Sparklines and Slicers
New tools debuted in Excel 2010 that let you create interactive dashboards that do not look like Excel. This 
figure shows an Excel workbook with two slicers, Region and Line, used to filter the data. Also in this figure, 
pivot charts plus a collection of sparkline charts illustrate sales trends.

You can use a setup like this and give your manager’s manager a touch screen. All you have to do is teach 
people how to use the slicers, and they will be able to use this interactive tool for running reports. Touch 
the East region and the Books line. All of the charts update to reflect sales of books in the East region.
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Switch to eBooks, and the data updates.
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Pivot Tables Galore

Behind all the charts and reports just shown is a series of pivot tables. These pivot tables are scattered 
below and to the right of the first screen of data. Each pivot table should be based on the same data set 
and should share a pivot table cache.

Slicers Can Filter Multiple Pivot Tables

Slicers provide a visual way to filter. Choose the first pivot table and select Analyze, Slicers. Add slicers for 
region and line. Use the Slicer Tools tab in the ribbon to change the color and the number of columns in 
each slicer. Resize the slicers to fit and then arrange them on your dashboard.

Initially, the slicers are tied to only the first pivot table. Select a cell in the second pivot table and choose 
Filter Connections (aka Slicer Connections in Excel 2010). Indicate which slicers should be tied to this pivot 
table. In many cases, you will tie each pivot table to all slicers. But not always. For example, in the chart 
showing how Books and eBooks add up to 100%, you need to keep all lines. The Filter Connections dialog 
box choices for that pivot table connect to the Region slicer but not the Line slicer. 
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Sparklines Are Word-Sized Charts

Professor Edward Tufte introduced sparklines in his 2007 book Beautiful Evidence. Excel 2010 implemented 
sparklines as either line, column, or win/loss charts, where each series fills a single cell.

Personally, I like my sparklines to be larger. In this example, I changed the row height to 30 and <gasp> 
merged B14:D14 into a single cell to make the charts wider. The labels in A14:A18 are formulas that point 
to the first column of the pivot table.

To change the color of the low and high points, choose 
these boxes in the Sparkline Tools tab:

Then change the color for the high and low points:

By default, sparklines are scaled independently 
of each other. I almost always go to the Axis 
settings and choose Same for All Sparklines 
for Minimum and Maximum. Below, I set 
Minimum to 0 for all sparklines.
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Making Excel Not Look Like Excel

With several easy settings you can make a dashboard look less like Excel.

●● Select all cells and apply a light fill color to get rid of the gridlines.

●● On the View tab, uncheck Formula Bar, Headings, and Gridlines.

●● At the right edge of the ribbon, use the ^ to collapse the Ribbon.

●● Use the arrow keys to move the active cell so it is hidden behind a chart or slicer.

●● Hide all sheets except for the dashboard sheet.

●● In Excel Options, Advanced, you can hide the scrollbars and sheet tabs.

Bonus Tip: Make Your Workbook into an Web App
Create a named range such as DisplayMe that surrounds your dashboard. To do so, select File, Browser 
View Options. Choose Items in the Workbook on the Show tab and select the named range DisplayMe.

Save your workbook to a OneDrive location. Use File, Share and ask for a Sharing Link.
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Anyone who has the link can open the file in a browser and interact with the slicers. Try it: http://mrx.cl/
xlonedrive77.

Caution: Anyone who has the link can download the workbook and unhide the data sheets.
Thanks to Ghaleb Bakri for suggesting a similar technique using dropdown boxes. Ryan Wilson suggested making Excel not look 
like Excel. Jon Wittwer of Vertex42 suggested sparklines and slicers.
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#21 GETPIVOTDATA Might Not Be Entirely Evil
Most people first encounter GETPIVOTDATA when they try to build a formula outside a pivot table that 
uses numbers in the pivot table. For example, this variance percentage won’t copy down to the other 
months due to Excel inserting GETPIVOTDATA functions.

Excel inserts GETPIVOTDATA any time you use the mouse or arrow keys to point to a cell inside the pivot 
table while building a formula outside the pivot table.

By the way, if you don’t want the GETPIVOTDATA function to appear, simply type a formula such as =D5/
C5-1 without using the mouse or arrow keys to point to cells. That formula copies without any problems.

Here is a data set that contains one plan number per month per store. There are also actual sales per 
month per store for the months that are complete. Your goal is to build a report that shows actuals for the 
completed months and plan for the future months.

Build a pivot table with Store in ROWS. Put Month and Type in the COLUMNS. You get the report shown 
below, with January Actual, January Plan, and the completely nonsensical January Actual+Plan.
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If you select a month cell and go to Field Settings, you can change subtotals to None.

This removes the useless Actual+Plan. But you still have to get rid of the plan columns for January through 
April. There is no good way to do this inside of the pivot table.

So, your monthly workflow becomes:

1. Add the actuals for the new month to the data set.

2. Build a new pivot table from scratch.

3. Copy the pivot table and paste as values so it is not a pivot table anymore.

4. Delete the columns that you don’t need.
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There is a better way to go. The following very small figure shows a new Excel worksheet added to the 
workbook. This is all just straight Excel, no pivot tables. The only bit of magic is an IF function in row 4 that 
toggles from Actual to Plan based on the date in cell P1.

The very first cell that needs to be filled in is January, Actuals for Baybrook. Click in that cell and type an 
equal sign. Using the mouse, navigate back to the pivot table. Find the 
cell for January Actuals for Baybrook. Click on that cell and press Enter. 
As usual, Excel builds one of those annoying GETPIVOTDATA functions 
that cannot be copied.

But today, let’s study the syntax of GETPIVOTDATA.

The first argument below is the numeric field "Sales". The second argu-
ment is the cell where the pivot table resides. The remaining pairs of arguments are field name and value. 
Do you see what the auto-generated formula did? It hard-coded "Baybrook" as the name of the store. That 
is why you cannot copy these auto-generated GETPIVOTDATA formulas. They actually hard-code names 
into formulas. Even though you can't copy these formulas, you can edit them. In this case, it would be 
better if you edited the formula to point to cell $D6.

Here is the formula after you edit it. Gone are "Baybrook", "Jan", and "Actual". Instead, you are pointing to 
$D6, E$3, E$4.
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Copy this formula and then choose Paste Special, Formulas in all of the other numeric cells.

Now here's your annual workflow:

1. Build an ugly pivot table that no one will ever see.

2. Set up the report worksheet.

Each month, you have to:

1. Paste new actuals below the data.

2. Refresh the ugly pivot table.

3. Change cell P1 on the report sheet to reflect the new month. All the numbers update.

You have to admit that using a plain report that pulls numbers from a pivot table gives you the best of 
both worlds. You are free to format the report in ways that you cannot format a pivot table. Blank rows are 
fine. You can have currency symbols on the first and last rows but not in between. You get double-under-
lines under the grand totals, too.
Thanks to @iTrainerMX for suggesting this feature.
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#22 Eliminate VLOOKUP with the Data Model
Say that you have a data set with product, customer, and sales information.

The IT department forgot to put sector in there. Here is a lookup table that maps customer to sector. Time 
for a VLOOKUP, right?

There is no need to do VLOOKUPs to join these data sets if you have Excel 2013 or Excel 2016. Both of these 
versions of Excel have incorporated the Power Pivot engine into the core Excel. (You could also do this 
using the Power Pivot add-in for Excel 2010, but there are a few extra steps.)

In both the original data set and the lookup table, use Home, Format as Table. On the Table Tools tab, 
rename the table from Table1 to something meaningful. I’ve used Data and Sectors.

Select one cell in the data table. Choose Insert, Pivot Table. Starting in Excel 2013, there is an extra box Add 
This Data to the Data Model that you should select before clicking OK.



THE TOP 40	 79 

1

The Pivot Table Fields list appears with the fields from the Data table. 
Choose Revenue. Because you are using the Data Model, a new line 
appears at the top of the list, offering Active or All. Click All.

Surprisingly, the PivotTable Fields list offers all the other tables in the 
workbook. This is groundbreaking. You haven’t done a VLOOKUP yet. 
Expand the Sectors table and choose Sector. Two things happen to 
warn you that there is a problem.

First, the pivot table appears with the same 
number in all the cells.

Perhaps the more subtle warning is a yellow box appears 
at the top of the PivotTable Fields list indicating that you 
need to create a relationship. Choose Create. (If you are in 
Excel 2010 or 2016, take your luck with Auto-Detect.)

In the Create Relationship dialog, you have four dropdown menus. Choose Data under Table, Customer 
under Column (Foreign), and Sectors under Related Table. Power Pivot will automatically fill in the match-
ing column under the Related Column (Primary). Click OK. 

The resulting pivot table is a mashup of the original data and the lookup table. No VLOOKUPs required.
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Bonus Tip: Count Distinct

Here is an annoyance with pivot tables. 
Drag the Customer column from the Data 
table to the VALUES area. The field says 
Count of Customer, but it is really a count of 
how many invoices belong to each sector. 
What if you really want to see how many 
unique customers belong to each sector?

Select a cell in the Count of Customer column. 
Click Field Settings. At first, the Summarize 
Values By looks like the same Sum, Average, 
and Count that you’ve always had. But scroll 
down to the bottom. Because the pivot table 
is based on the Data Model, you now have 
Distinct Count. 

After you select Distinct Count, the pivot table 
shows a distinct count of customers for each 
sector. This was very hard to do in regular 
pivot tables.

Count Distinct in Excel 2010

To join two tables in Excel 2010, you have to download the free Power Pivot add-in from Microsoft. Once 
you have that installed, here are the extra steps to get your data into Power Pivot: 

1. Select a cell in the Data table. On the PowerPivot tab, choose Create Linked Table. If Excel leaves you in 
the PowerPivot grid, use Alt+Tab to get back to Excel.

2. Select a cell in the Sectors table. Choose Create Linked Table. 
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3. From either the PowerPivot tab in the Excel ribbon or the Home tab in the PowerPivot ribbon, choose to 
create a pivot table. 

When it comes time to create relationships, you have only one button called Create. Excel 2010 will at-
tempt to AutoDetect relationships first. In this simple example, it will get the relationship correct.
Thanks to Colin Michael and Alejandro Quiceno for suggesting Power Pivot in general.

#23 Budget Versus Actual via Power Pivot
Budgets are done at the top level – revenue by product line by region by month. Actuals accumulate 
slowly over time – invoice by invoice, line item by line item. Comparing the small Budget file to the volumi-
nous Actuals data has been a pain forever. I love this trick from Rob Collie, aka PowerPivotPro.com.

To set up the example, you have a 54-row budget table: one row per month per region per product. 

The invoice file is at the detail level: 422 rows so far this year.

There is no VLOOKUP in the world that will ever let you match these two data sets. But, thanks to Power 
Pivot (aka the Data Model in Excel 2013+), this becomes easy.
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You need to create tiny little tables that I call “joiners” to link the two larger data sets. In my case, Product, 
Region, and Date are in common between the two tables. The Product table is a tiny four-cell table. Ditto 
for Region. Create each of those by copying data from one table and using Remove Duplicates.

George Berlin

The calendar table on the right was actually tougher to create. The budget data has one row per month, 
always falling on the end of the month. The invoice data shows daily dates, usually weekdays. So, I had to 
copy the Date field from both data sets into a single column and then remove duplicates to make sure that 
all dates are represented. I then used =TEXT(J4,"YYYY-MM") to create a Month column from the daily dates.

If you don’t have the full Power Pivot add-in, you need to create a pivot table from the Budget table and 
check the box for Add This Data to the Data Model.

As discussed in the previous tip, as you add fields to the pivot table, you will have to define six relation-
ships. While you could do this with six visits to the Create Relationship dialog, I fired up my Power Pivot 
add-in and used the diagram view to define the six relationships.
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Here is the key to making all of this work: You are free to use the numeric fields from Budget and from 
Actual. But if you want to show Region, Product, or Month in the pivot table, they must come from the 
joiner tables!

Here is a pivot table with data coming from five tables. Column A is coming from the Region joiner. Row 
2 is coming from the Calendar joiner. The Product slicer is from the Product joiner. The Budget numbers 
come from the Budget table, and the Actual numbers come from the Invoice table. 

This works because the joiner tables apply filters to the Budget and Actual table. It is a beautiful technique 
and shows that Power Pivot is not just for big data.

Bonus Tip: Portable Formulas
If you have the full version of Power Pivot, you can use the DAX formula language to create new calculated 
fields. From the Power Pivot tab in the ribbon, choose Insert Calculated Field.
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Give the field a name, such as Variance. 
When you go to type the formula, type =[. 
As soon as you type the square bracket, 
Excel gives you a list of fields to choose 
from.

Note that you can also assign a numeric 
format to these calculated fields. Wouldn’t 
it be great if regular pivot tables brought 
the numeric formatting from the underly-
ing data?

In the next calculation, the VariancePercent is reusing the Variance field that you just defined.

This is great – all of those fields in the pivot table:
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But you don’t have to leave any of those fields in the pivot table. If your manager only cares about the vari-
ance percentage, you can remove all of the other numeric fields.

Note that the DAX in this bonus tip is barely scratching the surface of what is possible. If you want to ex-
plore Power Pivot, you need to get a copy of DAX Formulas for Power Pivot by Rob Collie and Avi Singh

Thanks to Rob Collie for teaching me this feature. Find Rob at www.PowerPivotPro.com
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#24 F4 for Absolute and Repeat Last Command
The mighty F4 key should be in your Excel arsenal for two completely different reasons:

●● Use F4 to add dollar signs in formula references to make them absolute, mixed, or relative.

●● When you are not editing a formula, use F4 to repeat the last command.

Illustration: Bob D'Amico

Making a Reference Absolute

In the following figure, the tax in C2 is B2 times F1. 

But when you copy this formula down, none of the sales tax calculations are working. As you copy the 
formula down the column, the B2 reference automatically changes to B3, B4, and so on. That is what you 
want. But unfortunately, the reference to the sales tax in F1 is changing as well. That is not what you want.
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The solution? Edit the original formula and press F4. Two dollar signs are added to the final element of the 
formula. The $F$1 says that no matter where you copy this formula, that part of the formula always needs 
to point to F1. This is called an absolute reference. Pressing F4 while the insertion point is touching the F1 
reference is a fast way to add both dollar signs.

There are other times when you need only part of the reference to be locked. In the following example, 
you need to multiply H2 by A3 by C1. The H1 will always point to H1, so you need both dollar signs in 
$H$1. The A3 will always point back to column A, so you need $A3. The C1 will always point to row 1, so 
you need C$1.

To enter the above formula, you would press F4 once after clicking on H1, three times after clicking on A3, 
and twice after clicking on C1. What if you screw up and press F4 too many times? Keep pressing F4: It will 
toggle back to relative then absolute, then row absolute, then column absolute.

The result? A single formula that can be copied to C3:F12.
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Repeating the Last Command

Keyboard shortcuts are great. Alt+E, D, C Enter will delete a column. But even if you are really fast at doing 
Alt+E, D, C Enter, it can be a pain to do a lot of these in a row.

After deleting column B, press the Right arrow key to move to the next column that needs to be deleted. 
Instead of doing Alt+E, D, C Enter again, simply press F4. This beautiful command repeats the last com-
mand that you invoked.

www.allitebooks.com

http://www.allitebooks.org
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To delete the remaining columns, keep pressing Right arrow then F4.

Next you need to delete a row. Alt+E, D, R Enter will delete the row.

To keep deleting rows, press the Down arrow followed by F4 until all the blank rows are gone.

The F4 command works for a surprising number of commands. Perhaps you just built a custom format to 
display numbers in thousands: #,##0,K. If you see a few more cells that need the same format, select the 
cells and press F4.

There are a few annoying commands that do not work with F4. For example, going into Field Settings in 
a Pivot Table and changing the number format and calculation is one that would be nice to repeat. But it 
does not work.
Thanks to Myles Arnott, Glen Feechan, Shelley Fishel, Colin Legg, and Nathan Zelany for suggesting this feature.
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#25 The Fastest Way to Convert Formulas to Values
I always say there are five ways to do anything in Excel. Converting live formulas to values is a task that has 
far more than five ways. But I will bet that I can teach you two ways that are faster than what you are using 
now.

The goal is to convert the formulas in column D to 
values.

You are probably using one of the ways shown 
here:

You Prefer using the Mouse

If you prefer to use the mouse, nothing is faster than this trick that I learned from Dave in Columbus, 
Indiana. You don’t even have to copy the cells using this technique:

1. Select the data.

2. Go to the right edge of the selection box.

3. Hold down the right mouse button while you drag 
the box to the right.
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4. Keep holding down the right mouse button while 
you drag the box back to the original location.

5. When you release the right mouse button, in the 
menu that pops up select Copy Here As Values Only.

How does anyone ever randomly discover right-click, 
drag right, drag left, let go? It is not something that 
you would ever accidentally do.

It turns out the menu is called the Alternate Drag and Drop Menu. You get this menu any time you right-
drag a selection somewhere.

In this case, you want the values to cover the original formulas, so you have to drag right and then back to 
the left.

You Prefer Keyboard Shortcuts

I love keyboard shortcuts. I can Ctrl+C, Alt+E, S, V, Enter faster than you can blink. But starting in Excel 
2010, there is a faster way. Look at the bottom row of your keyboard. To the left of the spacebar, you usu-
ally have Ctrl, Windows, Alt. To the right of the spacebar is Alt, Something, and Ctrl.

What is that key between the right Alt and the right Ctrl? It has a picture of a mouse pointer and a pop-up 
menu. I’ve heard it called the Program key. I’ve heard it called the Application key. I’ve heard it called the 
Right-Click key. I don’t care what you call it, but here is a picture of it:

Here is the fastest keyboard shortcut for copying and pasting values. Press Ctrl+C. Press and release the 
Program/Application/Right-Click key. Press V.

Again, this only works in Excel 2010 or newer.

And, if you have a Lenovo laptop, it is likely that you don’t even have this key. On a keyboard without this 
key, you can press Shift+F10 instead.
Thanks to Ed Bott, Ken McLean, Melih Met, and Bryony Stewart-Seume for suggesting this feature.
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#26 See All Formulas at Once
You inherit a spreadsheet from a former co-worker. You need to figure out how the calculations work. You 
could visit each cell one at a time and look at the formula in the formula bar. Or, you could quickly toggle 
between pressing F2 and Esc to see the formula right in the cell.

But there is a faster way. On most U.S. keyboards, just below the Esc key is a key with two accent charac-
ters: the tilde from Spanish and the grave accent from French. It is an odd key. I 
don’t know how I would ever use this key to actually type Piñata or Café. 

If you hold down Ctrl and this key, you toggle into something called Show 
Formulas mode. Each column gets wider, and you see all of the formulas.

This gives you a view of all the formulas at once. It is great for spotting “plug” numbers or when someone 
added the totals with a calculator and typed the number instead of using =SUM(). This is great you can see 
that the co-worker left RANDBETWEEN functions in this model.

Bonus Tip: Highlight All Formula Cells
If you are going to be auditing the worksheet, it would help to mark all of the formula cells. Here are the 
steps:
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1. Select all cells using the box just above and to the left of cell A1.

2. Press Ctrl+G for Go To and then Alt+S for Special. In the Go To 
Special dialog, choose Formulas and click OK. Alternatively, you can 
choose Home, Find & Select, Formulas.

3. All of the formula cells will be selected. Mark them in a different font 
color, or, heck, use Home, Cell Styles, Calculation.

To mark all of the input cells, follow the same steps, but choose Constants in the Go To Special dialog. I 
prefer to then uncheck Text, Logical, and Errors, leaving only the numeric constants.

Why Is the F1 Key Missing from Your Keyboard?

I served as a judge for the ModelOff Financial Modeling Championships in NYC twice. On my first visit, I 
was watching contestant Martijn Reekers work in Excel. He was constantly pressing F2 and Esc with his left 
hand. His right hand was on the arrow keys, swiftly moving from cell to cell.

F2 puts the cell in Edit mode so you can see the formula in the cell. Esc exits Edit mode and shows you the 
number.

Martijn would press F2 and Esc at least three times every second. 

But here is the funny part: What dangerous key is between F2 and Esc? F1. If you accidentally press F1, you 
will have a 10-second delay while Excel loads online Help. If you are analyzing three cells a second, a 10-
second delay would be a disaster. You might as well go to lunch. So, Martijn had pried the F1 key from his 
keyboard so he would never accidentally press it.

Photo Credit: MrsExcel

Martijn was competing for a $10,000 first prize, but I still thought this was a little over-the-top. However, 
as I talked to the other 15 finalists, most admitted to having removed F1 from their keyboards, along with 
Caps Lock and Insert.
Thanks to Ron Armstrong, Olga Kryuchkova, and Sven Simon for suggesting this feature.
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#27 Discover New Functions Using fx 
There are 400+ functions in Excel. I only have room for 40 tips this book, so there is no way I can cover 
them all. But instead of taking 450 pages to describe every function, I am going to teach you how to find 
the function that you need.

The Excel 2007 formulas tab introduced a huge fx Insert Function icon. But you don’t need to use the one 
on the Formulas tab; the same icon has been 
to the left of the formula bar ever since I can 
remember.

If you are trying to figure out how to calculate 
a loan payment, the Insert Function dialog will 
help. Click the icon next to the formula bar. In 
the Search for a Function box, type what you 
are trying to do. Click Go. The Select a Function 
box will show functions related to your search 
term. Click on a function in that box to see the 
description at the bottom of the dialog.

When you find the correct function and click OK, Excel takes you into the Function Arguments dialog. This 
is an amazing tool when you are new to a function. As you click into each argument box, help appears at 
the bottom of the window, with specifics on that argument.
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Personally, I could never get the PMT function to work correctly because I always forgot that the Rate had 
to be the interest rate per period. Instead of pointing to the 5.25% in B3, you have to point to B3/12. Below, 
the help for Nper explains that it is the total number of payments for the loan, also known as the Term, 
from B2.

PV is the loan amount. Since I never write a check for negative $493, I want the answer from PMT to be 
positive instead of negative. That is why I always use –B1 for the PV argument. If you use B1 instead, you 
will get the correct $493.45065 answer, but it will appear as negative in your worksheet. Think of the origi-
nal $25,995 as money leaving the bank; that is why the PV is negative.
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Notice in the above figure that three argument names are bold. These are the required arguments. Once 
you finish the required arguments, the Function Arguments dialog shows you the answer in two places. I 
always use this as a sanity check. Does this answer sound like a typical car payment?

This one topic really covered three things: how to calculate a loan payment, how to use the fx icon to dis-
cover new functions, and how to use Function Arguments to get help on any function. If you are in a situ-
ation where you remember the function name but still want to use the Function Arguments dialog, type 
=PMT( with the opening parenthesis then press Ctrl+A.

Note: Thanks to Tony DeJonker and Cat Parkinson for suggesting the function arguments.

#28 Calculate Nonstandard Work Weeks
In my live Power Excel seminar, it is pretty early in the day when I show how to right-click the Fill Handle, 
drag a date, and then choose Fill Weekdays. This fills Monday through Friday dates. I ask the audience, 
“How many of you work Monday through Friday?” A lot of hands go up. I say, “That’s great. For everyone 
else, Microsoft clearly doesn’t care about you.” Laughter.

It certainly seems that if you work anything other than Monday through Friday or have a year ending any 
day other than December 31, a lot of things in Excel don’t work very well.

However, two functions in Excel show that the Excel team does care about people who work odd work 
weeks: NETWORKDAYS.INTL and WORKDAY.INTL.

But let’s start with their original Monday-Friday antecedents. The following figure shows a start date in B 
and an end date in C. If you subtract =C5-B5, you will get the number of days elapsed between the two 
dates. To figure out the number of weekdays, you would use =NETWORKDAYS(B2,C2).

It gets even better. The old NETWORKDAYS allows for an optional third argument where you specify work 
holidays. In the next figure, the list of holidays in H3:H15 allows the Work Days Less Holidays calculation in 
column F.
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Prior to Excel 2007, the NETWORKDAYS and WORKDAY function were available if you enabled the Analysis 
ToolPak add-in that shipped with every copy of Excel. For Excel 2007, those add-ins were made a part of 
the core Excel. Microsoft added INTL versions of both functions with a new Weekend argument. This argu-
ment allowed for any two consecutive days as the weekend and also allowed for a one-day weekend.

I’ve seen a manufacturing plant switch to six day weeks in order to meet excess demand.
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Plus, there are several countries with weekends that don’t fall on Saturday and Sunday. All of the countries 
shown below except Bruneei Darussalem 
gained functionality with 
NETWORKDAYS.INTL and WORKDAY.INTL.

However, there are still cases where the 
weekend does not meet any of the 14 
weekend definitions added in Excel 2007. 

I happen to live in the same county as 
the Pro Football Hall of Fame in Canton, 
Ohio. But the top tourism destination in 
our county is not the hall of fame. The 
top tourism destination is the Hartville 

Marketplace and Flea Market. Started in 1939, this place is a hot spot for people looking for fresh produce 
and bargains. The original lunch stand became the Hartville Kitchen restaurant. And the nearby Hartville 
Hardware is so big, they built an entire house inside the hardware store. But the Marketplace is the ben-
eficiary of the new, secret weekend argument for NETWORKDAYS and WORKDAY. The Marketplace is open 
Monday, Thursday, Friday, and Saturday. That means their weekend is Tuesday, Wednesday and Sunday.

Starting in Excel 2010, instead of using 1-7 or 11-17 as the weekend argument, you can pass a 7-digit 
binary text to indicate if a company is open or closed on a particular day. It seems a bit unusual, but you 
use a 1 to indicate that the store is closed for the weekend and a 0 to indicate that the store is open. After 
all, 1 normally means On and 0 normally means Off. But the name of the argument is Weekend, so 1 means 
it is a day off, and 0 means you don’t have the day off.

Thus, for the Monday, Thursday, Friday, Saturday schedule at the Hartville Marketplace, you would use 
"0110001". Every time I type one of these text strings, I have to silently say in my head, “Monday, Tuesday, 
Wednesday…” as I type each digit.

Marion Coblentz at the Hartville Marketplace could use the following formula to figure out how many 
Marketplace days there are between two dates.
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By the way I did not use the optional Holidays argument above because Memorial Day, July 4, and Labor 
Day are the biggest customer days in Hartville.

If you are ever in northeastern Ohio, you need to stop by Hartville to see the 100% American-Made house 
inside of the Hartville Hardware and to try the great food at the Hartville Kitchen. Give me a call; I will meet 
you there.

Bonus Tip: Use WORKDAY.INTL for a Work Calendar
While NETWORKDAYS calculates the work days between two dates, the WORKDAY function takes a start-
ing date and a number of days, and it calculates the date that is a certain number of work days away.

Say that a new hire is on probation for 30 work days. But no one really uses work days for that calculation. 
By far the most common use is to calculate the next work day. In the following figure, the start date is the 
date on the previous row. The number of days is always 1. Specify the weekend and/or holiday. Drag the 
formula down, and you will generate an employee calendar of work days.
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#29 Handle Multiple Conditions in IF
When you need to do a conditional calculation, the IF function is the answer. If <something is true> then 
<this formula> otherwise <that formula>. In the following figure, a simple IF calculates a bonus if your 
sales were $20,000 or more.

But what happens when two conditions need to be met? Most people will nest one IF statement inside 
another, like this:

But this gets out of hand if you have many conditions that have to be met. The AND function will shorten 
and simplify the formula. =AND(Test,Test,Test,Test) will only be True if all of the logical tests are True. The 
following example shows a shorter formula with the same results.
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If you like AND, you might find a use for OR and NOT. =OR(Test,Test,Test,Test) will be True if any one of the 
logical tests are True. NOT will reverse an answer. =NOT(True) is False. =NOT(False) is True. If you ever have 
to do something fancy like a NAND, you can do NOT(AND(Test,Test,Test,Test)).

Caution: Although Excel 2013 introduced XOR as an Exclusive Or, it does not work the way that ac-
countants would expect. =XOR(True,False,True,True) is True for reasons that are too complicated to 
explain here. XOR really counts whether you have an odd number of True values. Odd. Really odd.

Bonus Tip: Using Boolean Logic
I always cover IF in my seminars. And I always ask how people would solve the two-conditions problem. 
The results are often the same; 70-80% of people use nested IF and 20-30% use AND. Just one time, in 
Virginia, a woman from Price Waterhouse offered this formula:

It works. It gives the same answer as the other formulas. Calculate the bonus .02*B4. But then multiply that 
bonus by logical tests in parentheses. When you force Excel to multiply a number by True or False, the True 
becomes 1, and the False becomes 0. Any number times 1 is itself. Any number times 0 is 0. Multiplying the 
bonus by the conditions ensures that only rows that meet both conditions are paid.

It is cool. It works. But it seems confusing when you first see it. My joke in the seminar always is, “If you are 
leaving your job next month and you hate your co-workers, start using this formula.”
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#30 Cure Triskaidekaphobia with a Killer Formula
Triskaidekaphobia is the fear of Friday the 13th. This topic won’t cure anything, but it will show you an 
absolutely amazing formula that replaces 110,268 formulas. In real life, I never have to count how many 
Friday the 13ths have occurred in my lifetime, but the power and the beauty of this formula illustrates the 
power of Excel.

Say that you have a friend who is superstitious about Friday the 13th. You want to illustrate how many 
Friday the 13ths your friend has lived through.

Illustration Credit: Chelsea Besse

Set up the simple worksheet below, with birthdate in B1 and =TODAY() in B2. Then a wild formula in B6 
evaluates every day that your friend has been alive to figure out how many of those days were Friday and 
fell on the 13th of the month. For me, the number is 86. Nothing to be afraid of.
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By the way, 2/17/1965 really is my birthday. But I don’t want you to send me a birthday card. Instead, for 
my birthday, I want you to let me explain how that amazing formula works, one small step at a time.

Have you ever used the INDIRECT function? When you ask for =INDIRECT("C3"), Excel will go to C3 and 
return whatever is in that cell. But INDIRECT is 
more powerful when you calculate the cell refer-
ence on-the-fly. You could set up a prize wheel 
where someone picks a letter between A and C 
and then picks a number between 1 and 3. When 
you concatenate the two answers, you will have 
a cell address, and whatever is at that cell ad-
dress is the prize. Looks like I won a photo book 
instead of the resort stay.

Do you know how Excel stores dates? When Excel shows you 2/17/1965, it is storing 23790 in the cell, be-
cause 2/17/1965, was the 23790th day of the 20th century. At the heart of the formula is a concatenation 
that joins the start date and a colon and the end date. Excel doesn't use the formatted date. Instead, it uses 
the serial number behind the scenes. So B3&":"&B4 becomes 23790:42167. Believe it or not, that is a valid 
cell reference. If you wanted to add up everything in rows 3 through 5, you could use =SUM(3:5). So, when 
you pass 23790:42167 to the INDIRECT function, it points at all of the rows.
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The next thing the killer formula does is to ask for the ROW(23790:42167). Normally, you pass a single cell: 
=ROW(D17) is 17. But in this case, you are passing thousands of cells. When you ask for ROW(23790:42167) 
and finish the formula with Ctrl+Shift+Enter, Excel actually returns every number from 23790, 23791, 
23792, and so on up to 42167. 

This step is the amazing step. In this step, we go from two numbers and “pop out” an array of 18378 num-
bers. Now, we have to do something with that array of answers. Cell B9 of the previous figure just counts 
how many answers we get, which is boring, but it proves that ROW(23790:42167) is returning 18378 
answers.

Let’s dramatically simplify the original question so you can see what is happening. In this case we'll find 
the number of Fridays in July 2015. The formula shown below in B7 provides the correct answer in B6.

At the heart of the formula is ROW(INDIRECT(B3&":"&B4)). This is going to return the 31 dates in July 2015. 
But the formula then passes those 31 dates to the WEEKDAY(<date>,2) function. This function will return 
a 1 for Monday, 5 for Friday, and so on. So the big question is how many of those 31 dates return a 5 when 
passed to the WEEKDAY(,2) function.

You can watch the formula calculate in slow motion by using the Evaluate Formula command on the 
Formula tab of the ribbon.

This is after INDIRECT converts the dates to a row reference.

In the next step, Excel is about to pass 31 numbers to the WEEKDAY function. Now, in the killer formula, it 
would pass 18,378 numbers instead of 31.
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Here are the results of the 31 WEEKDAY functions. Remember, we want to count how many are 5.

Checking to see if the previous array is 5 returns a whole bunch of True/False values. There are 5 True 
values, one for each Friday.

I cannot show you what happens next, but I can explain it. Excel cannot SUM a bunch of True and False 
values. It is against the rules. But if you multiply those True and False values by 1 or if you use the double-
negative or the N() function, you convert the True values to 1 and the False values to 0. Send those to SUM 
or SUMPRODUCT, and you will get the count of the True values.

Here is a similar example to count how many months have a day 13 in them. This is trivial to think about: 
Every month has a 13th, so the answer for a whole year better be 12. Excel is doing the math, generating 
365 dates, sending them all to the DAY() function, and figuring out how many end up on the 13th of the 
month. The answer, as expected, is 12.
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The next figure is a worksheet that does all of the logic the one killer formula shown at the start of this 
topic. I’ve created a row for every day that I’ve been alive. In column B, I get the DAY() of that date. In 
column C, I get the WEEKDAY() of the date. In column D, is B equal to 13? In Column E, is C=5? I then multi-
ply D*E to convert the True/False to 1/0.

I’ve hidden a lot of the rows, but I show you three random days in the middle which happen to be both a 
Friday and the 13th.

The total in F18381 is the same 86 that my original formula returned. A great sign. But this worksheet 
has 110,268 formulas. My original killer formula does all of the logic of these 110,268 formulas in a single 
formula.

Wait. I want to clarify. There is nothing magical in the original formula that gets smart and shortens the 
logic. That original formula really is doing 110,268 steps, probably even more, because the original formula 
has to calculate the ROW() array twice.

Find a way to use this ROW(INDIRECT(Date:Date)) in real life and send it to me in an e-mail (pub at mrexcel 
dot com). I’ll send a prize to the first 100 people to answer. Probably not a resort stay. More likely a Big Mac. 
But that’s the way it goes with prizes. Lots of Big Macs and not many resort stays.
I first saw this formula posted at the MrExcel.com message board in 2003 by Ekim. Credit was given to Harlan Grove. The formula 
also appeared in Bob Umlas‘s book This Isn't Excel, It's Magic. Mike Delaney, Meni Porat, and Tim Sheets all suggested the minus/
minus trick. SUMPRODUCT was suggested by Audrey Lynn and Steven White. Thank you all.

#31 Troubleshooting VLOOKUP
VLOOKUP is my favorite function in Excel. If you can do VLOOKUP, you are able to solve many problems in 
Excel. But there are things that can trip up a VLOOKUP. This topic talks about a few of them. 

But first, the basics of VLOOKUP in plain English.
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The data in A:C came from the IT department. You asked for sales by item and date. They gave you Item 
number. You need Item Description. Rather than wait for the IT department to re-run the data, you find the 
table shown in column F:G.

You want VLOOKUP to find the item in A2 while it searches through the first column of the table in 
$F$3:$G$30. When VLOOKUP finds the match in F7, you want VLOOKUP to return the description found in 
the second column of the table. Every VLOOKUP that is looking for an exact match has to end in False (or 
zero, which is equivalent to False). The formula below is set up properly.

Notice that you use F4 to add four dollar signs to the address for the lookup table. As you copy the formula 
down column D, you need the address for the lookup table to remain constant. There are two common 
alternatives: You could specify the entire columns F:G as the lookup table. Or, you could name F3:G30 with 
a name such as ItemTable. If you use =VLOOKUP(A2,ItemTable,2,False), the named range acts like an abso-
lute reference.

Any time that you do a bunch of VLOOKUPs, you need to sort the column of VLOOKUPs. Sort ZA, and any 
#N/A errors will come to the top. In this case, there is one. Item BG33-9 is missing from the lookup table. 
Maybe it is a typo. Maybe it is a brand-new item. If it is new, insert a new row anywhere in the middle of 
your lookup table and add the new item.
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It is fairly normal to have a few #N/A errors. But in the figure below, exactly the same formula is returning 
nothing but #N/A. When this happens, I see if I can solve the first VLOOKUP. You are looking up the BG33-8 
found in A2. Start cruising down through the first column of the lookup table. As you can see, the match-
ing value clearly is in F10. Why can you see this, but Excel cannot see it?

Go to each cell and press the F2 key. Here is F10. Note that the insertion cursor appears right after the 8.

Here is cell A2 in Edit mode. The insertion cursor is a couple of spaces away from the 8. This is a sign that at 
some point, this data was stored in an old COBOL data set. Back in COBOL, if the Item field was defined as 
10 characters and you only typed 6 characters, COBOL would pad it with 4 extra spaces.

The solution? Instead of looking up A2, look up the TRIM(A2).

The TRIM() function removes leading and trailing spaces. If you have multiple spaces between words, TRIM 
will convert them to a single space. In the figure below there are spaces before and after both names in A1. 
=TRIM(A1) removes all but one space in A3.
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By the way, what if the problem had been trailing spaces in column F instead of column A? Add a column 
of TRIM() functions to E, pointing to column F. Copy those and paste as values in F to make the lookups 
start working again.

The other very common reason that VLOOKUP won’t work is shown here. Column F has real numbers. 
Column A has text that looks like numbers.

Select all of column A. Press Alt+D, E, F. This does a default Text to Columns and will convert all text num-
bers to real numbers. The lookup starts working again.
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Bonus Tip: Replacing Columns of VLOOKUP with a Single MATCH
In the following figure, you are going to have to do 12 VLOOKUP functions for each account number. 
VLOOKUP is powerful, but it takes a lot of time to do calculations.

Plus, the formula has to be edited in each cell as you copy across. The third argument has to change from 2 
to 3 for February, then 4 for March, and so on.

One workaround is to add a row with the column numbers. Then, the 3rd argument of VLOOKUP can point 
to this row. At least you can copy the same formula from B4 and paste to C4:M4 before copying the whole 
set down.

But here is a much faster approach. Add a new column B with Where? as the heading. Column B contains 
a MATCH function. This function is very similar to VLOOKUP: You are looking for the value in A4 in the 
column P4:P227. The 0 at the end is like the False at the end of VLOOKUP. It specifies that you want an 
exact match. Here is the big difference: MATCH returns where the value is found. The answer of 208 says 
that A308 is the 208th cell in the range P4:P227. From a recalc time perspective, MATCH and VLOOKUP are 
about equal.
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I can hear what you are thinking. “What good is it to know where something is located? I’ve never had a 
manager call up and ask, ‘What row is that receivable in?’”

While humans rarely ask what row something is in, the INDEX function can use that position. The following 
formula tells Excel to return the 208th item from Q4:Q227.

As you copy this formula across, the array of values moves across the lookup table. For each row, you are 
doing one MATCH and 12 INDEX functions. The INDEX function is incredibly fast compared to VLOOKUP. 
The entire set of formulas will calculate 85% faster than 12 columns of VLOOKUP.
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Bonus Tip: VLOOKUP Left with INDEX/MATCH
What if your lookup value is to the right of the information that you want VLOOKUP to return? The conven-
tional wisdom says VLOOKUP cannot handle a negative column number in order to go left of the key.

Note: In the second section of this book, Szilvia Juhasz reveals how VLOOKUP can look left. See 
"#19 VLOOKUP – to the Left!" on page 194.

The solution is to use a MATCH to find where the name is located, and then use INDEX to return the correct 
value.

VLOOKUP was suggested by Rod Apfelbeck, Patty Hahn, John Henning, @ExcelKOS, and @tomatecaolho. INDEX/MATCH came 
from Mark Domeyer, Jon Dow, Justin Fishman, Donna Gilliland, Alex Havermans, Jay Killeen, Martin Lucas, Patrick Matthews, Mike 
Petry, Michael Tarzia, and @beatexcel. Thanks to all of you.
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Poster Credit: Bobby Rosenstock  
justAjar Design Press, http://www.justajar.com/



114	 MrEXCEL XL

#32 Replace Nested IFs with a Lookup Table
A long time ago, I worked for the vice president of sales at work. I was always modeling some new bonus 
program or commission plan. I became pretty used to commission plans with all sorts of conditions. The 
one below is pretty tame.

The normal approach is to start building a nested IF formula. You always start at either the high end or the 
low end of the range. “If sales are over $500K, then the discount is 20%; otherwise….” The third argument 
of the IF function is a whole new IF function that tests for the second level: If sales are over $250K, then the 
discount is 15%;  otherwise,….”

These formulas get longer and longer as there are more levels. The toughest part of such a formula is re-
membering how many closing parentheses to put at the end of the formula.

Mini Bonus Tip: Matching the Parentheses
Excel cycles through a variety of colors for each new level of parentheses. While Excel reuses the colors, it 

uses black only for the open-
ing parenthesis and for the 
matching closing parenthesis. 
As you are finishing the for-
mula below, just keep typing 
closing parentheses until you 
type a black parenthesis.

Back to the Nested Formula Tip

If you're using Excel 2003, your formula is already nearing the limit. Back then, you could not nest more 
than 7 IF functions. It was an ugly day when the powers that be changed the commission plan and you 
needed a way to add an eighth IF function. Today, you can nest 64 IF functions. You should never do this, 
but it is nice to know there is no problem nesting 8 or 9.

Rather than use the nested IF function, try using the unusual use for the VLOOKUP function. When the 
fourth argument of VLOOKUP changes from False to True, the function is no longer looking for an exact 
match.

Well, first VLOOKUP tries to find an exact match. But if an exact match is not found, then Excel settles into 
the row just less than what you are searching for.

Consider the table below. In cell C13, Excel will be looking for a match for $28,355 in the table. When it 
can’t find 28355, Excel will return the discount associated with the value that is just less. In this case, the 
1% discount for the $10K level.

When you convert the rules to the table in E13:F18, you need to start from the smallest level and proceed 
to the highest level. Although it was unstated in the rules, if someone is below $10,000 in sales, the dis-
count will be 0%. You need to add this as the first row in the table.
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Caution: When you are using the “True” version of VLOOKUP, your table has to be sorted ascend-
ing. Many people believe that all lookup tables have to be sorted. But a table needs to be sorted 
only in the case of doing an approximate match.

What if your manager wants a completely self-contained formula and does not want to see the bonus 
table off to the right? After building the formula, you can embed the table right into the formula. 

Put the formula in Edit mode by double-clicking the cell or by selecting the cell and pressing F2.

Using the cursor, select the entire second argument: $E$13:$F$18.

Press the F9 key. Excel will embed the lookup table as an array constant. In the array constant, a semicolon 
indicates a new row, and a comma indicates a new column.

Press Enter. Copy the formula down to the other cells.

You can now delete the table. The final formula is shown below.

Thanks to Mike Girvin for teaching me about the matching parentheses. The VLOOKUP technique was suggested by Danny Mac, 
Boriana Petrova, Andreas Thehos, and @mvmcos.
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#33 Speed Up VLOOKUP
VLOOKUP is a relatively expensive function. When you are looking for an exact match, Excel has to look 
through the lookup table one row at a time.

The workbook that I am using today is doing 7000 VLOOKUPs into a table of 116,000 items. On a really fast 
64-bit machine with 8 cores, the recalc time is 3.01 seconds.

One way to improve VLOOKUP is to move the best-selling items to the top of the lookup table. Get a report 
of the top 100 best-selling items and move those items to the top of the list. Sorting by popularity im-
proves the recalc time to 0.369 seconds. This is eight times faster than the first result.

But there is a way to speed things up even more. As you are building your VLOOKUP, when you get to the 
fourth argument to choose False, there is another option that is hardly ever used. Excel says “True” does an 
“approximate match.” This is not at all correct. If the Excel team were being honest, they would explain that 
True “provides a correct answer a lot of the time, but other times, without any warning, we are going to slip 
the wrong answer in there. I hope you don’t mind restating your numbers to the Securities and Exchange 
Commission.”

Sure, there is a proper time to use True. See "#32 Replace Nested IFs with a Lookup Table" on page 114. 
But it would be really bad to use True when you are trying to do an exact match.

If you try to use True for an exact match, you will get the right answer a lot of the time. But when the item 
you are looking for is not in the table, Excel will give you the value from a different row. This is the part that 
makes “True” a non-starter for everyone in Accounting. Close is never correct in Accounting.



THE TOP 40	 117 

1

Note: I learned the following trick from Charles Williams. He is the world’s foremost expert 
on worksheet speed. If you have a slow workbook, hire Charles Williams for a half day of 
consulting. He can find the bottlenecks and make your worksheet faster. Find Charles at 
http://www.decisionmodels.com.

While I and all accountants reject the “True” argument of VLOOKUP because of the unpredictability, Charles 
Williams argues for True. He points out the True is much faster than False. Hundreds of times faster. He con-
cedes that sometimes you get the wrong answer. But he has a way to deal with the wrong answers.

Charles actually wants you to do two VLOOKUPs. First, do a VLOOKUP and return column 1 from the table. 
See if the result is what you were looking up in the first place. If that result matches, then you know it is 
safe to do the real VLOOKUP in order to return some other column from the table:

=IF(VLOOKUP(A2,Table,1,True)=A2,"All is good","The Answer will be wrong")

On the face of it, this seems insane. To use Charles’ method, you have to do twice as many VLOOKUPs. But, 
when you time the calculation time for this method, it is 35 times faster than the normal VLOOKUP.

Note that while most lookup tables do not have to be sorted, when you are using True as the fourth argu-
ment, the table does have to be sorted. For a 7-minute discussion of how the True version of VLOOKUP 
hops through the lookup table, see http://mrx.cl/TrueVLOOKUP.
Thanks to Charles Williams for teaching me this feature and to Scott St. Amant for nominating it for a top 40 tip.

Chad Thomas
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#34 Protect All Formula Cells
Worksheet protection in Excel is a little strange to use. Using the steps below, you can quickly protect just 
the formula cells in your worksheet.

It seems unusual, but all 16 billion cells on the worksheet start out with their Locked property set to True. 
You need to unlock all of the cells first.

1. Select all cells by using the icon above and to the left of cell A1.

2. Press Ctrl+1 (that is the number 1) to open the Format Cells dialog.

3. In the Format Cells dialog, go to the Protection tab. Uncheck the Locked status. Click OK.

While all cells are still selected, select Home, Find & Select, Formulas.

At this point, only the formula cells are selected. Press Ctrl+1 again to 
display Format Cells. On the Protection tab, choose Locked to lock all 
of the formula cells.

But locking cells does nothing until you protect 
the worksheet. On the Review tab, choose Protect 
Sheet. In the Protect Sheet dialog, choose if you 
want people to be able to select your formula 
cells or not. Don’t bother putting in a password. 
Passwords are easily broken and easily lost. You will 
find yourself paying $39 to the Estonians who sell 
the Office password-cracking software.
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#35 Back into an Answer Using Goal Seek
Do you remember in "#27 Discover New Functions Using fx" on page 94, when I showed you how to cal-
culate a loan payment using the Insert Function dialog? Back in that example, the monthly loan payment 
was going to be $493.54. I did not mention it at the time, but my monthly budget for car payments is $425.

If you are about the same age as me, and spent your summers watching TV, you might remember a crazy 
game show called The Price Is Right. Long before Drew Carey, the venerable Bob Barker would give away 
prizes using a variety of games. One that I recall is the Higher/Lower game. Bob would give you the car if 
you could state the price of the car. You would guess. Bob would shout Higher or Lower. I think you had 20 
seconds to narrow your guesses to the exact price.

A lot of times, I feel like those summers watching Bob Barker trained me to find answers in Excel. Have you 
ever found yourself plugging in successively higher and lower values into an input cell, hoping to arrive at 
a certain answer?

Illustration: Chad Thomas

A tool that is built in to Excel that does exactly this set of steps. On the Data tab, in the Data Tools group, 
look for the What-If Analysis dropdown and choose Goal Seek.
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Below, you are trying to set the payment in B5 to 
$425 by changing cell B1

.

Goal Seek finds the correct answer within a second.

Note that the formula in B5 stays intact. The only thing that changes is the input value typed in to B1.

Also, with Goal Seek, you are free to experiment with changing other input cells. You can still get the $425 
loan payment and the $25,995 car if your banker will offer you a 71.3379-month loan!

Thanks to Jon Wittwer of Vertex42.com and to @BizNetSoftware for suggesting Goal Seek.

#36 Do 60 What-If Analyses with a Data Table
Goal Seek lets you find the set of inputs that lead to a particular result. Sometimes, you want to see many 
different results from various combinations of inputs. Provided that you have only two input cells to 
change, the data table provides a fast way to compare alternatives.

Using the loan payment example, say that you want to calculate the price for a variety of principal bal-
ances and for a variety of terms.
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Make sure that the formula you want to model is in the top-left corner of a range. Put various values for 
one variable down the left column and various values for another variable across the top.

From the Data tab, select What-If Analysis, data table.

You have values along the top row of the input table. You want Excel to plug those values into a certain 
input cell. Specify that input cell as the Row Input Cell. 

You have values along the left column. You want those plugged into another input cell. Specify that cell as 
the Column Input Cell.
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When you click OK, Excel will repeat the formula in the top-left column for all combinations of the top row 
and left column. In the image below, you see 60 different loan payments based on various results.

Note that I formatted the table results to have no decimals and used Home, Conditional Formatting, Color 
Scale to add the red/yellow/green shading.

Here is the great part: This table is “live.” If you change the input cells along the left column or top row, the 
values in the table will recalculate. Below, the values along the left are focused on the $23K to $24K range.

Thanks to Owen W. Green for suggesting tables.

Bonus Tip: data table from a Blank Cell
Note: If you took a class on financial modeling in college, you likely used a textbook written by 
Professor Simon Benninga. I met Simon twice, when we were judges for the ModelOff World 
Financial Modeling Championships. He truly enjoyed what he was doing and showed me this cool 
Excel trick.

Simon Benninga tells a story of two illegal pastimes when he was attending private school in New York. 
The first was smoking in the bathroom. The second was a game called Penny Pitching. You and another 
student would each flip a penny. If you get one head and one tail, you win the penny. If the coins match 
(heads/heads or tails/tails), the other student gets the penny.

It is simple to model this game in Excel. If RAND()>.5, you win a penny. Otherwise, you lose a penny. Do 
that for 25 rows and chart the result. Press F9 to play 25 more rounds. 

This is known as a Random Walk Down Wall Street. Simon would always point out a result like this one, 
where a hot young stock analyst is on fire with a series of wins, but then a series of losses wipe out the 
gain. This is why most investment prospectuses point out that past results are not a guarantee of future 
returns.
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Instead of 25 trials, extend your table in A and B to run 250 trials. This would be like playing one round of 
penny pitching every work day for a year. Build a row of statistics about that year:

Create an odd data table where the blank cell in column F is the corner cell. Leave the Row Input Cell 
blank. Specify any blank cell as the Column Input Cell.

When you create the table, Excel will run the 250 coin flips once per row. This 30-row table models the 
entire career of a stock analyst. Every time you press F9, Excel runs the 250-row model for each of 30 years. 
You can watch an entire 30-year career be modeled with the simple press of F9.

Thanks to Professor Simon Benninga for showing me this technique. He had a chance to review this book just before he lost a 
battle to cancer in 2015. I trust he is in a better place - one where Pivot Tables don't default to Compact Form!
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#37 Find Optimal Solutions with Solver
Excel was not the first spreadsheet program. Lotus 1-2-3 was not the first spreadsheet program. The first 
spreadsheet program was VisiCalc in 1979. Developed by Dan Bricklin and Bob Frankston, VisiCalc was 
published by Dan Fylstra. Today, Dan runs Frontline Systems. His company wrote the Solver used in Excel. It 
has also developed a whole suite of analytics software that works with Excel.

If you have Excel, you have Solver. It may not be enabled, but you have it. To enable Solver in Excel, press 
Alt+T followed by I. Add a checkmark next to Solver.

To successfully use Solver you have to build a worksheet model that has three elements:

●● There has to be a single Goal cell. This is a cell that you either want to minimize, maximize, or set to a 
particular value.

●● There can be many input cells. This is one fundamental improvement over Goal Seek, which can only 
deal with one input cell.

●● There can be constraints.

Your goal is to build the scheduling requirements for an amusement park. Each employee will work five 
straight days and then have two days off. There are seven different possible ways to schedule someone for 
five straight days and two off days. These are shown as text in A4:A10. The blue cells in B4:B10 are the input 
cells. This is where you specify how many people you have working each schedule.

The Goal cell is total Payroll per Week, shown in B17. This is straight math: Total People from B11 times $68 
salary per person per day. You will ask Solver to find a way to minimize the weekly payroll.

The red box shows values that will not change. This is how many people you need working the park 
on each day of the week. You need at least 30 people on the busy weekend days – but as few as 12 on 
Monday and Tuesday. The orange cells use SUMPRODUCT to calculate how many people will be scheduled 
each day based on the inputs in the blue cells.

The icons in row 15 indicate whether you need more people, or fewer people or whether you have exactly 
the right number of people.

First, I tried to solve this without Solver. I went with 4 employees each day. That was great, but I did not 
have enough people on Sunday. So, I started increasing schedules that would give me more Sunday em-
ployees. I ended up with something that works: 38 employees and $2,584 of weekly payroll.
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Click the Solver icon on the Data tab. Tell Solver that you are trying to set the payroll in B17 to the mini-
mum. The input cells are B4:B10. 

Constraints fall into obvious and not-so-obvious categories.

The first obvious constraint is that D12:J12 has to be >= D14:J14.

But, if you tried to run Solver now, you would get bizarre results where you have fractional numbers of 
people and possibly a negative number of people working certain schedules.

While it seems obvious to you that you can’t hire 0.39 people, you need to add constraints to tell Solver 
that B4:B10 are >= 0 and that B4:B10 are integers.

Choose Simplex LP as the solving method and choose Solve. In a few moments, Solver presents one opti-
mal solution.

Solver found a way to cover the amusement park staffing using 30 employees instead of 38. The savings 
per week is $544 – or more than $7,000 over the course of the summer.
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Notice the five stars below Employees Needed. The schedule that Solver proposed meets your exact 
needs for five of the seven days. The byproduct is that you will have more employees on Wednesday and 
Thursday than you really need.

I can understand how Solver came up with this solution. You need a lot of people on Saturday, Sunday, 
and Friday. One way to get people there on those day is to give them Monday and Tuesday off. That is why 
Solver put 18 people with Monday and Tuesday off.

But just because Solver came up with an optimal solution does not mean that there are not other equally 
optimal solutions. 

When I was just guessing at the staffing, I didn’t really have a good strategy. 

Now that Solver has given me one of the optimal solutions, I can put on my logic hat. Having 28 college-
age employees on Wednesday and Thursday when you only need 15 or 18 employees is going to lead to 
trouble. There won’t be enough to do. Plus, with exactly the right headcount on five days, you will have to 
call in someone for overtime if someone else calls in sick.

I trust Solver that I need to have 30 people to make this work. But I bet that I can rearrange those people to 
even out the schedule and provide a small buffer on other days.

For example, giving someone Wednesday and Thursday off also ensures that the person is at work 
Friday, Saturday, and Sunday. So, I manually moved some workers from the Monday, Tuesday row to the 
Wednesday Thursday row. I kept manually plugging in different combinations and came up with this so-
lution which has the same payroll expense as Solver but better intangibles. The overstaff situation now 
exists on four days instead of two. That means you can handle call-offs on Monday through Thursday with-
out having to call in someone from their weekend. 
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Is it bad that I was able to come up with a better solution than Solver? No. The fact is that I would not have 
been able to get to this solution without using Solver. Once Solver gave me a model that minimized costs, 
I was able to use logic about intangibles to keep the same payroll.

If you need to solve problems more complex than Solver can handle, check out the premium Excel solvers 
available from Frontline Systems: http://mrx.cl/solver77.
Thanks to Dan Fylstra and Frontline Systems for this example. Walter Moore illustrated the XL roller coaster.

#38 Load a File List into Excel with Power Query
Power Query is built in to Excel 2016 and is available as a free download in certain versions of Excel 2010 

and Excel 2013. The tool is designed to extract, 
transform and load data into Excel from a vari-
ety of sources. The best part: Power Query re-
members your steps and will play them back 
when you want to refresh the data. As this 
book goes to press, the Power Query features 
in Excel 2016 are on the Data tab, in the Get & 
Transform group, under New Query. It is hard 
to predict whether Microsoft will retroactively 
rename Power Query to Get & Transform in 
Excel 2010 and Excel 2013.

This free add-in is so amazing, there could be 
a whole book about it. But as one of my top 
40 tips, I want to cover something very simple: 
bringing a list of files into Excel, along with the 
file creation date and maybe size. This is useful 
for creating a list of budget workbooks or a list 
of photos.
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In Excel 2016, you select Data, New Query, From File, From Folder. In earlier Excel versions, use Power 
Query, From File, From Folder. Specify the folder:

While editing the query, right-click any 
columns that you don’t want and choose 
Remove.

To get File Size, click this icon in the 
Attributes column:

A list of extra attributes appears. Choose 
Size.

A large list of Transform options are available.

When you are done editing the query, click Close & Load.

The data loads to Excel as a table. 
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Later, to update the table, select Data, Refresh All. Excel remembers all the steps and updates the table 
with a current list of files in the folder.

For a complete description of the feature formerly known as Power Query, 
check out M is for (Data) Monkey by Ken Puls and Miguel Escobar.
Thanks to Miguel Escobar, Rob Garcia, Mike Girvin, Ray Hauser and Colin Michael for nomi-
nating Power Query.

#39 Pivot Table on a Map Using 3D Maps
3D Maps (née Power Map) is available in the Office 365 versions of Excel 2013 and all versions of Excel 
2016. Using 3D Maps, you can build a pivot table on a map. You can fly through your data and animate the 
data over time. 

3D Maps lets you see five dimensions: latitude, longitude, color, height, and time. Using it is a fascinating 
way to visualize large data sets.

3D Maps can work with simple one-sheet data sets or with multiple tables added to the Data Model. Select 
the data. Choose Insert, 3D Maps.

Next, you need to choose which fields are your geography fields. This could be Country, State, County, Zip 
Code, or even individual street addresses.

You are given a list of fields in your data the drop zones HEIGHT, CATEGORY, and TIME.
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Here is a map of Merritt Island, Florida. The various 
colors are different housing allotments. Each col-
ored dot on the map is a house with a dock, either 
on a river or one of many canals dredged out in the 
1960s and 1970s.

Using the time slider, you can go back in time to 
any point. Here is when NASA landed the first man 
on the Moon. The NASA engineers had just started 
building waterfront homes a few miles south of 
Kennedy Space Center.

Use the wheel mouse to scroll in. You can actually 
see individual streets, canals, and driveways.

Hold down the Alt key and drag sideways to rotate 
the map. Hold down the Alt key and drag up to tip 
the map so your view is closer to the ground.

Hover over any point on the map to get details such as last sale date and amount.

In the default state of Power Map, each data point occupies about one city block. To be able to plot many 
houses on a street, use the Gear Wheel, Layer Options and change the thickness of the point to 10%.

To get the satellite imagery, open the Themes dropdown and use the second theme.
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The 3D Maps feature provides a completely new way to look at your data. It is hard to believe that this is 
Excel.

By the way, my thanks to Tony Giannotti at Serving Brevard Realty for showing me many of the houses in 
this area. If you need a house near Merritt Island, give Tony a call.
Thanks to Igor Peev and Scott Ruble at Microsoft for this cool new feature.

Illustration: Libby Norcross
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#40 Avoid Whiplash with Speak Cells
I hate having to hand-key data into Excel. Between the Internet and Power Query, there almost always is 
a way to find the data somewhere. I hate when people send a PDF where they scanned some numbers 
and are sending the numbers as a picture. But even then, a free trial of Able2Extract Pro (http://mrx.cl/
ExtractPDF) will get the actual number into Excel. Even so, sometimes, you end up keying data into Excel.

One of the painful parts about keying in data is that you have to proofread the numbers. So, you are look-
ing at the sheet of paper, then the screen, then the paper, then the screen. You will end up with a sore 
neck. Wouldn’t it be nice if you had someone to read you the screen so you can keep your eye on the 
paper? It’s built in to Excel.

Right-click on the Quick Access Toolbar and choose Customize Quick Access Toolbar.

Change the top-left dropdown to Commands Not in the Ribbon. Scroll down to the S entries until you find 
Speak Cells. Add all five of these commands to the Quick Access Toolbar

Select your range of numbers and click Speak Cells. Excel will read you the numbers.

Tip: You can customize the voice in the Windows Control Panel. Search for Tex to Speech. There is 
a setting for Voice Speed. Drag that slider to half way between Normal and Fast to have the voice 
read your cells faster.

http://mrx.cl/ExtractPDF
http://mrx.cl/ExtractPDF
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Bonus Tip: A Great April Fool’s Day Trick 
Do you want a harmless prank to pull on a co-worker? When he leaves his leave their desk to grab a cup 
of coffee, add the fifth icon to his Quick Access Toolbar: Speak Cells on Enter. Click the icon once and the 
computer will say, “Cells will now be spoken on Enter.” 

Once you’ve turned on Speak Cells on Enter, right-click the icon in the Quick Access Toolbar and choose 
Remove from Quick Access Toolbar. This will hide any sign that you were there.

Your co-worker comes back, sits down, and starts to build a worksheet. The computer will repeat back ev-
erything the co-worker types.

If you have a little more time, add the following macro to the code pane for the current worksheet. Speak 
Cells on Enter with attitude:

If only you could get the voice to be Nichelle Nichols, it would be perfect.
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Part 2 - 40 Keyboard Shortcuts
As I started polling readers about their favorite Excel tips, a large number of those were keyboard short-
cuts. Some readers, such as Matt Kellett, Olga Kryuchkova, Mike Dolan Fliss, and @model_citizen suggest-
ed that one of the 40 best tips has to be keyboard short cuts.

These are presented in order of popularity. If a lot of readers suggested a tip, it is at the top. After the first 
eight or so, they are then sorted by my subjective sequence.

1. Ctrl+1 to Format the Selection

Ctrl+1 (the number one) works to format whatever is selected. Whether it is a cell, Smart Art, a picture, a 
shape, or the March data point in a column chart, press Ctrl+1.
Thanks to Mitja Bezenšek, Alexa Gardner, Andrej Lapajne, Schmuel Oluwa, Jon Peltier, 
@ExcelNewss, @JulianExcelTips

2. Ctrl[+Shift]+Arrow to Navigate or Select

Your cell pointer is sitting at the top of 50K rows of data and you need to get to the bottom. If you have a 
column with no blanks, press Ctrl+Down Arrow to jump to the end of the data 
set. 

In the following figure, Ctrl+Down Arrow will jump to K545. Ctrl+Left Arrow will jump to A1. Ctrl+Right 
Arrow will jump the gap of empty cells and land on N1.

Add the Shift key in order to select from the active cell to the landing cell. Starting from A1 in the above 
figure, press Ctrl+Shift+Down Arrow to select A1:A545. While still holding down Ctrl+Shift, press the right 
arrow to select A1:K545. If it seems awkward at first, try it for a few days until you get the hang of it.
Thanks to Captain Excel, @Cintellis, José de Diego, Mike Girvin, Elchin Khalilov, Crystal Long, Paul Sasur, @XLStudioWorks.

3. Ctrl+. to Jump to Next Corner

Once you have a large range selected, press Ctrl+Period to move to the next corner of the selection. If the 
selection is rectangular, you move in a clockwise fashion. From the bottom right corner, press Ctrl+. twice 
to move to the top left.
Thanks to Crystal Long, Steve McCready

4. Ctrl+5 for Strikethrough
This is great for crossing things off your to-do list.
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5. Ctrl+* to Select Current Region

This one is easier if you have a number keypad so you don’t have to press shift to get to an asterisk. If I 
could slow down enough to stop pressing Ctrl+Shift+Down Arrow followed by Ctrl+Shift+Right arrow, I 
would realize that Ctrl+* is much shorter and does not get tripped up by blank cells. It is really superior in 
every way to keyboard tip #2. But my muscle memory still prefers tip #2. Thanks to @Excelforo

6. Ctrl+Enter to Copy Formula into Entire Selection

Ken Puls, who is the king of Power Query, says, “You would think my favorite Excel tip would be Unpivot 
with Power Query, but my favorite all-time is Ctrl+Enter.” Say that you want to enter a formula into 400 
cells. Select the 400 cells. Type the formula in the first cell. Press Ctrl+Enter and Excel enters a similar for-
mula in all cells of the selection.

Gavin White points out another use. You enter a formula in G2. You need to copy the formula down but 
not the formatting. Select G2:G20. Press the F2 key to put the cell in Edit mode. When you press Ctrl+Enter, 
the formula is copied but not any formatting. Thanks to Crystal Long, Schmuel Oluwa, Ken Puls, Peter Raiff, Sven Simon, 
Gavin Whyte.

7. Date or Time Stamp

Press Ctrl+Shift+: to enter the current time. Press Ctrl+; for the current date. Note the shortcut enters the 
current time, not a formula. Thanks to Olga Kryuchkova, Tim O’Mara

8. Ctrl+Backspace to Bring the Active Cell into View

This is a great trick that I never knew. Say that C1 is the active cell. You’ve used the scroll bars and now you 
are looking at ZZ999. To bring the window back to encompass the active cell, press Ctrl+Backspace. 
Thanks to Olga Kryuchkova, Schmuel Oluwa.

9. Alt+= is AutoSum

Press Alt+= to invoke the AutoSum function. Thanks to Dawn Bjork Buzbee, Olga Kryuchkova

10. Ctrl+PageDown and Ctrl+PageUp to Jump to Next Worksheet

If you need to move from Sheet1 to Sheet5, press Ctrl+PageDown four times. If you are at Sheet9 and need 
to move to Sheet3, press Ctrl+PageUp six times. Thanks to Jeneta Hot.

11. Use Ctrl+Click to Select Noncontiguous Cells

If you have to select two regions, select the first one, then hold down Ctrl while clicking on other cells or 
regions. – Thomas Fries

12. Tab to AutoComplete

This one is maddening. You type =VL to start VLOOKUP. The AutoComplete shows there is only one func-
tion that starts with VL. But if you press Enter, you will get a #NAME? error.
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The correct way to choose VLOOKUP is to press Tab! Thanks to Ashish Agarwal.

13. Press Shift+F8 for Add to Selection

Select the first range. Press Shift+F8 and you are in Add to Selection mode. Scroll anywhere. Select the 
next range. Then another range. And so on, without ever touching Ctrl. To return to normal, press Esc. - 
Neil Charles. A bonus tip from Bill Hazlett: if you select A1, press F8, then click in S20 you will select from 
A1:S20.

14. Select Entire Column or Row

Ctrl+Spacebar selects the whole column. Shift+Spacebar selects the whole row. How can you remember 
which is which? The “C” in Ctrl stands for the “C” in column. Also, the “S” in Shift is adjacent in the alphabet 
to the “R” in Row. Another way to remember which is which: the Shift key is much longer (like a row!) than 
Ctrl.
Thanks to Michael Byrne, Jeneta Hot, and Bob Umlas.

15. See All Formulas with Ctrl+`

Many folks in the United States think this is Ctrl+~, but it is actually the grave accent to toggle into and out 
of Show Formulas mode.

16. F3 to Paste a Name into a Formula

I am not a huge fan of this, since you can start typing the name and then choose from AutoComplete. But I 
know the trick has its fans, include Mike Girvin and Johan van den Brink.

17. Apply Number Format using Ctrl+Shift+1 through 6

I had never memorized these, but I am going to start using some of them. Ctrl+Shift+1 (also known as 
Ctrl+!), will apply a number format, 2 decimals, thou-
sands separator, and negatives shown with a minus 
sign. The other five make some reasonable sense, with 
Ctrl+% doing percentages, Ctrl+@ doing time, Ctrl+$ 
doing currency, Ctrl+^ doing exponential.
Thanks to Matthew Bernath.

18. Control Word Wrap with Alt+Enter

To move to a new row in the current cell, press Alt+Enter. Isn’t this the same as turning on Word Wrap? Sort 
of, but Alt+Enter lets you control where the words wrap. - Olga Kryuchkova

19. Ctrl+[ to jump to Linked Cell

You are in a cell that points to Sheet99!Z1000. Press Ctrl+[ to jump to that cell. This even works if you have 
links between workbooks, even if the other workbook is closed! - @Heffa100 with Bob Umlas

20. Alt+F1 Charts the Selected Data

Select some data. Press Alt+F1. You get a chart of the data. You might remember F11 doing the same 
thing. But F11 creates the chart as a chart sheet. Alt+F1 embeds the chart in the current sheet.
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21. Shift+F11 inserts a Worksheet

I never knew this one, but it makes sense as a corollary to F11. If F11 inserted a chart sheet, then Shift+F11 
inserted a new worksheet. You can also use Alt+I, W to insert a worksheet, Alt+I, R to insert a row or Alt+I, C 
to insert a column. - Olga Kryuchkova.

22. Alt+E, S, V to Paste Special Values

I can do Alt+E, S, V Enter with my eyes closed. Alt+E opened the Excel 2003 Edit menu. S chose Paste 
Special. V chose Values. Enter selected OK. There are a whole series of these to learn: Alt+E, S, T pastes for-
mats. Alt+E, S, F pastes formulas. Alt+E, S, W pastes column widths. Alt+E, S, D, V does a Paste Special Add, 
but does not screw up the formatting. Alt+E, S, E does a Transpose. To see all the possibilities, press Alt+E, S 
and then look for the underlined letters. - Matthew Bernath & Laura Lewis.

23. Change Macro Security with Alt+T, M, S. Activate Add-Ins with Alt+T, I

These are really useful now that the settings are buried deep in Excel options. – Ron de Bruin

24. Enable the Filter Dropdowns with Ctrl+Shift+L

Toggle the filters on or off with Ctrl+Shift+L. Or, press and release Alt, A, T. –David Hager, Andew Walker

25. Hold down Alt to Snap to Grid

If you are drawing any shape, Alt will cause that shape to exactly line up with the borders of cells. - Rickard 
Wärnelid

26. Ctrl+W Closes a Workbook but Leaves Excel Open

If you have one workbook open and you click the “X” in the top right corner, you will close Excel. Ctrl+W 
will close that workbook but leave Excel open. - Dave Marriott

27. Use F5 to Sneak Into a Hidden Cell

You’ve hidden column D, but you need to see what is in D2. Press Ctrl+G or F5 to open the Go To dialog. 
Type D2 and press Enter. The cell pointer moves to the hidden cell D2 and you can see the value in the for-
mula bar. You can now use the down arrow to move within the hidden column D, always seeing the value 
in the formula bar.

28. Alt+D, E, F to Convert Numbers Stored as Text to Numbers

Select the whole column. Alt+D, E, F. The text numbers are converted to numbers. You are actually doing a 
default Text to Columns with this shortcut.

29. Alt+O, C, A to AutoFit the Column

Select some cells. Alt+OCA and the column is wide enough for the longest value in the selection.

30. Ctrl+’ to Copy the Exact Formula Down (aka Ditto)

You have to sum in D10 and average in D11. Create the AutoSum in D10. When you press Enter, you 
are in D11. Press Ctrl+’ to bring the exact formula down without changing the cell reference. If D10 is 
=SUM(D2:D9), the formula in D11 will also be =SUM(D2:D9).

From there, you can press F2, Home, Right, AVERAGE, Delete, Delete, Delete, Enter. It sounds crazy, but the 
engineers at General Electric in Cleveland swear by it.

If you use Ctrl+Shift+” it will bring the value from above into the current cell, eliminating any formula.
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31. Alt+W, F, F to Freeze Panes

There are hundreds more shortcuts like this which you can easily learn. Press and release Alt in Excel to see 
key tips for each tab in the Ribbon (plus numbered key tips for the Quick Access Toolbar. Press the letter 
corresponding to a Ribbon tab to see the key tips for all of the commands on that tab. In this particular 
case, clicking Alt+W+F reveals a third level of key tips, so Alt+W, F, F completes the command. - Bradford 
Myers

32. Ctrl+C to Copy

33. Ctrl+V to Paste

34. Ctrl+X to Cut

35. Ctrl+B for Bold

36. Ctrl+I for Italics

37. Ctrl+U for Underline

38. Ctrl+N for New Workbook

39. Ctrl+T (or Ctrl+L) to Format as Table

40. Never Forget to Right-click

So many timesavers that are linked to the right mouse button that people forget about. – Colin Foster

Hey! This is not a keyboard shortcut! But wait…it is. You can open that right-click menu using the Program 
key on the bottom right side of your keyboard. Release the Program key then press any underlined letter 
to invoke the command. Program key, L will invoke the new Excel 2016 Smart Lookup.
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Part 3 - Excel 30 Anniversary Tips
#1 Wingdings and Other Unsung Font Heroes
So you want some cool visuals to go on that dashboard. Conditional formatting icon sets are fun but 
limited.

That’s pretty much it. Not much more customization possible.

Unfortunately, you can’t really change color schemes, icon size, or the icons themselves. So what if you’re 
bored with all of them?

Enter Excel’s unsung font heroes. I’m looking at you, Wingdings, Wingdings 2, and Webdings. These fonts 
provide a great workaround for conditional formatting’s limited icon set options, essentially allowing you 
to create your own icon sets.

There are Hundreds of Choices

First, let’s explore the amazing selection of characters generated by these fonts. One quick way to do this is 
to create a character map you can use for reference. The CHAR() function is what you’ll need. CHAR() takes 
a single argument – a number – and returns a character from your computer’s internal character set that 
corresponds to that number. For instance, character number 65, when formatted as Arial, returns a capital 
letter A.
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Supplying CHAR() with a code number, 65, and comparing results using Arial, and then four of your special unsung hero 
fonts.

Note: Keep in mind, that there aren’t many interesting icon choices for special font sets outside the 
range of CHAR(33) through Char(255).

Using Special Fonts in Formulas

Now that you have a character map, you can browse through the available icons and think about which 
ones you might want to use for your report. Let’s start with a simple report showing unit sales by product 
line by month.

Next, choose the icons you want to apply by browsing through your CHAR() character map. You can see 
that when you use a Webdings font, CHAR(246) will give you a cat and CHAR(33) will give you a spider. 
Cool!
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Just like with conditional formatting, you’re going to need some rules to tell Excel when to display each 
icon. So you come up with a plan based on the notes you took in that last department meeting.

Back at your desk, you open up your report in Excel. You add some placeholder columns to the left of each 
month column to make room for your icons. Next, you look at those notes and translate them into Excel 
formulas. Recall that you want to display a cat for each value greater than or equal to 300, a spider for each 
value greater than or equal to 200, and no icon for all others. This sounds like a job for an IF() function. 
Recalling that the CHAR() codes for you chosen icons are 246 (for cats) and 33 (for spiders), you have:

=IF(C10>=300,CHAR(246),If(C10>=200,CHAR(33),""))
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Note: Remember when creating nested IF() statements, you should use descending order for each 
logical test. Notice here that you start by testing whether your value is >=300, then you perform 
the >=200 test, and so on. If you don’t use descending order, you will eventually get erroneous 
results.

Note that at this point, you are still using a “regular” style font while you’re typing the initial formula. Of 
course, you’re not going to see any cats or spiders as long as you are still using Arial, Verdana, or any other 
familiar font. But if you can wait until after you’ve constructed your formula to apply the correct font, you 
can avoid having to see this weird and unreadable-looking thing in B10 as you type. (Yes, you could always 
just look at the formula bar, but it’s nice to be able to see what you are typing in-cell also.)

Finishing Touches

Now that your formula is done, you can apply the Webdings font and copy the formula to the remaining 
placeholder columns D, F, H, J, and L. You should also resize these columns to be narrower, since they only 
need to hold a single icon in each cell. 19 pixels seems about right.

You’re nearly there. Just add a report header plus a few more cosmetic finishing touches to your final 
report design. I like to add a left margin spacer column to the left of A. You can also:

Remove gridlines. This is often a nice choice for reports that need to have a clean look because they will 
be viewed on a monitor (as opposed to being viewed on old school paper only). Removing gridlines is 
simple. In the Home tab, Show group, uncheck the box next to Gridlines.

Apply conditional formatting to the icons. Wait. Didn’t I just spend the last two pages complaining 
about conditional formatting? Yes. But this has nothing to do with the conditional formatting icon sets. In 
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this case you use conditional formatting to modify the font colors, so your cats will always be orange, and 
your spiders will be black. 

To do this, select all the cells that contain your icons. Press the Ctrl key while you make your selections to 
select noncontiguous ranges. Just before you launch the conditional formatting menus, make sure you 
have selected all the cells where your cat and spider icons appear.

Notice that even though you’re selecting multiple cells at once, Excel considers C10 your “active” cell. This 
becomes obvious when you glance up in the Name box. This is important to keep in mind as you create 
your conditional formatting rules.

With the cells still highlighted, from the Home tab, click Conditional Formatting. Click New Rule…. From 
the list of rule types, choose Use a Formula to Determine Which Cells to Format. Then type your rules in 
the rules description box. This is where you will create a logical test to determine which font colors to use. 
Because C10 is your “active” cell, that is the cell reference you use in your logical test formula.

Returns TRUE if the value in C10 equals CHAR(246). But really, the same logic will apply to all cells in your selection.

You don’t want to use any absolute references in your conditional formatting formula here. You want the 
conditional formatting rules to apply relatively to each cell in your selection so Excel evaluates each cell in-
dividually and decides which format to apply, if any.
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Next, you must tell Excel what kind of format to apply for each cell where the test returns TRUE. CHAR(246) 
gives you cats, and you love orange cats, so you choose an orange font. In the New Formatting Rule dialog, 
you click Format…, and choose the font color you want.

You click OK twice to exit all conditional formatting menus. At this point, your conditional formatting “all 
cats in orange” rule is done. In fact, you don’t need to create a separate rule for spiders, because you are 
already using a standard black font. 

Your report is done. Neat!

Thanks to Olga Kryuchkova for suggesting Conditional Formatting.
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#2 In-Cell Charting with REPT()
File this tip under “charts without charts.” The wonder that is Excel offers many ways you can creatively 
display data using methods that in many cases are much faster and easier than creating and maintaining 
charts. One of these is a little-known function called REPT().

About REPT() 

REPT() takes two arguments: text, a character to repeat, and num_times, a number that tells Excel how 
many times to repeat text. So, this formula:

=REPT("HAPPY BIRTHDAY, EXCEL!",4)

spells out the lyrics to the Happy Birthday song (You’ll have to supply the melody, or just check out "Bonus 
Tip: A Great April Fool’s Day Trick" on page 133 for the “Speak Cells” feature. Then let “Microsoft Anna” take 
her best stab.)

Maybe dancing is more your thing. You’ve had a few Jitterbug Jelens and are ready to get on the floor. 
Here’s one for you:

REPT() for In-cell Charts

Let’s see how you can use REPT as a no-charts-required data visualization technique. The trick here is to 
use a special character for you first argument. When that character is stacked side by side and repeated 
enough times, your REPT formula will basically mimic the look of a horizontal bar chart.

Using REPT to create in-cell chart effects

There are a couple things to notice on the previous illustration. First, notice the character you use in the 
first argument. It might look like a lowercase “L” but in fact it is the vertical bar character (typically on your 
keyboard just above the Enter key). Apply the Playbill font, size 10 or higher.
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#HT to Jordan Goldmeier for pointing this out to me. I had been using 
lowercase L, which never looked as good as the vertical slash character.

Let’s look at the formula again:

=REPT("|",F21)

Recall that the second argument is your number_of_times argument. In the previous example, the high-
est value, 197, happens to be in F21. You can see that the REPT function still produces a reasonably sized 
bar chart. But sometimes it might make sense to scale down the number_of_times argument. In cases 
where you are dealing with much larger numbers, or only have limited column width sizes to work with, 
this helps reduce the amount of screen real estate your REPT function takes up. As long as you use apply a 
consistent scaling factor, the end result will be the same, just more compact. Let’s see what happens in the 
same example when you scale down by one-third.

Scaling down by one-third. Same proportions, but your bar charts are no longer spilling over into column I like they were 
before.
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#3 AutoSum on a Matrix
OMG. WHY DIDN’T THIS TIP DAWN ON ME UNTIL I HAD ALREADY BEEN USING EXCEL FOR TEN YEARS?

After all, I have known for quite some time that Excel is very good at working with more than one cell at a 
time, even when it comes to noncontiguous ranges. Just press the Ctrl key while you click, click, click away 
on individual worksheet cells to select them. Then enter a formula or value and press Ctrl+Enter to popu-
late all selected cells at once. 

Pressing Ctrl+Enter will populate all the highlighted cells in row 5. This is the same result as if you had entered the Jan for-
mula in A5 and used Copy and Paste to repeat the formula logic for Feb, Mar, and Apr.

So why I did not make the mental leap and extend this same concept to Autosum until recently? I don’t 
know. Go ahead, judge me all you want. Now, let’s move on.

Let’s say you have a matrix with regions going down a column and months going across the top row. You 
need monthly totals in row 13 and YTD totals in column K. 

Select all the numbers in the matrix to include in the totals. Be sure to also include in your highlighted area 
the empty cells just below the final row and the empty cells to the immediate right of the final column.
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Now, from the Formulas tab, Function Library group, click the AutoSum button.

The formulas all populate beautifully, all the way across row 14 and down column K. 

File under, "How the heck did I miss this before?"

#4 Retrieve the Intersection Value – From Space!

The Great Looking-Stuff-Up Debate

Excel community insiders are keenly aware of this ongoing “VLOOKUP versus INDEX/MATCH” rivalry. As a 
professional contrarian, I refuse to pledge allegiance to either camp. I also just never got the extent of the 
hype. For one thing, what is wrong with using VLOOKUP with MATCH? But I digress. There is yet another 
method for accomplishing the same things these two camps continue to debate. That thing we are really 
talking about is getting a value from a certain row and column intersection. 

The following technique does just that by combining range-naming techniques and the intersection op-
erator. The intersection operator is nothing more than an empty space.

Huh?

Let’s start with an example to illustrate. You have three employees, and three activities you want to track.

How can you ask Excel how many babies Aqua Man has rescued on a given day? Or how many villains 
Steve has foiled? All such questions are ultimately asking Excel to retrieve the value from a row/column 
intersection. 

Armed with this understanding, let’s look at a new way to do this outside the realm of VLOOKUP or INDEX/
MATCH.



30 BONUS TIPS FOR EXCEL'S 30TH BIRTHDAY	 149 

3

The Empty Space Operator

Whether you even realize it, you already know a lot about operators. If you didn’t, you probably would 
not have read this far. Common operators we use in Excel include * for multiplication,+ for addition, / for 
division, and so on. But here’s the crazy thing: The empty space is also an operator. Yes, space. As in the 
Spacebar. As   in   the   e x t r a   s p a c e s   I ’ m   u s i n g   r i g h t   n o w . 

Using the previous Superhero employees example, let’s say you type the following formula somewhere on 
the same worksheet:

=A3:D3 C1:C4

Excel will retrieve the value that intersects the range A3:D3 and C1:C4. Looking at this on the grid makes it 
easier to see: This intersection is cell C3. 

B6 will return 11 – that is the value at the intersection of A3:D3 and C1:C4.

Admittedly, it is not a very intuitive formula on the surface. This is easily solvable if you apply range names 
to the three rows and three columns in the matrix.

Creating a Friendly Name for Each Range

If you are unfamiliar with named ranges, you can simply think of them as “friendly” names. For example, 
instead of referring to the BabiesRescued column as C2:C4, you can create a friendly name instead, like 
BabiesRescued. Then you can use that name in any formulas you might create that need to point to C2:C4. 
Once you’ve done that, these two formulas will mean the same thing, but one is perhaps easier to read:

=SUM(C2:C4)     =SUM(BabiesRescued)

Naming a range is as simple as highlighting the cells you want to include in the name and typing the 
name you want in the Name Box, located to the left of the Formula Bar.
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When you have multiple rows and columns for which you want to create names, there is a much faster 
way. 

Start by highlighting the entire range, including both the row labels and column labels.

From the Formulas tab, Defined Names group, click Create from Selection. Because you’re already selected 
a proper range, the dialog that appears will have check boxes configured correctly for you.

Excel will automatically use the top row and left column values as range names.

Click OK. Now you have 6 new names you can use in any formula you create, such as:

=SUM(BabiesRescued)

which would return 48, just as if you had typed:

=SUM(C2:C4)

Putting It All Together

You can combine the “friendly” named ranges with the empty space/intersection operator method. If you 
want to know how many babies Aqua Man has rescued, you can now use the named ranges instead of the 
standard A1-style referencing.

As soon as you start typing a range name, Excel’s fabulous AutoComplete feature is already guessing what 
you are trying to say before you finish.

As soon as you see this pop up, you can press the Tab key to finish it rather than typing the entire word.

Now just add the empty space and finish the second half of the formula.
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B6 will return 11. Note that Excel added an underscore to Aqua_Man to make it a legal name.

Thanks to Meni Porat for suggesting intersection. Olga Kryuchkova and John Lythe suggested various Name techniques.

#5 How to Lose Your VBA-V (VBA-Virginity)
Readers of this book are a diverse bunch. If you are in the “been there, done that” camp when it comes to 
macros, you can feel free to gloss over this tip. However, if you are a newbie and are VBA-curious, or if you 
want to know how I got into macros, stay with me.

On the Subject of Macros

One thing I will say at the very start: Learning VBA is like learning a brand-new language. Particularly if 
your general computer programming education comes primarily from the school of hard knocks, like mine 
did. 

The topic of macros and VBA is far too vast to cover in one tip in a book. Indeed, the subject could be its 
own book or, rather, many books and indeed, it is! Numerous books, blogs, and training courses have at-
tempted to tackle this challenge of learning VBA. Those books and blogs speak to a wide range of skill 
levels, needs, and learning styles. I encourage you to explore on your own as much as possible. In the 
meantime, I’ll share with you how I got started, in the hopes that this one Excel developer’s perspective – 
mine – might resonate with some of you.

Before You Attempt to Read any Book

I’ve heard fellow Ohioan and Microsoft MVP Jordan Goldmeier tell some tall tales about he when read 
Professional Excel Development: The Definitive Guide to Developing Applications Using Microsoft Excel. He says 
he read it without even having Excel open. He. Just. Read. It. The way one might read Valley of the Dolls: on 
vacation, poolside, DAX on the Beach in hand, just indulging in unapologetic amusement. 

I am not sure I totally buy Jordan’s claim, but he really knows his stuff, so feel free to try his approach. I 
dare you to get through an entire chapter of Professional Excel Development or any other VBA book without 
opening Excel and tinkering around. I also dare you to absorb it all in one sitting. It's never worked for me 
this way.

In my case, before I even cracked open a single book, I played around a lot with the macro recorder. The 
macro recorder is just like an old school tape recorder. I clicked Record. I did some stuff in Excel. I clicked 
Stop Recording. Then I looked at the code – written in the VBA language - that was automatically generat-
ed behind the scenes. I was able to start making associations between my actions and the VBA language. 
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The key was to look at the code as soon as possible after I hit the Stop Recording button, while things were 
still fresh in my mind.

You can actually learn a lot this way, and it is quite exciting at the beginning when simple things start 
working. But if the recorder is the only thing you use to create macros, you’ll soon discover some limita-
tions. You might even discover this immediately, the first time you record a macro. Even when you find 
ways to work around those limitations, you'll find some new ones. For me, it was running into these limita-
tions that made me curious enough to crack open some books and focus. Or, maybe it was just stubborn 
determination to figure out how this thing works. I was ready, and after all that practice with the macro 
recorder, I found the books were an easier read. The concepts were sinking in.

Danny Moon Esq enjoying Power Programming with VBA.

Favorite Books

There are definitely more books and blogs out there today than when I was starting out. Starting with 
books, there are a couple that were instrumental in my initial learning. 

John Walkenbach’s Power Programming with VBA books were a prominent influence. Looking at his book 
on my shelf, it is in the top five in terms of visible creases on the paperback spine, so that says something. 
His chapter called "Introducing Visual Basic for Applications" includes a subsection called "The Basics of 
VBA". I found this in particular to be a great overview of all the most important terms a newbie developer 
needs to grasp, like objects versus methods versus properties and the like. Interestingly, despite that head-
ing, "The Basics of VBA", it was only after I had been playing around with the macro recorder for a while 
that it really made any sense to me. Think of it as learning to speak before learning the rules of grammar.

In addition, my coauthor blackmailed me into saying his books are totally superior to everyone else’s has 
some excellent published works on the subject, including VBA and Macros for Microsoft Excel by Bill Jelen 
and Tracy Syrstad. I really liked the grammar analogies there: Objects are like nouns, methods are like 
verbs, and so on. That was quite helpful.
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Favorite Online Resources

By the time this book goes to print, more Excel websites and blogs will have be born. After all, it is a revolu-
tionary time for Excel right now. Some sites will be great, others less so. Even these opinions will vary from 
reader to reader. Excel bloggers themselves will blog about other blogs and debate which are the most 
helpful blogs, and which are the amazing blogs, and blah de blah de blah. So get out there and explore 
what resonates best with you rather than just relying on my advice. Remember, Google Bing is your best 
friend for quick and free advice.

Next Steps

Enough deliberating for now. In the next tip, I will actually show you how to record your first macro. 

#6 Recording Your Very First Macro
As I confessed in tip #5, when it comes losing VBA virginity, many developers (including me) start with the 
macro recorder. But don’t worry. It’s not that kind of recording. 

Put as simply as possible: You hit the Record button, you do some stuff, and you hit the Stop Recording 
button. Like an old school tape recorder.

Starting Your (Macro) Recording Career

There's got to be something very easy that you can do in Excel just to see the mechanics of the macro re-
corder. I know you can record a macro that will “print” your name onto a worksheet:

1. Click inside any cell. I’ll use A1 in this example.

2. Click the Developer tab. Click Record Macro.
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Note: If you don’t have a Developer tab visible, click File, Options, Customize Ribbon. In the 
Customize Ribbon section on the right, check the box next to Developer. Click OK. You should see 
a Developer tab on your Ribbon now.

3. In the Record Macro dialog that appears, use the following settings:

●● Macro Name (Required): Call this one MyName. (No spaces or special characters allowed in a macro 
name.)

●● Shortcut Key (Optional): If you want to assign a specific keyboard shortcut to run your macro later, 
enter a letter or number here. To avoid overwriting existing Excel shortcuts (like Ctrl+C for copy), in-
corporate the Shift key into the keystroke to help reduce the risk. (It’s a pain to get it back once you 
overwrite!!!)

●● Store Macro in (Required): Choose This Workbook for this exercise.

●● Description (Optional): Any comments you add here will be stored along with the macro code for 
future reference.

4. Type your name in the cell you're in.

5. Press the Enter key and notice that Excel moves down to row 2. (This will be important when we exam-
ine the code later.)

6. On the Developer tab, click the Stop Recording icon. You’re ready to test the macro and then examine 
the VBA code that was generated by the recorder.
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Playback and Inspection 

Before you run your new macro, try clicking in a different cell first. To run the macro, use the shortcut you 
assigned in step 3 above. You should notice the macro “prints” your name in the active cell.

How does it do that?

To find out, you need to inspect the code that got generated while you were still in Recording mode. You 
should do this ASAP. Why ASAP? Because whatever you were doing while you were still recording is still 
fresh in you mind at this point, so making those associations between action and code will be much easier.

Backstage, Where the Code Resides

Welcome to the VB Editor. This “backstage” area is where all of your code hangs out. Here’s how to get in:

1. Click the Developer tab.

2. Click the Visual Basic icon. The Visual Basic Editor windows opens. In the Project Explorer on the left, 
there is a list of VBA projects, including your current file's.

3. Click the + sign next to the filename and then one next to Modules. Double-click on Module1.
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4. Study the code in the code window to start learning how the macro recorder “translates” your Excel ac-
tions into the VBA language.

At first glance, the code looks sort of cryptic. How are we supposed to know what all of this means? 
Remember, this is like learning a language. 

First things you will observe: At the very beginning of your code, you have Sub, followed by the name of 
the macro we entered earlier, and an opening and closing parentheses. You also have End Sub at the very 
end of the code. Sub and End Sub are in a blue font and are the standard opening and closing lines for any 
macro you record. You will also notice any comments you entered in the Description field are in green. This 
is another standard thing you will see with every macro you record.

Moving on to the first line of recorded code: ActiveCell is what the macro recorder interprets as the 
active cell position. This is not too hard to grasp. The .FormulaR1C1 bit is unfortunately a bit less intuitive. 
FormulaR1C1 is a property of the ActiveCell object. It is the way that the macro recorder likes to describe 
the “formula” of the active cell. (Never mind that this isn’t even a formula since you've just entered text!) 
Welcome to the oddities of the macro recorder.
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These two lines of code accomplish the same thing: 

ActiveCell.FormulaR1C1 = "XSzil"

ActiveCell = "XSzil"

Moving on to the next line of code, you see that the recorder also generated this bit:

Range("A2").Select

This happened because, after you were done typing in A1, you pressed Enter. When you press Enter in 
Excel, your cursor moves down to the next row, and therefore you have just selected that cell. So, regard-
less of your intent, the recorder interpreted this action as “select the next row.” 

Here's another oddity with the macro recorder: With VBA, you never really need to select anything. Unlike 
“regular” Excel, VBA can perform an action on a cell without actually selecting it. Known in the VBA lan-
guage as methods, these actions can be just about anything you do in Excel, including entering text, enter-
ing formulas, applying fonts or other format styles, cutting, copying, pasting, etc.

So as you can see by now, the macro recorder is both helpful and confusing at the same time! It is helpful 
for learning some basic mechanics. But it also produces a lot of extra stuff you don’t need. Put bluntly, it 
doesn’t always interpret your intention. 

So what can you do? For one, you can modify the code right in the VB Editor window to delete stuff you 
don’t need. As you experiment more, you will become more familiar with what you can remove and what 
you need to keep to make your code work.

Welcome to the VBA Jungle

I don’t blame you if you are already frustrated with VBA. It seems very illogical at first, and isn’t Excel sup-
posed to be a supreme ruler of all things logical? I feel your pain, I really do. Sometimes I even wonder 
what possessed me to keep tinkering with macros for so long. Maybe I am a masochist. Happily there are 
many great resources out there to guide you past this initial stage. If you didn’t read my other tip "#5 How 
to Lose Your VBA-V (VBA-Virginity)" on page 151, go ahead and check it out for some additional advice on 
getting started.
Several readers suggested Macros as their favorite Excel tip: Pete Doyle, Chris Jones, @theexcelclub

#7 Turn Your QAT into Your Personal Laugh Track

Talking Spreadsheets

If you’re reading this book cover to cover, you’ve already enjoyed "#40 Avoid Whiplash with Speak Cells" on 
page 132. If you have not seen it, turn there now! Bill walks you through how to get Excel to “talk back” 
to you by reading the contents of your worksheet to you - out loud. Bill describes one practical use of this 
feature and one that fits into a category I like to call “Excel hijinks.” 

Just as you can use VBA to work with Windows Speech Recognition, you can use VBA to play sounds from 
any .wav or .mp3 sound files. You can play these files automatically with the click of a button. In the next 
example, I’ll show you how to use your QAT (Quick Access Toolbar) to store these buttons and play sound 
effects any time you want right from Excel.
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Hat Tip

I am very grateful to have stumbled upon the macros used in this tip years ago, on John Walkenbach’s old 
j-walk.com site. It opened my eyes to all sorts of new ways to annoy amuse my co-workers and friends at 
the office.

BONUS tip: Set Up Your Personal Macro Workbook

One thing you’ll need for your sound effects toolbar is a personal macro workbook. A personal macro work-
book, unlike regular Excel workbooks, is one that, once created, will open each time you start Excel but 
stays hidden in the background. You don’t really use it like a regular workbook but rather like a backend 
storage place for any macros you want to store and make available globally, meaning available to more 
than one workbook. 

To create a personal macro workbook:

1. Click the Developer tab.

2. Click Record Macro. 

3. The Record Macro dialog appears. From the Store Macro In dropdown, choose Personal Macro 
Workbook. Leave all other settings as-is.

4. Click OK.

5. From the Developer tab, click Stop Recording. Your personal macro workbook has just been created.

Notice you didn’t really do anything while you were recording. But by choosing Personal Macro Workbook 
in Step 2, you’ve essentially created your personal macro workbook. This was a one-time thing. Going for-
ward you can store any macros you want in your personal macro workbook, so they are available to run 
regardless of the Excel file you have open at the time.
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Your New Personal Macro Workbook

Now let’s explore what happened behind the scenes. From the Developer tab, click Visual Basic (or press 
Alt+F11). You are now backstage at the Visual Basic Editor. 

You will notice in the Project Explorer section that there is a new file listed called Personal.xlsb. Click the + 
symbol next to the filename, then click the + sign next to the Modules folder. Double-click Module1. You 
now see the (mostly empty) code for Macro1 you just recorded in the code window. 

Since the purpose of recording Macro1 was to create a personal macro workbook only, you won’t need the 
code for Macro1 anymore. So for now, you will simply delete the code. You can highlight everything from 
Sub Macro1() all the way to End Sub, right-click, and delete.

Put all Your Favorite Sound Files in a Folder

Next, you will add the VBA code to play your sound effects. Before you do that, you might want to collect 
all your sound effects in one place – ideally in one folder. You’ll need the folder pathnames and filenames 
for your macros to work properly.

As you browse for sound files (.mp3 or .wav), use your own music collection or any clips that you find 
online and build your collection over time. Here is an early-days look at the folder I used to start building 
my sound effects toolbar (I have a few more now, a bit of an addiction).
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Add new PlaySound Macro to Your Personal Macro Workbook

Since this macro is not one that can be recorded, you need to type it directly into the Visual Basic Editor. 
From Excel, get back into the Visual Basic Editor by clicking Visual Basic from the Developer tab or using 
the keyboard shortcut Alt+F11. Navigate back to Module1 in the Personal.xlsb file, as described in the pre-
vious section. 

Type the code shown in the next figure in the Module1 code window. Notice the modifications you will 
have to make; I’ve added comments to guide you on the specific lines you will have to modify to make it 
run in your environment.

Here is the code:

Let’s examine this code.

The first line, which starts with Declare PtrSafe, sets up the main function, which I’ve assigned to the name 
PlaySound. 

Note: I should point out that this line of code starts with Declare PtrSafe and ends with As Long. 
Even though it may look like two lines, the underscore character (preceded by a space) adds a line 
break. This is a macro writer’s technique to enhance readability for very long lines of code. This way 
you are avoiding having a single line of code that stretches across so far you have to keep scrolling 
right to see it all.

In the next line, which starts with Public Const, sets the default folder. Here you should replace the folder 
path with the one you have set up to store all your sound files.

Next, there are three subroutines: Sub PlayLAUGHTRACK(), Sub PlayAPPLAUSE(), and Sub PlayCRICKETS(). 
These are individual macros to play specific sounds. Again, you’ll need to update the filenames with what-
ever you have. You can also change each macro name to something intuitive to match the specific file you 
are going to play. You can also replicate as many times as you need for new sound files as your collection 
grows. To do this, just copy any one of the existing Subs and paste it right into the same module. Then just 
update the macro name and the filename.

Tip: If you are not working in a 64-bit operating environment, you might notice that the first line of 
code suddenly turns red, VBA starts complaining, and your code won’t run. If this happens to you, 
try deleting PtrSafe from the first line of code. The red font should go away, and your code will now 
work properly.
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Create Icons on Your QAT

Sound files organized in one folder? Check. Code added to Personal.xlsb? Check. It’s finally time to set up 
the QAT shortcuts to Excel-hilarity! You’ll want to add one icon per sound effect. I like to use several, to suit 
different moods. 

Your  QAT sits just above or just below your Ribbon. It has a few default icons on it when you first install 
Excel, but you can add or remove any icons you want. The icons can be used for your personal macros, as 
well as any built-in Excel commands you want to be able to access quickly and easily without navigating 
around the Ribbon.

To customize your QAT and create your personal Excel sound effects toolbar:

1. Right-click on the QAT and choose Customize Quick Access Toolbar.

2. In the Excel Options dialog select Macros from Choose Commands From dropdown.

3. Click on the first sound effect macro in the list. Click the Add button. The macro will now be added to the 
Customize Quick Access Toolbar list on the right.

The next two steps are optional but recommended if you plan to have more than a few personal macro 
icons on your QAT. 

4. Select one of the macros in the Customize Quick Access Toolbar list on the right and click Modify. The 
Modify Button dialog appears. 
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5. Change the symbol and display name to your liking. The symbol will be the icon that actually appears 
on the QAT, and the display name will appear as you hover over the icon. Click OK when you’re done.

Have Fun with Your New QAT

Are you presenting your latest Excel model to your whole department? Are you an Excel trainer facing 
a tough crowd? Sass it up with some sound effects. Make sure your speakers are on. At the appropriate 
moment, click the icon for the sound effect you want on your QAT. You will instantly change the energy in 
the room. Whether that is a good or bad thing remains to be seen. Good luck!

Bonus Tip: Add Icons to the Quick Access Toolbar
The Quick Access Toolbar is great for collecting commands that you use frequently. Hate to go to the Data 
tab just to click the AZ sort button? Right-click the button and choose Add to Quick Access Toolbar. Other 
useful commands can be found by selecting All Commands in the top-left dropdown in the Customize 
Quick Access Toolbar section. Try some of these useful icons:

●● Select Visible Cells - see "Bonus Tip: Copying the Subtotal Rows" on page 40

●● AutoFilter to do Filter by Selection. See "#2 Filter by Selection" on page 4

●● Print Preview Full Screen to bring back the old style Print Preview

●● Camera Tool - see "#18 Smile for the Excel Camera!" on page 190

●● New (but not New...). See "My Rant About New and New…" on page 22

●● Quick Print to print without stopping at the Backstage.
Thanks to Matt Atkins for New. Chris Jones for suggesting adding Select Visible Cells. @K_Tizy55 for Quick Print.
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#8 VBA For Troublemakers
Continuing with our VBA hijinks theme, there are a few ways I like to use Excel’s Text to Speech 
functionality. 

VBA Events

In Excel VBA programming, there is this concept known as an event. An event can trigger a macro to fire. 
Examples of events include clicking on a button, activating a worksheet, deactivating a worksheet, recal-
culating a worksheet, changing the selection, changing the active sheet, and clicking on a specific cell.

Storing Code for VBA events

There are two ways we can embed VBA code in a workbook. Double-click on any of these to access its cor-
responding code window:

1. Standard module code – where recorded code gets generated, 
and where you’ll find most code that is not event-specific

2. Sheet code – where you want to put code specific to a work-
sheet-related event

3. ThisWorkbook code – where you want to put code specific to a workbook-related event

MrExcel on April Fool's

In his tip "#40 Avoid Whiplash with Speak Cells" on page 132, Bill has already explained how to use Excel’s 
Text to Speech feature. He even described a “harmless prank” you can pull on your co-workers that looks 
like this:

Now, let’s try a few more variations on this hilarity.

Excel for Narcissists

Let Excel greet you each day with Workbook_Open. Pick a file you work with frequently. Open it. Get into 
the VB Editor. In the Project Explorer, navigate to that file. Double-click on ThisWorkbook and add this little 
bit of code:

Pretty soon, you will start to believe it.
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Always Know Where You Are with Worksheet_SelectionChange

One of the many VBA events with lots of practical uses is the selection change event. Here is a not-so-prac-
tical and super-annoying way to use it. Pick another victim and get your hands on their file. Get into the 
VB Editor. In the Project Explorer, navigate to that file. Find the sheet name where you want to make a little 
trouble. Double-click on it to access that Sheet code window. Then add this little bit of code:

Target Your Message with Worksheet_Activate

Another handy property of the Application object in VBA is the UserName property. What that means is, 
you can get VBA to read the name associated with the user of a particular computer. This is usually the 
same name that immediately follows C:\Users in your My Documents folder, for example:

C:\Users\YourName\Documents

Anyway, you can have more fun with this in VBA. Find out the username associated with a particular co-
worker, or even your boss if you are feeling really foolish. Then pick a file you all use. Get into the VB Editor. 
In the Project Explorer, navigate to that file. Double-click on the sheet where you want your message to be 
heard each time it’s activated. Then add this little bit of code:

#9 Absolute, Relative, and Multiplication Tables
After you have reached a certain level of Excel prowess, absolute and relative referencing is something you 
do in your sleep. This probably includes many of those reading this book. But can you explain it to some-
one else? If there is one thing I have learned as a professional Excel instructor, it is that the ability to do and 
the ability to teach can be two entirely different animals. 

This tip is one tried-and-true Excel instruction technique, and it's particularly handy if you have a mixed 
crowd. It is a quick way to figure out how to pace the instruction for the rest of the day. If everyone can do 
this in 20 seconds or less, I slam another double espresso and brace myself for an advanced crowd. If I have 
a bunch of frightened, deer-in-headlight looks, I know we’ll need to dial it back and focus on fundamental, 
Excel 101 kind of stuff.

Back to School

Here is how the exercise works. Start creating a multiplication table mockup of sorts. Enter the numbers 
1-10 in B1:K1, then do the same in A2:A11. Of course, you can click and drag the Fill Handle to do the first 
set of 10, then copy, paste, and transpose for the second set. At this point, it should look like this:
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Now, ask your audience to see if they can figure out how to create a single formula in cell B2 that can be 
copied all the way across to column K and all the way down to row 11 and return the correct answer for 
each cell. If the cell referencing was correctly applied in B2, you should see all other cells returning the cor-
rect answer.

Word to the Excel gurus out there seeking to help out their friends: This multiplication table exercise is not 
always a cinch for many people who don’t use Excel 24/7. It’s been a while since fifth grade, so yes, people 
will forget things like multiplication is commutative, and therefore these two formulas return the same 
result:

=C$1*$A4  =$A4*C$1
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The “Answer” for Those Learning Excel

For the new Excel learners, the short answer is to put the following formula in B2:

=$A2*B$1 

Or, alternatively =B$1*$A2 will also work. Once you’ve done that, you can copy this same formula all the 
way across to column K and down to row 11.

The “Answer” for Those Teaching Excel

The other fun part of this exercise is discovering that even with a seemingly simple example such as this, 
there are quite a few opportunities to showcase Excel timesavers and shortcuts like:

●● Using the Fill Handle to create a series of numbers

●● Using copy, paste, transpose to transform a vertical range to a horizontal one or vice versa

●● Using Ctrl+Enter to populate a matrix of cells simultaneously

and perhaps a few more that I’ve missed, to be sure.

In short, there is no single “right” answer on how to approach this problem. But it is a great way to illustrate 
how important the correct mix of references can be in our Excel formulas!

#10 From Outline to Flat Table

Hat Tip to Bob Umlas

Here is yet another one of those “now why didn’t I 
think of that?” moments in my Excel life. I read this 
tip on a plane from Atlantic City to LA a few years 
ago, when I read This Isn't Excel, It's Magic by Bob 
Umlas. Thanks Bob! Why didn’t I think of that?

You Have an Outline, but That’s It

Somebody put this together and thought they 
were very clever. But now you can’t sort it, or filter 
it, or make it into a pivot table, because it has all 
these blanks in it.
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The Solution

Just Go To it: 

1. Highlight the entire outline area, including empty cells that need to be filled.

2. Press the F5 key.

3. From the Go To dialog, choose the Blanks option and press Enter.

4. Type an equals sign.

5. Tap the Up arrow key.

6. Type Ctrl+Enter. Your outline is now filled.

An optional final step is recommended if you need to sort, filter, or create a pivot table. Convert all the for-
mulas to values. Either just highlight D9:F27, then press Ctrl+C, and select Paste Dropdown, Paste Values. 
Or use one of the methods Bill described in "#25 The Fastest Way to Convert Formulas to Values" on page 
90.
This technique was the most-suggested tip for this book. Thanks to Matt Allington, Ray Hauser, Chris Hicks, Barbara Johnston, 
Laura Lewis, Paul Martinez, Michael A. Rempel, Rene Sprebitz, Darrell Wade, Steven White, @AuditExcel.
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#11 Goal Seek for Renters and Shoe Lovers

When You Must Blow Your Whole Wad

Sometimes the Jimmy Choos just beckon and you are compelled to spend every last penny in your pocket. 
It happens. Fortunately Goal Seek can help you through it. Goal Seek allows you to back into a question 
when you already know the answer. For example, “What is the maximum retail price I can afford in order to 
spend exactly $450, including tax?” This analysis could be accomplished with Algebra, of course. But who 
needs Algebra when you have Excel (and a sweet pair of Italian leather slingbacks)?!

Illustration: Michelle Routt

Setting Up the Problem

In Excel, this starts out as a simple math problem: Retail price plus tax equals what I must pay:

I have one variable I can play around with here, which is the retail price in B2. Am I right? Of course I am, 
because the other two cells are both formulas that are “set” in the sense that I can’t really change their 
logic. In B3, I cannot change the amount of sales tax I must pay, because it’s required by law, so that for-
mula must remain. B4, the total amount, must also stay because retail+tax = amount due is a fact of life 
beyond my control. Changing cells and set cells are important concepts to understand when you are learn-
ing to use Goal Seek.

Recall that the original goal was to spend all the money I have in my pocket, $450. Using the setup shown 
in the figure above, I can change the value in B2 as many times as I want and observe how close the total 
gets to $450. But that might take a while, and I’m not very good at Algebra, so I turn to Goal Seek.

Goal Seek to the Rescue

Here is how you use Goal Seek to solve this problem:

1. Click the total cell, B4.

2. Click the Data tab, Data tools group, What-If Analysis, Goal Seek. 
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3. In the Goal Seek dialog, enter the following settings:

●● B4 for the Set Cell

●● 450 for the To Value

●● B2 for the Changing Cell

4. Click OK to see what Goal Seek is proposing for a solution. Notice that it puts the proposed value into B2 
for you.

5. Click OK to accept the proposed solution or click Cancel to return to the original value you had.
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Buying, Renting, or Living in a Shoebox

Indeed, life can be more complicated than having $450 to blow on shoes. In most real-world problems, 
things are often more complicated, and Goal Seek is therefore not always the best choice. For more com-
plex analysis, complete with multiple changing set cells, multiple fixed cells, and constraints, check out 
Goal Seek’s over-achieving cousin, Solver. See "#37 Find Optimal Solutions with Solver" on page 124.

You can still use Goal Seek to analyze questions of slightly higher complexity, but you have to frame the 
problem so there is only one variable and one set cell at a time. For example, a question like “how much 
can I afford to take out as a loan, given a fixed interest rate and a fixed term in months?” could be analyzed 
with Goal Seek, using the set up here:

Let’s say you have $2,000 to spend each month on housing, and you want Goal Seek to help you do some 
analysis on what size loan you might take out. Because you have a fixed amount you can spend each 
month, you would choose the monthly payment cell, E47, as the set cell. You can then pick one of the 
three changing cell options. For example, if you assume that the term is a fixed 360 months, and the inter-
est rate is a fixed 5%, then the loan amount becomes your changing cell (by process of elimination).

Once you have chosen one set cell and one changing cell, you are ready for Goal Seek. You click the set 
cell, E47 and click the Data tab, What-If Analysis, Goal Seek. You use the following parameters:

When you click OK, Goal Seek lets you know that assuming your term is 360 months, and your interest rate 
is 5%, and you want to spend no more than $2,000 each month, you can take out a loan of $372,563.
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#12 Controlled Lists with Data Validation
When building interactive Excel models, you want to keep your end user in mind. Data validation is a great, 
no-macros way to control the acceptable values for a given cell. For example, you can limit entries to a 
fixed list of choices, a value in a range, text of a certain length, and more. 

This tip focuses on the dropdown list option you have with Excel’s data validation feature. It’s pretty easy 
to create a dropdown list. Unfortunately, it can also get screwed up easily if you don’t pay attention to the 
“gotcha” caveats, so I will comment on those also.

Restrict Entries to a List of Values

Let's say that you want your end user to enter a company name in C2, but you want to make sure the com-
pany is one from your approved vendors list.

This is one of the easiest types of data validations to create: 

1. Click on C2

2. From the Data tab, Data tools group, click Data Validation, Data Validation again. 

Note: In real life, you would click the top of the Data Validation icon to choose Data Validation. I 
added the extra click in this case to show the Circle Invalid Data choices. They aren't discussed in 
this book, but you might want to check them out. In the future, the book will describe clicking only 
the top half of the Data Validation icon.
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3. In the Data Validation dialog, select List from the Allow dropdown.

4. Click inside the Source box and select the range where your list values are stored.

5. Click OK.

Now when the user clicks on C2, Excel immediately presents a dropdown list of acceptable choices.

Note that the source range that populates your list need not be visible to the end user. The previous fig-
ures show the easiest variation of this technique, but in practice, you can define the source in a variety of 
other, more practical ways:

Option 1. Put your list in a hidden column on the same worksheet. Caveat: Unless you implement some 
clever sheet protection schemes (sometimes even requiring VBA), the user can easily mess things up.

Option 2. Use a named range. Your named range can refer to names on other worksheets. For example, I 
can create a new named range called CompanyList:
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Then I can use that name as my source in the Data Validation dialog:

Tip: When you click inside the Source box, press the F3 key. You will get a Paste Name dialog. 
Double-click any range name that shows up in the Paste Name list to automatically transfer that 
name into the Data Validation Source box.

Option 3. If you have a short list, typing a comma-separated list directly in the Source box will do the trick 
also.
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The Problem with Static Lists

One problem with using regular, A1-style range definitions in your data validation source is that the list 
will not be dynamic. Like Excel formulas, however, you can sort of work around this by remembering to 
insert new values above the last row in your defined range. For example:

=SUM(A1:A15)

This will easily pick up new rows past row 15 as long as those new values are inserted above row 15 after 
you’ve created the initial formula. Similarly, the source for any data validation lists will expand to pick up 
new list values as long as those new values are inserted somewhere between the first and last rows of the 
range. But in practice, somebody always appends rather than inserting, and things get screwy.

To work around this, you can use your favorite dynamic range naming technique, then use those defined 
names as your list source. The OFFSET function is one such technique, but since Excel tables came onto the 
scene, I find I use OFFSET a lot less. So, for this tip, let’s focus on the easier one: tables.

A Solution with Dynamic Tables

Creating a table is simple: Click inside a list and click OK on the Create Table dialog. You now have a table.

Among the many advantages of using Excel tables (they extend well beyond the scope of this tip), one of 
the big ones is built-in dynamic ranges. The next illustration shows two ways of counting the number of 
companies I have in my list. In C1, I have the old, A1-style cell referencing we are all used to with “regular” 
Excel. C2 shows the newer, structured referencing syntax used by Excel tables. Of the two, only the struc-
tured referencing style is dynamic.

Note: Creating the formula in C2 was as simple as typing =COUNTA( and then clicking just above 
cell A2 to select the entire column. Excel then puts in the table name, Table1, and column name, 
Company, for you, using the correct syntax.
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Once the table is created, you can use another trick with the INDIRECT function to bring it all together for 
the data validation list source. For more details on INDIRECT, check out Bill's "#30 Cure Triskaidekaphobia 
with a Killer Formula" on page 102. In this example, we'll use the INDIRECT function in a data validation 
list source, to specify a reference to a table range. You know the table name is Table1. You know the field 
name is Company. So, armed with all this information, the winner for dynamic validation list sources looks 
like this:

Bonus Tip: Other Data Validation Settings
You have seen by now that the Data Validation dialog contains two other tabs besides Settings.

The Input Message tab allows you to offer people additional guidance, in “real time,” as soon as they click 
on the validated cell.
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The Error Alert tab allows you to deliver another message to end users if they try to type in something that 
is not on the list. Error Alert offers three styles of alerts of varying tones, ranging from polite to stern.

After the user tries to enter an unapproved vendor, this Stop-style error alert kicks in.

While you can have some fun with these…

…don’t be fooled. These settings, like data validation in general, do not offer very robust protection 
against mistakes. In fact, in the absence of fairly well-thought-out protection schemes, sometimes even re-
quiring passwords and VBA, a casual end user could easily screw up your validation with a simple copy and 
paste action. All someone has to do is copy another cell, paste over the validated cell, and poof! Validation 
gone.

Therefore, you should use data validation with the intent of guiding cooperative, well-meaning end users. 
For this it is still very effective. For the rest, unless you are prepared to spend some time implementing a 
more sophisticated VBA solution, it is likely to get screwed up.
Thanks to Wilde XL Solutions for suggesting Data Validation.

Note: I am often asked about my thoughts on sheet protection, passwords, and the like. For more 
information on that, read my next tip, “The XSzil Guide to Excel Protection”

#13 The XSzil Guide to Excel Protection
Should you protect your Excel model or not? I am often asked this question. It’s hard to offer a concise 
answer. Excel offers many types of protection: protect an entire workbook, protect a worksheet, protect 
certain cells within a worksheet, and more. Each type can involve a password, or not. But in reality, none of 
it is high-security stuff. So my answer usually starts with “It depends…”

I do not come from an official computer programming background. However, I have experimented with 
Nassi-Shneiderman diagrams. You know, for fun. Also, I found that this technique offers an interesting, 
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“visual” way of solving complex problems. I sometimes use this technique for approaching Excel problems 
as well, VBA or non-VBA subjects. A Nassi-Shneiderman diagram looks sort of like a flowchart, but with 
simpler rules. 

Note: From Wikipedia: “A Nassi–Shneiderman diagram (NSD) in computer programming is a 
graphical design representation for structured programming.” 

So, here you go. A Nassi-Shneiderman lover's guide to whether you need to worry about protecting your 
Excel model. 

You’re welcome, America!
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#14 Named Formulas: Yesterday and Tomorrow
Another sneaky tip on using names in Excel: They’re not just for ranges! They are, in fact, great tricks to in-
clude in your Excel modeling toolkit.

In Excel There Is Only TODAY()

There is no YESTERDAY(). There is no TOMORROW(). If you think this profound opening line is just another 
cheap segue to an Excel cocktail pairing, you are right! I recommend an Excel Libre, in celebration of the 
TODAY() function’s beautiful simplicity:

This figure was created on June 28, 2015.

However, there is no similar YESTERDAY() function built into Excel (Cheers, Microsoft!). So for our first 
named formula, we can make our own YESTERDAY.

From the Formulas tab, Defined Names group, click the Name Manager icon. Then click New.

The New Name dialog appears. Type YESTERDAY in the Name box (capitalization not important). In the 
Refers To box, type =TODAY()-1. Click OK.

You now have a new custom formula, =YESTERDAY, that you can type in any cell in your workbook. It will 
always return the current day’s date minus one day. 
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This figure was created on June 28, 2015.

You could repeat the above steps to create your own TOMORROW: just change the -1 to +1:

#15 Named Formulas: VLOOKUP Without the Sausage
Let’s look at an example, with a bit more complexity. I know you’re ready for it!

You have an Excel model where you want the end user to enter shipping information for customer orders. 
There are two tabs, Input and Customer Table.

On the Customer Table tab, you are storing customer shipping information for your frequently contacted 
customers. You create a table (Ctrl+T) so you can use the built-in advantages of Excel tables.

On the Input tab, you want to create dropdown menus to speed up data entry where possible. The first 
input field, Bill-to Name, reads the Customer Table tab’s Bill-to Name field and uses that for its data vali-
dation source list. You can use the INDIRECT tech‌nique to make the data validation source list dynamic 
(For more information on dynamic lists and data validation, check out "#12 Controlled Lists with Data 
Validation" on page 171.)
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VLOOKUP Without the Sausage

Now you can move on to the other four input fields: Address, City, State, and Zip. Once the user selects a 
customer from the Bill-to Name dropdown, how will you get these four fields populated? I can hear team 
VLOOKUP out there, already crying out: We get it! We know how to do this with VLOOKUP, using Bill-to Name 
as our Lookup value…. Let me stop you right there and say it: Good for you. But recall that this tip is about 
providing a solution for end users who are not you – and who might be terrified of VLOOKUP. These people 
don’t need to see the sausage being made.

So here’s the plan: Let’s separate the sausage-making process from the end user. You can take if off of the 
Input sheet and into the back end room where you create a named formula. All the logic built into your 
VLOOKUP will be embedded in the name.

First, create the VLOOKUP formula in the Address cell B4, just like you were going to do in the first place. 
Recall that the lookup range is a table named CustomerTable, and the Address field is the second column, 
so you would have this: 

Inevitably, at some point there will be a one-off address change. You can let your end user overwrite the 
default formula, but after that you’re back to square one (A1?). You must either re-create the formula for 
the users or rely on them to reconstruct it. Neither is a good option. But a named formula is a good option. 
Here’s how to do it:
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1. Click on B4. 

2. Click in the formula bar and then highlight the text of the formula you just created.

3. Right-click your selection and choose Copy.

4. Press Enter to exit the formula bar.

5. From the Formulas tab, click Name Manager. The New Name dialog appears.

6. Click inside the Refers To box and press Ctrl+V to paste the clipboard contents.

7. In the Name box, type AddressLookup and then click OK.
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8. Click on cell B4 again. Clear the contents (by right-clicking and selecting Clear Contents).

9. Click the Data tab, Data tools group, Data Validation. The Data Validation dialog appears.

10. From the Allow tab, choose List.

11. Click inside the Source box. Enter a + sign and press F3. Double-click AddressLookup to send it to the 
Data Validation dialog's Source box.

12. Click the Error Alert tab and uncheck Show Error Alert After Invalid Data is Entered.

This essentially allows you to create an either/or-style input field. 
Either use the default address dropdown or fill-in your own address.

13. Click OK to close the Data Validation dialog.

Your Address field is now ready for prime time.

You can choose the “default” address using the dropdown or enter an alternate.

Replicating for the remaining fields

Now that you’ve done the first input field, AddressLookup, you can repeat exactly the same steps for City, 
State, and Zip. You could go straight to the Name Manager and create additional named formulas for each 
of these. Be sure to update each VLOOKUP with the correct column index references. From the Formulas 
tab, Defined Names group, Name Manager:
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You now have a fully functioning input worksheet in your model, with data validation:

#16 Controlled Formula Lists with Data Validation
Just now, in tip #15 we explored some advanced techniques for using data validation lists. You added 
named formulas to a data validation list. However, you might recall that each of these lists used only a 
single formula.

Let the record show that you need not limit yourselves to one formula per Data Validation dialog Source 
box. You can have, well, a list of them.
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Data Validation and Dates

It’s true that data validation already offers a way to restrict input to a limited range of dates. Click the input 
cell where you want to apply date restrictions and then from the Data tab click Data Validation. In the 
Settings tab, choose Date from the Allow list. In the Data dropdown you see all the usual suspects for set-
ting date parameters:

But you may still encounter problems if/when your end users are not very skilled at entering dates in Excel 
properly.

So here is another way. Let’s say you want your end user to have the ability to choose from a few key 
dates, including the current day. The TODAY() function, discussed in "#14 Named Formulas: Yesterday and 
Tomorrow" on page 178, is a built-in Excel function. Like custom functions, it too can be added as an item 
in a Data Validation dialog's Source box:



30 BONUS TIPS FOR EXCEL'S 30TH BIRTHDAY	 185 

3

Today, Tomorrow, Yesterday Recap

Note the syntax in the previous figure. Remember that TODAY() is a built-in function in Excel, with no ar-
guments. When you add TODAY to the Data Validation dialog's Source box, make sure to use the + sign at 
the start and the opening and closing parentheses at the end, as shown in the previous figure. Otherwise, 
when your end users select it from the dropdown list, they may receive a #NAME error. 

Unlike the built-in function TODAY, there is no similar YESTERDAY or TOMORROW function in Excel. So 
you created one in tip #14. To refresh your memory, here they are again, shown in action on a worksheet. 
Notice that I’ve also fired up the Name Manager to show the definitions for TOMORROW and YESTERDAY.

Restrict Choices to a Short List of Date Functions

With YESTERDAY, TOMORROW, and Excel’s built in TODAY(), you have all the functions you need to build a 
nifty data validation dropdown list. You pick the input cell and set up a data validation rule to allow a list, 
where the choices are typed directly into the source box, like this:
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Putting it all together:

#17 Dependent Data Validation Lists
More tips in our data validation series! In the last few tips, you’ve learned how to use several types of data 
validation controlled lists, including choosing from a list of values, and choosing from a list of built-in or 
even named formulas you can create. 

One aspect we have yet to explore: What happens when you have more than one list to consider, and 
these lists are related to each other in some way? For example, let’s say you are creating a sign-up form to 
collect subscriber information. It has a dropdown list for state and then a second dropdown list for city. It 
would make sense to somehow filter the city dropdown list dynamically, based on the first selection made, 
in the state list.

By combining data validation list techniques with Excel’s INDIRECT function, you can address these types 
of challenges.

For example, let’s say you are planning on having an Excel-inspired cocktail party. You are creating a model 
to help you with your planning. You are building your ingredient lists by drink. You want two dropdown 
lists – one for your drink choice, and one for ingredients related to the drink choice. So far it looks like this:
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In B10 you want a dropdown to choose from the list of drinks you might serve at your party. This one is 
a straightforward data validation list. Click on B10, click the Data tab, then click Data Validation. In the 
Settings tab, Allow dropdown, click List. Click in the Source box and then highlight the horizontal range 
A1:D1, where you have your drink names.

The next dropdown list, for ingredients, should depend on the drink selection made in B10. You can start 
tackling this problem by creating named ranges, one for each of the drinks listed in A1:D1. You can do this 
in just a few clicks: 

1. Click A1 and drag down to the end of the ingredients list (that is, A6).

2. Press and hold the Ctrl key until the end of this series of steps.

3. Click B1 and drag down to the end of the ingredient list (that is, B5).

4. Repeat step 3 (still holding the Ctrl key) for the remaining two columns, C and D.

When you’ve selected all drinks and ingredients, your selection should look like this:

5. Click the Formulas tab. In the Defined Names group, click Create from Selection.



188	 MrEXCEL XL

6. In the Create Names from Selection dialog, ensure that Top Row is checked. Click OK.

You have just created four new names. You can check the Name Manager to make sure. From the Formulas 
tab, click Name Manager to see them:

INDIRECTly Speaking.

Now it’s time for our INDIRECT trick. The INDIRECT function in Excel is one of those oddballs that is hard to 
explain without going straight to an 
example. One way to think of 
INDIRECT: it lets you change up the 
range arguments you might supply in 
a formula. You can type the name of a 
range in a cell and then use INDIRECT 
to grab that information and pop it 
into a formula. For instance, look at 
these wacky examples of the INDIRECT 
function:

In this figure, all the range defini-
tions being supplied to the various 
INDIRECT functions are standard A1-
style references. But you can also use 
named ranges as well. This is the key 
to implementing the dependent data 
validation list in this next example.
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Creating the List Dependencies

To create a dependent dropdown list in B12:

1. Click on cell B12.

2. Click the Data tab, Data tools group, Data Validation. The Data Validation dialog appears.

3. From the Allow tab, choose List.

4. Click inside the Source box and enter the following: 
=INDIRECT($B$10)

5. Click OK.

You now have a dependent ingredients list. It bears mentioning once you select an item in B12, if you 
change the item in B10 you now have something invalid in B12. The way around this is a small piece of 
VBA to clear the item in B12 when B10 changes. In a Worksheet_Change module you could use this: 

Cheers!
Thanks to Todd Schulz and Shirlene Wilkin for naming this technique as one of their favorites.
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#18 Smile for the Excel Camera!
Excel is all about straight lines. While this is great, it can also be a pain to make everything look good when 
you are trying to line up disparately sized elements onto a single page. Fortunately, the Excel camera tool 
is here to help.

First, Get Yourself a Camera

The camera tool doesn’t automatically appear on your Ribbon, but you can add it to your QAT: 

1. Right-click on the QAT and choose Customize Quick Access Toolbar.

2. The Excel Options dialog appears. In the Choose Commands From dropdown, choose Commands Not in 
the Ribbon.

3. Scroll down to find Camera. Click Add to add it to your QAT.
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When Your Data Is Not Camera Ready

Say that you want to show a quarterly payroll report below a budget table. But the payroll account num-
bers are too long, and if you make the columns wide enough to display them, you’ve made your budget 
report look ugly again. The solution is to move the payroll report somewhere offscreen to make it look 
nice.

Once your payroll data is off in faraway lands in column Y, you can give it the makeover it desperately 
needs! 

Here’s the before shot:

Here’s a recap of what I did to make it look better: I started by removing the 2016 Payroll title in Y2 and 
moved that over to B9, where the rest of the payroll information will eventually appear. I applied the same 
formatting to B9 as I had in B1.
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Back to the Makeup Chair

Back over to column Y. For the remaining data, to get the alternate-row shading effect quickly, I used 
Ctrl+T to temporarily turn Y3:AC7 into a table and then I converted it back into a standard range by select-
ing Table Tools, Tools group, Convert to Range. I adjusted column widths so everything is visible, and at 
this point I am pleased with the look of it:

Ready for an Excelfie! 

All that is left to do is snap the picture and place it somewhere on the worksheet. At this point, you just 
highlight the now beautifully formatted payroll data and then click the new camera icon on your QAT. You 
will see the “marching ants” around your selection, just like when you copy something into the clipboard.
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Now go back over to where your original report is, in column 
B. You’ll notice that your cursor has turned into a small black 
cross, which means you are ready to draw. 

Position your cursor just below B9, under your payroll report 
header.

Now just click once. The picture appears! It’s an object that 
“floats” above your worksheet so you can move it around and 
adjust sizing just as you would with a text box or shape. 

Design tip: Don’t stretch it too much in any direction, or the resolution will start to look off. 

The best part is, the picture is a linked object, as you might notice by looking at the formula bar, which 
shows the source range when the object is selected. So when you make a change in the source range, the 
changes will be reflected in your linked picture object.

Now there is something to smile about!
Joerg Decker, Gerald Strever and Bernard Vukas suggested the Camera tool

 Illustration: Walter Moore
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#19 VLOOKUP – to the Left!

Go West, Young Man

You've all heard it before. VLOOKUP can only “look right”. It's a myth, but a very popular one. It's not sur-
prising this is such an ingrained fact of life. In his Excelcampus blog, Excel MVP Jon Acampora reminds us 
just how often we do VLOOKUP in our heads, following exactly the same motion that Excel does:

Courtesy of Jon Acampora. Logos modified here to protect the innocent.

So we reinforce our familiar VLOOKUP mindset every time we order coffee?? Apparently so! 

But data isn’t always arranged in the way we need it. So what if we wanted Excel to look to the left?

When Going Right Just Won’t Work..

Let’s say you’re back at Excelicious Café again, and it’s trivia night! You fire up Excel to check the scores 
from last week. Here’s a partial view of the first 19 teams:
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Highest possible score of 100; Excel people are to be feared.

You can use VLOOKUP to find the number of players or last week’s score by team captain or by team name, 
because directionally both of those questions “look right.” But what if you want to look up team captain 
based on team name? Or how about best week by team captain?

CHOOSE to Go Left

It turns out you can “trick” VLOOKUP into going left by incorporating the CHOOSE function with VLOOKUP. 
On its own, CHOOSE will choose an item from a list, based on an index number. The official Excel syntax is:

=CHOOSE(index_num, value1, [value 2]…) 

You can have up to 254 values. CHOOSE will return the value based on the index_num. For example:

=CHOOSE(1,"Excel","Tableau","Babylonian Clay Tablet")

will return Excel because that is first in the list of values. Now, buckle up. Here is the crazy part. Array for-
mula fans will love this trick, one that I learned from Mynda Treacy (thanks, Mynda)!

If you surround the index_num argument with some curly brackets {} you can specify more than one index 
number. You can also specify ranges instead of values, so CHOOSE will return a range reference. So this 
formula:

=CHOOSE({1,2},$C$2:$C$15,$B$2:$B$15))

is basically saying, C is the first column, and B is the second column. What does all this mean for VLOOKUP? 
It means you can replace the entire table_array argument VLOOKUP with a CHOOSE function like this anytime 
you want VLOOKUP to go left.
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A Whole New Syntax

Now let’s compare the “old”  VLOOKUP – looking only right – with our “new”  VLOOKUP that can look left.

To look right, the old familiar syntax:

=VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup])

To look left, the new syntax:

=VLOOKUP(lookup_value,CHOOSE({1,2},lookup_array,return_array), 2, 
FALSE)

where

lookup_value is the value you seek, lookup_array is the column containing your lookup value , and return 
array is the column containing the return value.

Let’s try an example. Say that you're back at trivia night, and the competition is still fierce! You want to 
know who the team captain of Hungarian Notation is because those people worry you. You break down 
the arguments using the “look left” syntax:

●● lookup_value is “Hungarian Notation”.

●● lookup_array is C2:C19.

●● return_array is B2:B19.

Plugging these into a look-left-style VLOOKUP function:

=VLOOKUP("Hungarian Notation",CHOOSE({1,2}, C2:C19, B2:B19), 2, FALSE)

returns Kris. I knew it!

And Now, with Structured Referencing

Now, if you’ve turned the data into Excel table (Ctrl+T), you will of course wind up with structured refer-
ences in your formulas. Assume that you’ve done this and that you've named your table TriviaTable. The 
final example shows how your new VLOOKUP-LEFT* technique lets Excel find the team captain in C24 and 
the best performance week in C26 based on a team name selected from a dropdown list in C22.

Neat!

*Dear Microsoft, can we please have a simpler way to do this now? Maybe just allow negative numbers for 
the column_index_num argument? Thanks!

Illustration: Walter Moore
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Mark Ford, Jeremy Trebas and @InfiniteDrifter suggested this technique.

#20 Data Shaping (Unpivot) with Power Query
A good portion of this book is dedicated to the amazing powers of the pivot table, and now I’m suggest-
ing you unpivot? Yes!

If you are a regular Excel user and have not used Power Query, you should get on that ASAP. It is a free add-
in, easily found online via a quick Google Bing search. It works with Excel 2010 or higher.

So what does Power Query do? In a nutshell, it is a hugely powerful program that lets you do all kinds of 
data cleansing, aggregating, and reshaping in a much simpler way than ever before. The total scope of its 
powers is far greater than what can be covered in the next pages here. Nevertheless, I suspect you will be 
hooked and will want to know more. If so, you should check out the great resources Ken Puls and Miguel 
Escobar have to offer: http://mrx.cl/pqtraining.

One for the Pivot Table Users

If you use pivot tables, you know that creating a pivot table is the easy part. Even on the reporting side, 
you can do quite a bit without a ton of effort. But challenges arise before any of this happens, in particular 
when the source data is not in the format you need. For example, if you try to pivot this, it will basically 
suck:
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You might think it looks like a flat table – even pivot table data source-esque. Close, but no dice. It might 
be just fine as a pivot table report but not as source data. The official reasons for the eventual suckitude 
have to do with database theory and data normalization forms. But let’s not put ourselves to sleep digress. 
Suffice it to say: if the column headers in your source data can double as values within a field, you need to re-
shape your data before you pivot. In this case, the column headers (6/30/2015 and so on) could double as 
values - for a field called week. That’s why it won’t work as a data source, and that’s why you need Power 
Query. 

Power Query to the Rescue

You’ve downloaded Power Query. It shows up as a new tab on your Ribbon. Now:

1. Click anywhere inside your data table that needs to be fixed. In your new Power Query tab, click From 
Table.

Power Query helpfully reminds you of your data range and confirms that your table has headers.

2. Click OK to accept this.
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33. In the Power Query Editor dialog, click the column header for the Product field to highlight the Product 
column.

4. Click the Transform tab on the Power Query ribbon. In the Any Column group, find Unpivot Columns 
icon. Choose Unpivot Other Columns from the dropdown list. 
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Your data now looks like this:

5. Clean up the columns: Right-click the Value column, choose Rename, and change Value to Units. Right-
click on the Attribute column, choose Rename, and change Attribute to Week. 
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6. With the Week column highlighted, click the 
Transform tab and change the Week column’s 
Data Type from Any to Date. 

The Query Settings pane, with Applied Steps. It’s like a modern Excel 
version of the VBA macro recorder!

7. In the Query Settings pane on the 
right change the name of your data 
table to Units (optional, but good 
practice). Also notice that Power 
Query has been recording your steps 
for you all this time, in the Applied 
Steps list.

8. In the Power Query Home tab, click Close & Load (or it might be Apply & Close).

Power Query creates a new worksheet and loads your reshaped data into an Excel table. Best of all, it’s 
“normalized” – that is, pivot table friendly!

Modern Excel. You’ve come a long way, baby!
Alaeddin Badran and David Rosenthal both suggested unpivoting for this book.
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#21 XSzil Design Tips for Excel for Presenters and Trainers
By popular demand, this tip is just for presenters and Excel trainers. Following are some “outside the 
gridlines” ideas I’ve used over the years to design fun, engaging Excel classes and takeaway materials.

Use FORMULATEXT()

If you want to show a formula in your onscreen or printed materials so the reader can easily see both a for-
mula and the result at the same time, use FORMULATEXT. 

Adapted from a Mike Girvin example, except he used dogs. I am team both, personally.

Yes, FORMULATEXT will save your life, especially for printed materials. 

Trainers, take note! If you distribute any files to others, remember that there are still people in this world 
who do not have Excel 2013. FORMULATEXT was introduced in 2013. Here is a simple VBA function you can 
use that will work for all versions:

Using this approach will ensure that pre-Excel 2013 users won’t get a bunch of #NAME errors when they 
open your file:
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Excel for Presentations at the Office

Even for non-training purposes, you can make Excel more presentation friendly by minimizing the Ribbon, 
hiding gridlines, hiding the formula bar, and hiding row and column headers. With enough creativity, 
people won’t even realize you’re in Excel! Aesthetics count. This is increasingly important these days, with 
more and more Excel “competitors” capitalizing on the beautiful look and feel of their products, forever 
comparing themselves to Excel.

Excel for Excel Training

For training sessions, of course I like to stay in Excel 
as much as possible rather than doing the constant 
Alt+Tab between Excel and PowerPoint (no offense, 
PowerPoint, I love you, too). So, I create Excel/
PowerPoint hybrids. How do I do it without sacrific-
ing the intent of an Excel training session with too 
much silliness?

Make Use of Pictures and Shapes

In the previous figure, you can see my cat’s beauti-
ful headshot. Hard to believe, but that handsome 
image adds more than incredible cuteness to a pre-
sentation. As you know, we can assign macros to 
shapes and pictures with a simple right-click:
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This opens up all kinds of possibilities. Here are some of the macros that I’ve used in training presentations:

●● Toggle font color between black and white for anything I don’t want attendees to see on screen until 
I’m ready to show them. This macro will do that trick:

●● Toggle the formula bar on/off (to  hide the formula bar until you are ready to show it):

●● Toggle a specific row or column to show/hide:
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“Worksheet Within a Worksheet” Effect

This effect is kind of like those Russian nesting dolls. It looks like this:

The “fake column” effect is created with the formula you see in the formula bar. COLUMN() won’t work be-
cause it returns a number. For “fake rows” it’s easier: use ROW().

Why all the fuss? For one thing, when you convert the Excel file to PDF, poof! Instant e-book that you can 
distribute to attendees. The Excel file is then a practice file and book, all in one.

Final Word

There are certainly many other ways to approach designing course materials, and I am sure many of them 
are far more efficient than mine. Using Excel for course materials is probably every serious graphic artist’s 
nightmare. I know. I’ve seen the raised eyebrows. But to me, it’s a labor of love and further proof that Excel 
is truly the world’s most versatile software, ever.

XSzil evangelizing 
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#22 Fill in a Flash
Excel 2013 added a new data-cleansing tool called Flash Fill. In the figure below, you see full names in 
column A. You want to get the person’s first initial and last name in column B. Rather than try to puzzle out 
=PROPER(LEFT(A2,1)&" "&MID(A2,FIND(" ",A2)+1,50)), you simply type a sample of what you want in B2.

Type the first initial in B3. Excel sees what you are doing and “grays in” a suggested result.

Press Enter to accept the suggestion. Bam! All of the data is filled in.

Look carefully through your data for exceptions to the rule. Two people here have middle initials. Do you 
want the middle initial to appear? If so, cor-
rect the suggestion for Dennis P. Jancsy in 
cell B4. Flash Fill will jump into action and 
fix Martha K. Wendel in B9 and any others 
that match the new pattern. The status bar 
will indicate how many changes were 
made.

An on-grid dropdown menu appears. Open 
this, and you can select the cells that were 
just changed. Change the font color and 
the filter by color to inspect them.

In the above case, Excel gurus could have 
figured out the formula. But Flash Fill is 
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easier. In the following case, it would be harder to write a formula to get the last word from a phrase that 
has a different number of words and more than one hyphen.

Flash Fill makes this easy. Go to cell B3. Press Ctrl+E to invoke Flash Fill.

Note that Flash Fill will not automatically fill in numbers. If you have numbers, you might see Flash Fill 
temporarily “gray in” a suggestion but then withdraw it. This is your signal to press Ctrl+E to give Flash Fill 
permission to fill in numbers.
Thanks to Chad Rothschiller at Microsoft for building this feature. Thanks also tto Olga Kryuchkova.

#23 Suppress Errors with IFERROR
Formula errors can be common. If you have a data set with hundreds of records, a divide-by-Zero or a #N/A 
are bound to pop up now and then.

In the past, preventing errors required herculean efforts. Nod your head knowingly if you’ve ever knocked 
out =IF(ISNA(VLOOKUP(A2,Table,2,0),"Not Found",VLOOKUP(A2,Table,2,0)). Besides being really long to 
type, that solution requires Excel to do twice as many VLOOKUPs. First, you do a VLOOKUP to see if the 
VLOOKUP is going to produce an error. Then you do the same VLOOKUP again to get the non-error result.

Excel 2010 introduced the greatly improved =IFERROR(Formula,Value If Error). I know that IFERROR sounds 
like the old old ISERROR, ISERR, ISNA functions, but it is completely different.

This is a brilliant function: =IFERROR(VLOOKUP(A2,Table,2,0),"Not Found"). If you have 1,000 VLOOKUPs 
and only 5 return #N/A, then the 995 that worked only require a single VLOOKUP. It is only the 5 that re-
turned #N/A that need to move on to the second argument of IFERROR.
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Oddly, Excel 2013 added the IFNA() function. It is just like IFERROR but only looks for #N/A errors. One 
might imagine a strange situation where the value in the lookup table is found, but the resulting answer is 
a division by 0. If you wanted to preserve the divide-by-zero error for some reason, then IFNA() will do this.

Of course, the person who built the lookup table should have used IFERROR to prevent the division by 
zero in the first place. In the figure below, the “n.m.” is a former manager’s code for “not meaningful.”

Thanks to Justin Fishman, Stephen Gilmer, and Excel by Joe.

#24 Plural Conditions with SUMIFS
Did you notice the “S” that got added to the end of SUMIF starting in Excel 2007? While SUMIF and SUMIFS 
sound the same, the new SUMIFS can run circles around its elder sibling.

The old SUMIF and COUNTIF have been around since Excel 97. In the figure below, the formula tells Excel 
to look through the names in B2:B22. If a name is equal to the name in F4, then sum the corresponding cell 
from the range starting in D2. (I realize that most people would use $D$2:$D$22 as the last argument, but 
you only have to specify the top cell.)
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SUMIF and COUNTIF were great when you only had one condition. But if you had two or more things to 
check, you had to switch over to SUMPRODUCT. (I realize most people would replace my multiplication 
signs with commas and add a double-minus before the first two terms, but mine works, too.)

SUMIFS allows for up to 127 conditions. Because you might have an indeterminate number of conditions 
in the function, the numbers that you are adding up move from the third argument to the first argument. 
In the following formula, you are summing D2:D22, but only the rows where column B is Allen Matz and 
column C is Widget.

Excel 2007 also added plural versions of COUNTIFS and AVERAGEIFS. All of these "S" functions are very ef-
ficient and fast.
Thanks to Nathi Njoko, Abshir Osman, Scott Russell, and Ryan Sitoy.
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#25 Formatting as Façade
Excel is amazing at storing one number and presenting another number. Choose any cell and select 

Currency format. Excel adds a dollar sign and a 
comma and presents the number rounded to 
two decimal places. In the figure below, cell D2 
actually contains 6.42452514. Thankfully, the 
built-in custom number format presents the re-
sults in an easy-to-read format.

The custom number format code in D2 is 
$#,##0.00. In this code, 0s are required digits. Any #s are optional digits. 

However, formatting codes can be far more complex. The code above has one format. That format is ap-
plied to every value in the cell. If you provide a code with two formats, 
the first format is for non-negative numbers, and the second format is for 
negative numbers. You separate the formats with semi-colons. If you pro-
vide a code with three formats, the first is for positive, then negative, then 
zero. If you provide a code with four formats, they are used for positive, 
negative, zero, and text.

Even if you are using a built-in format, you can go to Format Cells, Number, Custom and see the code used 
to generate that format. Here is the code for the Accounting format:

To build your own custom format, go to Format Cells, Number, Custom and enter the code in the Type box. 
Check out the example in the Sample box to make sure everything looks correct.

In the following example, three zones are used. Text in quotes is added to the number format to customize 
the message.
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If you create a zone for zero but put nothing there, you will hide all zero values. The following code uses 
color codes for positive and negative. The code ends in a semi-colon, creating a zone for zero values. But 
since the zone is empty, zero values are not shown.

Walter Moore

You can extend this by making all zones blank. A custom format code ;;; will hide values in the display and 
printout. However, you'll still be able to see the values in 
the formula bar. If you hide values by making the font 
white, the ;;; will stay hidden even if people change the fill 
color. The following figure includes some interesting for-
matting tricks.

In B2 and B3, if you put ** before the 
number code, it will fill to the left of the 
number with asterisks like the old check 
writer machines would do. But there is 
nothing that says you have to use aster-
isks. Whatever you put after the first as-
terisk is repeated to fill the space. Row 3 
uses *! to repeat exclamation points.

In B4 and B5, each comma that you put after the final zero will divide the number by 1,000. The code 0,K 
shows numbers in thousands, with a K afterward. If you want to show millions, use two commas. The “M” 
code must be put in quotes, since M already means months.

In B6 put a stern message in the fourth zone to alert anyone entering data that you want a number in the 
cell. If they accidentally enter text, the message appears.

In B7 to B9 the normal zones Positives, Negatives, and Zero are overwritten by conditions that you put in 
square brackets. Numbers under 70 are red. Numbers over 90 are blue. Everything else is black.

In B10, those odd _( symbols in the accounting format are telling Excel to leave as much space as a left 
parenthesis would take. It turns out that an underscore followed by any character will leave as much white 
space as that character. In B10, the code contains 4 zeroes. But there are different amounts of space be-
tween each. The space between the 1 and 2 is the width of 2 WW characters. The space between 2 and 3 is 
the width of an N. The space between 3 and 4 is the width of a lowercase letter i.
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The following figure shows various date formatting codes.

Note that the mmmmm format in row 8 is useful for producing J F M A M J J A S O N D chart labels.
Thanks to Dave Baylis, Brad Edgar, Mike Girvin, and @best_excel for suggesting this feature.

#26 Extract Uniques with a CSE Formula
This example is way beyond the scope of this book. There is a secret type of formula in Excel that requires 
you to press Ctrl+Shift+Enter in order to unlock the powers of the formula.

If you or I needed to get a unique list of values from column B, we would do something such as use an ad-
vanced filter or a pivot table or copy the data and use Remove 
Duplicates. These methods take five seconds and are easy for you 
or me. 

The problem rears its head when you need your manager’s man-
ager to use the spreadsheet. You cannot hope that the VP of Sales 
is going to master doing a Copy and Remove Duplicates. You 
need a way to have live formulas that will always be extracting 
unique lists of values.

The formulas to do this are absolutely insane. But they work. In 
the figure below, a long formula in D2 figures out how many unique values are in the list. An even longer 
formula in D5 that is copied down extracts the unique list.

Here is the formula. I won’t try to explain it to you.



30 BONUS TIPS FOR EXCEL'S 30TH BIRTHDAY	 213 

3

But I will do the next best thing. I will introduce you to someone who can explain it to you. Mike Girvin has 
produced thousands of Excel videos on YouTube under the ExcelisFun chan-
nel. He has also written a few Excel books, including Ctrl+Shift+Enter – the 
complete guide to these amazing formulas. In the book, Mike explains this 
formula and many other formulas in detail so you can understand how they 
work and write your own. If you are ever about to give up on a formula be-
cause it can’t be done, there is a good chance the formulas in Mike’s book will 
solve it.
Thanks to Mike Girvin, Olga Kryuchkova, and @canalyze_it for suggesting this feature.

While I am promoting Mike Girvin's book, I should mention that you should check out is ExcelisFun YouTube channel 
where he has thousands of free amazing videos. Mike and I have done a series of fun Dueling Excel videos, where we 
show various ways to solve problems in Excel.

Illustration credit: Szilvia Juhasz

You could say that Mike is the Elvis of Excel.

Illustration: Michelle Routt
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#27 Consolidate Quarterly Worksheets
There are two ancient consolidation tools in Excel. 

To understand them, say that you have three data sets. Each has names down the left side and months 
across the top. Notice that the names are different, and there are a different number of months in each 
data set.

You want to combine these into a single data set. Turn the page for a discussion of the two methods.
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Illustration: Cartoon Bob D'Amico
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The first tool is the Consolidate command on the Data tab. Choose a blank section of the workbook before 
starting the command. Use the RefEdit button to point to each of your data sets and then click Add. In the 
lower left, choose Top Row and Left Column. 

When you click OK, a superset of all three data sets is produced. The first column con-
tains any name in any of the three data sets. Row 1 contains any month in any data set.

In the above figure, notice three annoyances. Cell A1 is always left blank. The data in A is not sorted. If a 
person was missing from a data set, then cells are left empty instead of being filled with 0.

Filling in cell A1 is easy enough. Sorting by name involves using Flash Fill to get the last name in column N. 
Here is how to fill blank cells with 0:

1. Select all of the cells that should have numbers: B2:M11.

2. Select Home, Find & Select, Go To Special.

3. Choose Blanks and then click OK. You will be left with all of the blank cells selected.

4. Type 0 and then Ctrl+Enter.
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The result: a nicely formatted summary report.

The other ancient tool is the Multiple Consolidation Range pivot table. Follow these steps:

1. Press Alt+D, P to invoke the Excel 2003 Pivot Table Wizard.

2. Choose Multiple Consolidation Ranges in step 1. Click Next.

3. Choose I Will Create the Page Fields in step 2a. Click Next.

4. In Step 2b, use the RefEdit to point to each table. Click Add after each.
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5. Click Finish to create this pivot table.

Thanks to CTroy for suggesting this feature.

#28 A2:INDEX() Is Like a Non-Volatile OFFSET
This is a niche tip. There is an amazingly flexible function called OFFSET. It is flexible because it can point 
to a different-sized range that is calculated on-the-fly. In the image below, if someone changes the # Qtrs 
dropdown in H1 from 3 to 4, the fourth argument of OFFSET will make sure that the range expands to in-
clude four columns.

Spreadsheet gurus hate OFFSET because it is a volatile function. If you go to a completely unrelated cell 
and enter a number, all of the OFFSET functions will calculate. Even if that cell has nothing to do with H1 
or B2. Most of the time, Excel is very careful to only waste time calculating the cells that need to calculate. 
But once you introduce OFFSET, all of the OFFSET cells, plus everything downline from the OFFSET, starts 
calculating after every change in the worksheet.
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I was judging the 2013 ModelOff finals in New York City when a few of my friends from Australia pointed 
out a bizarre workaround. In the formula below, there is a colon before the INDEX function. Normally, the 
INDEX function shown below would return the 1403 from cell D2. But when you put a colon on either side 
of the INDEX function, it starts returning the cell address D2 instead of the contents of D2. This is wild that 
it works. 

Why does this matter? INDEX is not volatile. You get all of the flexible goodness of OFFSET without the 
time-sucking recalculations over and over.
I first learned this tip from Dan Mayoh at Fintega. Thanks to Access Analytic for suggesting this feature.
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#29 Sort and Filter by Color or Icon
Conditional formatting got a lot of new features in Excel 2007, including icon sets and more than three 
levels of rules. This allows for some pretty interesting formatting over a large range. But, once you format 
the cells, you might want to quickly see all the ones that are formatted a particular way. In Excel 2007, sort-
ing and filtering were also updated to help you do just that!

This book analysis table has some highlighted rows to flag interesting books and an icon next to the price 
if the book is in the top 25% of prices in the list:

If you want to quickly view all the highlighted rows or cells that have icons, just dropdown the filter for the 
column and choose Filter by Color (or Sort by Color to bubble them to the top):

Then you can pick the formatting you want to sort or filter by! This doesn’t just work for conditional for-
matting; it also works for manually coloring cells. It is also available on the right-click menu of a cell under 
the Filter or Sort flyout, and in the Sort dialog.

This tip is from Sam Radakovitz, a project manager on the Excel team. He is more fond of cats than dogs.
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#30 Word for Excellers
Note: Sam Radakovitz from the previous tip is one of the coolest Excel Project Managers. For ex-
ample, Sam actually enjoys hanging out with the Excel MVPs at the annual MVP Summit instead of 
seeing them annoying. Sam started bringing his fiancé, Katie Sullivan, to our gatherings. Katie is a 
Project Manager on the Microsoft Word team. For our last tip in the book, I turn the podium over 
to Katie.

While Excel fans sometimes tease that Word and PowerPoint are freeware apps that come on the Excel 
DVD, there are times when Microsoft Word offers a feature that Excel does not. In those cases, it makes 
sense to copy your data from Excel, paste to Word, do the command, then copy back to Excel. Here are 
some examples of techniques that are better handled in Word than in Excel.

Technique 1: Convert to Upper, Lower, Proper

If you have to convert from uppercase to lowercase or proper case, Word has a keystroke shortcut. Copy 
the data to Word and toggle the case using Shift+F3.

Technique 2: Add Bullets

If you want to add bullets to Excel cells, it is far easier in Word than in Excel. Copy the cells to Word and 
apply a bullet style. Copy from Word and paste back to Excel. You might have to use the Reduce Indent 
icon a few times.

Technique 3: Visualize and Color Formulas

If you have a massively long formula, say one with 10 nested IF statements, you can paste to Word and 
use colors and Shift+Enter to space the formula to help make sense of the formula. (One rebuttal from the 
Excel team: You can expand the formula bar and use Alt+Enter to split a formula into many lines. Or, use 
the great Ref Tree Analyser add-in from Jan Karel Pieterse; see http://mrx.cl/jkpformula.)

Technique 4: Faster SmartArt

Word offers the Convert Text to SmartArt option. While Excel offers SmartArt, too, it is not very handy there 
because you have to copy the entries one at a time into the SmartArt pane.

Technique 5: Extract Data from a PDF

Say that someone has an Excel workbook and saves that workbook as a PDF. They send it to you. This is an-
noying, and clearly they don't want you to reuse the data. If you open the PDF in Acrobat Reader, copy the 
data, and paste to Excel, it will unwind into a single column. But here is the secret: Paste that data to Word 
first. The rows and columns will paste properly. You can then copy from Word and paste back into Excel. (If 
you are stuck in a pre-2013 version of Office, I recommend Able2Extract: http://mrx.cl/pdftoxl.)
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Here is the original data on the left and how it looks when you paste directly from PDF to Excel on the 
right. You can see that the data “unwinds,” with B1:C1 going to A2:A3 and so on.

Paste that same data to Word (below left), then copy from Word and paste to Excel (below right). The data 
stays in the original order. You can unapply Word Wrap and adjust the column widths to get back to the 
original data.

Technique 6: Change Formatting of Words Within Excel

If you have sentences of text in Excel, it is possible to select one word while in Edit mode and change the 
color of that word. But globally change the color of all occurrences of 
the word in Excel is tedious. Instead, paste the data to Word and press 
Ctrl+H. Change dog to dog. Click More>> and then Format, Font. 
Choose Red. Click Replace All. Copy from Word and paste back to Excel.

Technique 7: Replace While Keeping Character Formatting

Word also handles a similar problem: replacing text but leaving the text formatting as it is. Below is a 
survey about the best pet. Someone has highlighted certain words within the text.
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Use Ctrl+H to do a Find and Replace. When 
you use Replace All, if a sentence was 
changed, your in-cell formats will be lost. In 
the figure below, the strikethrough remains 
in the first row because that row did not 
have an occurrence of the word puppy and 
thus was not changed.

To keep the formatting in the original text, 
copy to Word. Do the Replace in Word. Copy 
from Word and paste back to Excel.

On behalf of the entire Word team, Katie invites all of you Excellers who still type your letters in Excel using 
Fill Justify to come on over and give Word a spin.

Bonus Tip: Merge Shapes
Here's a brief plug for PowerPoint: If you need to create a shape in Excel that is a combination of other 
shapes, create the shapes in PowerPoint. Select all the shapes. On the Drawing Tools Format tab, choose 
Merge Shapes. You can Union, Combine, Fragment, Intersect, or Subtract to combine the shapes. (The 
Subtract feature would let you cut a hole in a shape.) Then copy that shape and paste to Excel (or Word).

Bonus Tip: Eye Dropper
Another feature unique to PowerPoint is the eye dropper. If you want to use a particular color you can just 
click the eye drop on the color. When you open the Power Point color menu again. Choose More Colors 
and you can see the RGB colors. To use the eyedropper outside of the PowerPoint frame, hold down the 
left mouse button and pick from any website or picture you have visible on your desktop.
Thanks to Katie Sullivan (a project manager on the Word team!) for contributing this tip. Katie clearly prefers dogs to cats. Thanks 
to Glenna Shaw and Oz du Soleil for contributing ideas to this tip. Zack Barresse and Echo Swinford pointed out the Merge Shapes 
option in PowerPoint. Sam Radakovitz added the eye dropper tip and noted the subtract feature for shapes.

#31 40 Tips for the next MXL Book
More than 200 ideas were sent in for this book. While the following ideas did not get much press here, they 
are self-explanatory in a 140-character tweet. I will hang on to these for my 1040th (MXL) book!

●● Quick Sum: Highlight a group of cells and see the sum, average, etc., on the status bar at the bottom of 
the screen. -Al Momrik

●● To make Excel open full-screen, right-click the Excel icon and change the Run setting to Full Screen. 
-David Ringstrom, CPA

●● Use a thin light border line to create useful scrollbar maximums when your worksheet contains charts 
that the scrollbars don’t recognize. -Chris Mack

●● Highlight duplicate records with Conditional Formatting, Highlight Cells, Duplicate Records. -@Leaf_xl
●● If you want to color every other row, use this conditional formatting formula: =MOD(ROW(),2)=0. 

-Pedro Millers
●● Save As CSV to get rid of all trailing spaces and merged cells. -Oz du Soleil
●● Have a photo appear after a dropdown list in Excel http://t.co/TjbAtSkJ3t -Michael A. Rempel
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●● Select two (or more) columns, Find & Select, Go To Special, Row Differences. -Colleen Young
●● Use Skip Blanks when pasting values. It skips any blanks in the target range. -Laura Lewis
●● Use pictographs for charts (column and pie): Copy picture: select series, paste. -Olga Kryuchkova
●● For a pie chart with too many slices: move small slices to second pie using Pie of Pie chart. -Olga 

Kryuchkova
●● Use X/Y charts for drawing artwork. -Joerg Decker
●● You can use a wildcard in =VLOOKUP("A*",Table,2,False). -Khalif John Clark
●● Sort with a formula: =LARGE(A$1:A$10,ROW(1:1)). -Meni Porat
●● INDEX can return an entire row/column and return a cell reference. -Sumit Bansal
●● With year in A2, this formula calculates Easter Sunday: =DOLLAR(("4/"&A2)/7+MOD(19*MOD

(A2,19)-7,30)*14%,)*7-6. sent by Matt Allington (author Thomas Jansen)
●● Put an apostrophe in front of an Excel formula to stop it from being evaluated. -@DiffEngineX
●● DATEDIF(A2,B2,"Y")&" years, "&DATEDIF(A2,B2,"YM")&” months, "&DATEDIF(A2,B2,"MD")&" days." -Paul 

Wright
●● Insert rows without breaking formulas. Cell above is OFFSET(thisCell,-1,0) - Jon Wittwer, Vertex42.com
●● The =NPV function does not calculate the Net Present Value of the investment. Always subtract one 

from the result.  -Olen L. Greer
●● Use EDATE to move the date out one month or year. -Justin Fishman
●● When Excel says you have links, but you can’t find them, check in the Name Manager. Ta-da! -Lisa 

Burkett
●● Formulas created in Notepad, saved as CSV, & opened in Excel work. Example: mike,=proper(A1) will 

give Mike. -@mdhExcel
●● Double-click a formula. Excel color codes the cells referenced in the formula. - Cat Parkinson
●● Turn off Edit Directly in Cell. Then double-click a formula to show cells used in that formula, even if in 

external workbook. -Sean Blessitt, David Ringstrom
●● Go To Special, Constants helps spot constants within a block of formulas where a formula is overwrit-

ten with a number. -@HowToExcel
●● Select a random 5% of data using =RAND()<.05. -Olga Kryuchkova
●● Format comments as funny shapes like a heart or smiley face. http://mrx.cl/commentshape -Olga 

Kryuchkova
●● Highlight formulas using the Conditional Formatting formula =HASFORMULA(A1). Requires Excel 

2013. -Justin Fishman
●● Double-click a number in a pivot to get the detail behind that number. -@Sheet1
●● Array formula to count without COUNT: =SUM(IF(ISNUMBER(MyRange),1,0)). -Meni Porat
●● In the VBA window, you can set the property of a worksheet to xlVeryHidden to keep most people out 

of the sheet. -Sagar Malik
●● In VBA, use Range("A1").CurrentRegion instead of RANGE(). It is like pressing Ctrl+*. -Arnout Brandt
●● You can use hyperlinks to launch VBA macros. Smaller than buttons. -Cecelia Rieb
●● Use a macro to color the heading cells that have filters applied. -Peter Edwards
●● Use Environ("UserName") in VBA code for restricting workbook access. -Angelina Teneva
●● Use a UDF in a hyperlink to change cells. http://mrx.cl/udfhyperlink -Jordan Goldmeier
●● There are a variety of games written tin Excel (2048, MissileCommand, pleuroku, TowerDefense, Pac-

Man, Rubic’s Cube,  Yahtzee, Tetris) -Olga Kryuchkova
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INTRODUCTION

Can I create a pivot table with VBA? Should I use a pie chart? When should I use 
VLOOKUP, and when should I use INDEX/MATCH? This book answers none of these 
questions. In fact, this is perhaps the first Excel book in history that can actually make you 
forget all the Excel tips you just read. Fortunately, you won’t care, because your taste buds 
will be rejoicing when you sip your very first Excel inspired cocktail.

So what’s an Excel cocktail anyway? The first of their kind, these cocktails are Excel 
“themed.” Meaning, their recipes were inspired by, and carefully crafted with specific 
Excel concepts, ideas, truisms, or famous Excel personalities in mind. In short, the sort of 
stuff hardcore Excel nerds can truly appreciate. Only this time, served in a cocktail glass.
The unveiling of this very special cocktail collection could not have been more 
appropriately timed. It was exactly 30 years ago when Microsoft Excel was released 
unto to the world. 30 years, especially in software years, really says something. For me 
personally, this book has been a true labor of Excel-love, a celebration, and my personal 
homage to Excel herself (oh yes I did).

Happy birthday, Excel! Cheers to you.



EXCEL LIBRE

Happy birthday, Excel! It’s your big 3-0! Aww, you’re so grown up! Why, I remember when I first 
installed you. Your tortured little 16-bit color palette, your adorable little pal Clippy (rest his soul), 
and those very first 3D charts of yours, they still make the data viz experts weep. Just look at you 
now: more than 50 new functions, Power BI, Excel Web App. Your power user fan base is over half 
a billion strong and still growing. Some might say you’re the Coca-Cola of software. So here’s a 
delicious modern variation on the classic Cuba Libre, in honor of your big day.

Main recipe yields 1 drink
Supporting recipes yield batches of 6-8

Ingredients
1½ oz. vanilla-infused aged rum*
¼ oz. roasted lime juice**
4 oz. Mexican Coke 

Garnish
Lime wedge

Add all ingredients to a Collins glass filled with ice. Garnish with lime wedge.

* Vanilla-Infused Rum (make at least 24 hours in advance)
Yields approximately 6 1½-oz. portions
9 oz. aged rum
2½ vanilla beans
Split vanilla beans down the middle and place in a nonreactive container. Add rum. Let sit for at least 24 hours. 
Strain mixture through a fine-mesh strainer.

** Roasted Lime Juice (make at least 24 hours in advance)
Yields approximately 8 ¼-oz. portions
2 halved limes
Place limes, cut side up, on a baking sheet. Broil on low for 15–20 minutes, or until the limes are plump and 
moderately charred. Juice the roasted limes and strain through a fine-mesh strainer. Refrigerate in a nonreactive 
container.



SPARKLINE SWIZZLE

Do your data visualizations lack in sizzle? Try a Sparkline Swizzle! Those dull, sad little stacks of 
stats will go from drab to fab in just a few mouse clicks. But with so many colors and styles to 
choose from, you just might need a bit of help making your decisions. Meet my fabulous friends, 
vodka and Champagne. They’re always ready to inspire your next great decision..

Main recipe yields 1 drink
Supporting recipe yields batches of 20

Ingredients
1½ oz. vodka
½ oz. green tea syrup*
½ oz. lemon juice
Champagne

Garnish
Lemon peel

Fill a cocktail shaker with ice and add all ingredients except the Champagne. Shake and strain into 
a champagne flute. Top with champagne. Garnish with lemon peel.

* Green Tea Syrup (Make up to 1 month in advance)
16 oz. sugar
8 oz. water
3 green tea bags

Heat sugar and water in a saucepan, stirring frequently. Once sugar has dissolved and syrup begins 
to boil, add green tea bags. Let steep at a simmer for 10 minutes. Turn off heat and let steep for an 
additional 20 minutes. Remove tea bags. Refrigerate syrup in a nonreactive container.



CORRUPT FORMULA

Sage advice for aspiring Excel analysts: Adding “just one more little column” of array formulas to a 
rickety old 40 MB Excel file probably isn’t going to be “just fine.” That would be like drinking alcohol 
to cure a hangover. Or would it?

This invigorating brew is a delicious descendant of the classic Corpse Reviver, which, according 
to cocktail historians, was a hair-of-the-dog formula devised precisely for the purpose of curing 
hangovers. So the next time you’ve blown your volatile functions wad and you’ve got some 
downtime while Excel hangs in “not responding” mode, enjoy a few of these little gems. You’ll feel 
better in the morning, even if your spreadsheet doesn’t.

Yields 1 drink

Ingredients
¾ oz. gin
¾ oz. Cointreau
¾ oz. Lillet Blanc
½ oz. lemon juice
1 bar spoon Crème Yvette

Garnish
Lime peel

Fill a cocktail shaker with ice and add all ingredients. Shake and strain into a chilled coupe glass. 
Garnish with lime peel.



BROKEN LINK

Science says our taste buds can detect up to 300 distinct types of bitterness. Thanks, Science, but 
can any of those truly compare to the bitterness of broken links in a spreadsheet? It’s that dreaded 
scenario: Bob from Accounting has left the company. You’ve inherited his terrible Excel model, 
and now you’re staring down hundreds of broken links pointing to a mysterious, nonexistent C: 
drive. Grab the whiskey, my friend, because you’re about to spend your entire afternoon clicking 
the Change Source button, trapped in an inESCapable loop of Edit Links dialogs. You realize the 
other Bob (Umlas) is your best hope for salvation, so you wait for him to send you a solution, but 
it’s coming by fax*.  So in the meantime, this tasty, golden, orange-infused little gem has just the 
right amount of bitters to take the edge off. It’s sweet yet strong, the perfect therapy to soothe your 
looming carpal tunnel syndrome. To (both) Bobs…

*DISCLAIMER: Bob Umlas is a “first wave” MVP. He does enjoy telling stories about the days when 
Microsoft used to actually fax people answers to their Excel questions. However, Bob has since 
moved on to embrace ListServs.

Yields 1 drink

Ingredients
1½ oz. rye whiskey
1 oz. Aperol
¾ oz. sweet vermouth
¼ oz. Amaro
3 dashes Angostura bitters

Garnish
Orange slice

Add all ingredients to a mixing glass filled with ice. Stir to chill and then strain into a double old 
fashioned glass. Add 1 large ice cube. Garnish with orange slice.



STACKED COLUMN SHOT

PARTY GAME! Can you make a stacked column chart in Excel faster than your bartender can make 
this Stacked Column Shot in your glass? No? Another shot for you, my friend… ♪♪♪ - Tequila! - ♪♪♪

Main recipe yields 2 shots (or 1 big one if you’re down)
Supporting recipe yields batch of 20

Ingredients
1½ oz. Reposado tequila
¼ oz. Curaçao
½ oz. cinnamon syrup*
½ oz. lemon juice
1 oz. orange juice
1 dash Peychaud’s bitters

Fill a cocktail shaker with ice and add tequila, cinnamon syrup, lemon juice, and orange juice. 
Shake and strain into 2 tall shot glasses. Next, gently pour blue curacao into shot glasses, taking 
care so the colors do not bleed together. Tilting the glass at an angle as you pour can help with this 
effort. Carefully add a dash of Peychaud’s on top.

* Cinnamon Syrup (Make up to 1 month in advance)
16 oz. sugar
8 oz. water
4 cinnamon sticks

Heat sugar and water in a saucepan, stirring frequently. Once sugar has dissolved and syrup 
begins to boil, add cinnamon sticks. Let steep at a simmer for 10 minutes. Turn off heat and let 
steep for an additional 20 minutes. Remove cinnamon sticks. Refrigerate syrup in a nonreactive 
container.



DAX ON THE BEACH

Hey, single Excel lovers, do you remember when summer lasted forever? And do you remember 
how long it took you to finally figure out what the hell a DAX formula is? Well, you’ve done it, and 
it’s time for some fun in the sun. While you download that Tinder-for-Excel add-in to speed up the 
search for your fresh new squeeze, keep sipping on this spin-on-the-original-sin. By the time that 
app finishes installing, this flirty formula will guarantee that everyone’s “measures” look amazing! 
Before you know it, you’ll be “swiping right” all day long.

Main recipe yields 1 drink
Supporting recipe yields batch of 20

Ingredients
1½ oz. vodka
½ oz. lime juice
½ oz. simple syrup*
2 oz. mango nectar
1 small bottle or can lemon/lime soda

Garnishes
Lime wheel
Mint sprig

In a cocktail shaker filled with ice add all ingredients except the lemon/lime soda. Shake and strain 
into a goblet filled with ice. Top with lemon/lime soda. Garnish with lime wheel and mint sprig.

* Simple Syrup (Make up to 1 month in advance)
16 oz. sugar
8 oz. water
Heat sugar and water in a saucepan, stirring frequently. Once sugar has dissolved and syrup begins 
to boil, remove from heat. Refrigerate in a nonreactive container.



POWER PIVOTINI

Modern Excel has never tasted so good. This audience favorite (lucky focus group!) is powered by 
“Navy-strength” gin, which means it ranks 15 points higher on the alcohol proof scale than the more 
familiar varieties, like London dry style. It’s like the 128-bit of gins! Industrial alcohol strength aside, 
it’s hard to not notice the masterful presentation here, which, like a well-crafted PowerPivot model, 
takes a bit of patience and skill. Once you get there, you won’t ever want to come back.

Main recipe yields 1 drink

Ingredients
1½ oz. Navy-strength gin
½ oz. lime juice
½ oz. honey
½ oz. elderflower liqueur
1 egg white

Garnishes
2-4 drops Angostura bitters

Add all ingredients to a cocktail shaker. Dry shake for 10 seconds to emulsify egg white. Add ice 
and shake for an additional 30 seconds. Strain into a coupe glass. Carefully tap bottle of Angostura 
bitters on top, allowing drops to form a PowerPivot-worthy design.



JITTERBUG JELEN

Fun fact about Mr. Excel: When he’s not shaking his Excel moneymaker, he’s shining up his boogie 
shoes then heading towards the world famous Tropical Haven Dance Hall in Melbourne, Florida. 
Sunday nights, it’s “Don & Joy” bringing the live music, while Bill and his 93-years-young dad, Robert 
Jelen, captivate the crowd with their best ballroom shimmy shakes. Between cha-chas, Bill is often 
seen moonwalking towards his laptop to refresh his Excel based dance card decision model. Salud!

Yields 1 drink

Ingredients
1½ oz. aged rum
¼ oz. pomegranate grenadine
½ oz. lime juice
½ oz. falernum
3 dashes Angostura bitters

Garnishes
Lime wheel
Mint sprig

Fill a cocktail shaker with ice and add all ingredients. Shake well. Strain into a collins glass filled 
with crushed ice. Garnish with lime wheel and mint sprig.



CTRL+B

Next time you’re discussing dashboards over Sunday brunch, go bold with this feisty take on the classic Bloody 
Mary. A dedication to self-professed bacon aficionado and “Data Pig” himself, Mike Alexander, the Ctrl+B is a surefire 
shortcut to some sizzling banter around the table. B is for breakfast. B is for bold. And now, B is for bacon-infused 
bourbon. Word to the wise: a formula this bacon-y delicious will require a bit of advance planning, like a finely tuned 
Excel dashboard with a generous helping of slicers. Fun for the whole Bloody Mary lovin’ family!

Main recipe yields 1 drink
Supporting recipes yield approximately 6 

Ingredients
1½ oz. bacon-infused bourbon*
½ oz. peppercorn & horseradish shrub**
1 large cube tomato water ice***
3 dashes celery bitters

Garnish
Salt rim (Eric suggests smoked sriracha salt)

Rim a double old fashioned glass with your salt. Add all ingredients to the glass and stir to chill.

* Bacon-Infused Bourbon (Make at least 12 hours in advance)
9 oz. bourbon
2½ oz. rendered bacon fat
Arrange approximately 9 bacon strips on a foil-lined sheet pan. Place the pan in a cold oven and set the temperature to 425°F. Bake 
for 15 to 20 minutes, or until crisp. Harvest all the rendered bacon fat. In a jar, mix together the bourbon and 2½ oz. of the rendered 
bacon fat. Close the jar and shake vigorously. Refrigerate for at least 12 hours. Skim the solidified bacon fat off the top of the mixture 
and strain the infused bourbon through cheesecloth or a fine-mesh strainer.

** Peppercorn & Horseradish Shrub (Make at least 30 minutes in advance)
2 oz. honey
2 oz. balsamic vinegar
1 tsp. whole black peppercorns
1 tsp. horseradish
Whisk all ingredients together and let rest for 30 minutes for flavors to meld. Strain mixture through a fine-mesh strainer.

*** Tomato Water Ice (Make at least 12 hours in advance, or long enough to freeze)
6 ripe vine-on tomatoes (OK if a bit over ripe, it will give it extra flavor)
Puree tomatoes in a food processor. Strain the pulp through cheesecloth. Fill an ice cube tray (a silicon one that makes larger cubes 
or orbs, if you have one) with the resulting tomato water. Freeze until solid.



RC COLUMNS( )

When modern Excel pioneer Rob Collie was interviewed about his preferred libational inspirations, 
he said he leans toward gin in order to “appear suaver than I really am.” Indeed. RC’s most 
impressive creation to date goes beyond the invention of the word “suaver.” As a founding engineer 
of Power Pivot, Rob is a leading voice in the modern Excel revolution. His popular and entertaining 
blog PowerPivotPro is a great read on all things modern Excel, so it pairs perfectly with this modern 
twist (or shall we say “pivot”?) on the classic Tom Collins (or is it Tom Columns?) 

Main recipe yields 1 drink
Supporting recipe yields batches of 20

Ingredients
1½ oz. gin (Rob prefers Hendrick’s. Because suaver.)
½ oz. ginger syrup*
½ oz. lemon juice
Club soda

Fill a cocktail shaker with ice and add all ingredients except soda. Shake and strain into a collins 
glass filled with ice. Top with soda. Garnish with lemon wedge

* Ginger syrup (Can be made up to 1 month in advance)
16 oz. sugar
8 oz. water
8 oz. peeled, chopped ginger
¼ tsp. orange zest

Heat sugar and water in a saucepan, stirring frequently. Once sugar has dissolved, let syrup boil 
for 5 minutes. Pour the syrup and other ingredients into a blender and blend for 20 seconds. Strain 
mixture through cheesecloth. Refrigerate syrup in a nonreactive container.



DIRTY GIRVIN

XSzil: “Hey, Mike, what do you like to drink?”
Mike Girvin: “Cheap Oakland beer [and a shot]!”

Well, alrighty then. It’s ON like a Dueling Excel smack down. Let’s start with a fresh coffee bean 
infusion, because with over 2,500 Excel Is Fun video tutorials and counting, it would seem you’ve 
been pulling a few all-nighters this semester. Bottoms up, Professor!

Main recipe yields 1 drink
Supporting recipe yields batches of 6

Ingredients
1 can of your favorite Oakland beer, or classic American-style lager
1½ oz. vanilla espresso-infused bourbon*

Pop open the can and pour the beer into a frosty mug. Pour in a shot of vanilla espresso-infused 
bourbon. Throw one back every time Mike says, “Ctrl Shift Enter.”

* Vanilla Espresso-Infused Bourbon (Make at least 24 hours in advance)
9 oz. bourbon
2 vanilla beans
2 oz. whole espresso beans (approximately 20 beans)

Split the vanilla beans down the middle and place them in a nonreactive container. Add bourbon 
and espresso beans. Let sit for at least 24 hours. Strain mixture through a fine-mesh strainer.



CHANDOO’S CONDITION

Oh, mighty Chandoo. 
How DO you DO what you DO,
to make EXCEL DREAMS come TRUE( )..
by the thousands, the millions, or perhaps a BILLION times TWO??
If only I KNEW how to write an EXCEL HAIKU,
I’d do so for YOU.
Instead, I’ll just sip this chocolatey BREW, so deliciously AWESOME, it’s named after YOU.

Main recipe yields 1 drink
Supporting recipes yield batches of 6

Ingredients
1½ oz. vanilla-infused aged rum*
½ oz. chocolate syrup
½ oz. simple syrup**
1 oz. heavy cream
1 whole egg

Garnish
Ground cinnamon

Add all ingredients to an empty cocktail shaker. Dry shake for 10 seconds to emulsify egg. Add ice 
and shake for 30 seconds more. Strain into a goblet. Sprinkle top with ground cinnamon. Then write 
a Chandoo poem because a lot of words rhyme with Chandoo. Come on, you know you want TO…

* Vanilla-Infused Aged Rum (Make at least 24 hours in advance)
9 oz. aged rum
2½ vanilla beans

Split vanilla beans down the middle and place in a nonreactive container. Add rum. Let sit for at 
least 24 hours at room temperature. Strain mixture through a fine-mesh strainer.

** Simple Syrup (Make up to 1 month in advance)
16 oz. sugar
8 oz. water
Heat sugar and water in a saucepan, stirring frequently. Once sugar has dissolved and syrup begins 
to boil, remove from heat. Refrigerate in a nonreactive container.



ABOUT THE AUTHORS

Szilvia Juhasz, aka XSzil

Based on a True Story

Los Angeles-based Szilvia Juhasz, known in the Excel world simply as 
XSzil, hails from Cleveland, Ohio. As a young, aspiring spreadsheet 

artist, she ran away from home because her parents insisted that she would never make 
it as an Excel consultant. “Why can't you focus on something practical...like acting or 
singing?!” they would plead. But Szilvia had Sparklines in her eyes. One day, with nothing 
but her Windows 95 laptop, her tears, and the MrExcel poster she had torn down from 
her bedroom wall, she defiantly boarded a standby flight to Budapest to hang with 
fellow Excel bohemians and beg in the streets for unpaid Excel internships. Eventually she 
wound up in San Francisco, working as a nightclub singer to pay the bills while pursuing 
her ultimate dream of being an Excel consultant. Fast forward to present day, Szilvia is 
busy running XSzil Consulting. She helps businesses improve processes, leverage existing 
systems, and maximize their Excel potential. In her spare time, she enjoys relaxing at her 
beachside home office, making Excel-inspired parody music, jingles, and animation videos. 
Szilvia hopes this special cocktail collection will inspire creativity and passion in your own 
personal Excel journey. She’d also like to propose a toast, to Excel, on a milestone birthday!

Eric Ho, Master Mixologist & Unintentional Scientist

Also known as “Cleveland’s greatest bartender,” Brooklyn-born Ohio 
resident Eric Ho earned his aerospace engineering degree from 
Case Western University in 2009. So what did he do? Naturally, he 
sailed toward the boozier shores of bartending. In 2010, his original 

Beetnik’s Tonic recipe was awarded top honors in the Tanqueray T&T Competition, 
a nationwide contest for the best twist on the classic Gin & Tonic. He has since had 
recipes published in numerous industry magazines, books, and periodicals. Currently 
Bar Manager and Principal Bartender at Melt Bar and Grilled in Cleveland, Eric has an 
insatiable passion for all things alcohol, from their origin to production practices to 
— most importantly — how they taste. While he says he’s never really “looked back,” 
his engineer’s perspective still shines through in his inventive craft cocktail and menu 
creations, which he approaches with great attention to efficiency, accuracy, and balance. 
Eric also keeps busy running his new startup, Cantina Distillery. Eric loves to travel and 
explore the dining cultures and cuisines of lands both near and far away. His personal 
favorite libation is a shot of American whiskey and a good beer.
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Part 4 - Excel Fun
Excel Jokes
Excel MVP Jordan Goldmeier is the Henny Youngman of Excel. He has written/collected 40 spreadsheet 
jokes. If the joke is not credited, it is by Jordan. Others: AG=Alex Guttman, LB = Liam Bastick ,  
ODS=Oz du Soleil, and SJ=Szilvia Juhasz.  

An analyst walks into a bar chart… Ouch?
Spreadsheet jokes are so formulaic. (-AG)
Q: What’s the best way to ruin a spreadsheet? A: WordArt
Q: Why are spreadsheets like prison? A: So many cells

Q: Why can’t 
spreadsheets drive cars? 
A: They crash too often

Walter Moore

Q: What happens when you insult an Excel application? A: It stops responding
Did you hear about the constipated spreadsheet? He couldn't budget. (-LB)
Q: Why was the spreadsheet arrested?  A: For an illegal error

There once was a man named Dave, 
Having worked for hours all day,  
But then one fatal cell,  
Sent his spreadsheet to hell,  
Next time he’ll remember to save

Q: What do spreadsheet developers order at McDonald's? A: A big macro
Calibri walks into a bar, and the bartender says, “Sorry, we don’t serve your type in here”
Q: What do you call a broken spreadsheet? A: The new guy’s problem
Q: What did the VLOOKUP say on his online dating profile? A: “Seeking an approximate match”.  It’s True! 
(-SJ)
On Error Goto Excel Hell (-SJ)
The spreadsheet circus is in town: Circ du cell A
Best cell to store Excel error messages?  FU2 (LB)
Accountants are now allowed to deduct jokes made at their expense.
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When 
spreadsheets go 
on vacation, they 
go to Graceland, 
to see Excelvis (SJ)

Walter Moore

Please prepare a meta analysis to analyze the spreadsheet you use to analyze the spreadsheet you use to 
track all the spreadsheets you use… (-SJ)
Q: What happens when spreadsheets break up? A: They become Ex cells (-SJ)
SOLVER?! I barely know her! (-SJ)

Q: Kim Kardashian's 
favorite spreadsheet?  
A: The #Excelfie (-SJ)

Walter Moore

Q: Why was the spreadsheet x-rated? A: Because of graphic content. 
Q: What happens when a bar chart works out? A: It becomes stacked.
Q: What do you call a spreadsheet consultant who owns his own company? A: Cell-employed
Q: What happens when a spreadsheet gets sick? A: VTHROWUP()
Q: What do you call a spreadsheet philosopher? A: Excelstensial (-SJ)
Q: What do Excel users put in their hair? A: SUMPRODUCT()
Q: What does every newborn spreadsheet need? A: Formula
Q: What do statisticians look for in a spouse? A: A normal distribution
Q: What do you call an egotistical Excel user? A: Cell-centered
Q: Why were the data depressed? A: No validation.
Q: What do you call Excel users in contest to see who can fill up their spreadsheet the fastest?  A: A 
drag-race
Q: How did the murderer get out of jail? A: He unselected View Gridlines  (-ODS)
Q: Why did the spreadsheet hate his job? A: Too many functions
Q: How do you quickly take over a spreadsheet? A: By using Ctrl.
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Q: Where do 
spreadsheets go to 
drown their errors?  
A: The formula bar

Illustration: Chad Thomas

Q: Why can’t you give an accountant a birthday gift? A: Because they’ll want to know the present value!

Q: How do 
spreadsheets gain 
muscle?  
A: Lots of REPTs
Illustration: Walter Moore

A pivot table walks into a bar and orders a beer and says, “Put me in the same tab, will ya?”
If I had a dollar for every time someone stuffed up my formulas by deleting a cell I’d have #REF! by now (LB)
Q: How many interns are required to fix a messed up spreadsheet? A: As many as you can blame

Q: Why can’t 
spreadsheets tell 
stories? A: Too 
many circular 
references (-ODS)

Walter Moore
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Excel Tweets
One of my favorite things about Friday is the collection of Excel tweets published by Excel MVP Debra 
Dalgleish. Check this out each Friday: http://exceltheatre.com/blog/. Here are 40 all-time favorite Excel 
tweets, courtesy of Debra.

●● What kind of monster sets Workbook Calculation to Manual in Excel anyway?

●● Today I wore my *VLOOKUP face* all day. It’s a bit like my *Pivot Table face* crossed with my *I'm sure I 
can smell something nasty face*

●● If I want to use an Excel worksheet on this computer today I have to open it last week.

●● Oh, the joys of opening a 2+ year old Excel workbook and trying to remember how it was constructed.

●● You know work changed you when you realize you are already using the so-called "Top 10 Excel Tips 
You Probably Don't Know".

●● Put down the Excel slowly and step away from the chart…

●● I totally just made Excel make a pie chart. It even included the right stuff. This is a breakthrough. 

●● I'm so crafty I've locked myself out of my OWN stupid Excel file!!! 

●● Kids - learn three things in Excel. Vlookup. Pivot tables. How to create a chart. The average office 
worker will think you're a GOD. 

●● Using a mouse in Excel is the work equivalent of wearing a lanyard when you first get to college. 

●● A blank Excel workbook - the world at your fingertips 

●● How does anyone work in Excel without visible gridlines. You're all barbarians 

●● OK, this is getting a little scary. My Excel VBA code is actually starting to work. I doubted this day would 
ever come.

●● At some point, the pivot table that I was working on achieved sentience. Time for a beer.

●● Sipping coffee while simultaneously making charts on Excel and reading Wall Street Journal articles. 
I'm adulting pretty hard today.

●● It puzzles me why people "colour code" in Excel. Any good ideas why?

●● Things I would rather do than work on an excel spreadsheet; 1; eat kale 2; bathe cats 3; get hit by a car 

●● There's a reason this Excel workbook is titled "Headache.xlsx" 

●● Guy in my class just asked me how to make a basic chart in excel…. *must not judge* 

●● How many engineers does it take to make a bar chart on excel? Apparently 5. 

●● I have an Excel file that contains 15 sheets and 108 charts. If I lose this file, I will die.

●● Wondering how long I can stare at this same Excel sheet before boss realizes I haven't done any work 
since lunch 

●● They said, "You are gonna excel in life." What they really meant is, "I will be doing Excel my whole life." 
#FML 

●● never felt technologically challenged till I tried to graph on excel 

●● Intensive Excel-work can turn any day into a Monday really fast… 

●● I spend more time in Excel than I do in my bed. That is sad. #work #officelife #ctrlaltdelete

●● Computer claims "It is impossible to close Excel." I pull the plug. — If I ever plug you back in, don't 
EVER forget who's boss! #Ineedadrink 
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●● My grandfather swore he'd retire the day they made him use a computer. My Grandma uses Excel like a 
boss. 

●● Work is sending me to Excel school. Not sure if compliment… or punishment. 

●● I daydream about using my skills to save lives; "A monster is destroying the city! Can ANYONE make a 
pivot table in an Excel spreadsheet???"

●● If you are asking yourself if now is a good time to save your #Excel workbook, the answer is 'yes'

●● My husband is explaining a pivot table to our 7 year old, and she is in awe. #girlswhocode 

●● There is exactly one person on planet earth who will understand any given Excel worksheet; The 
person who created it. 

●● I can't work with human beings who hard code total amounts in excel files. Cannot. 

●● I judge people at the office by their ability to use a pivot table. 

●● Things I've learned to appreciate since starting work: free food, bathroom breaks, Excel formulas 

●● Always good to be friends with someone who can work Microsoft Excel! 

●● Well, turns out I don't know how to use a pivot table… 

●● Not everything I do at work revolves around Excel. Only the fun parts.

●● Wrote a macro to save time. Closed Excel without saving it. #FML 
Thanks to Debra Dalgleish for collecting thousands of funny Excel tweets and providing this list. Thanks to the tweeters: @28fly-
ersfan, @aalannyse, @Adovy, @algaegirl328, @alliebp, @anarchival, @awellofcards, @beanbeannie, @BeingHanuman, @bethykins, 
@bouleg812, @cdhowe, @chiayilcy, @ChrisGriff87, @danieljayz, @DanielleHollyxx, @danmarsekapr, @DehvanM, @Dodslaw, @
gilltuft, @gueroguerinche, @incurablehippie, @itsreallyerin, @KeithPulling, @leaflitter, @MarkBrooksVA, @mattyk21fb, @mdhExcel, 
@MMaxwellStroud, @MrPSB, @science_goddess, @Scrappy_INFP, @sethbaysinger, @sherrybearie, @shmouflon, @SWEDUN, @taral-
lodactyl, @thomasrafael, @ThriftyYinzr, @vndimitrova
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Excel Art From The FrankensTeam

All of these are charts created in Excel by The FrankensTeam. https://sites.google.com/site/e90e50charts/

Clockwise From top right: Square Pie, Visualize the Digits of Pi 4, Visualize the Digits of Pi 6, Sun Chart
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Excel Stories

How Did You Get So Good With Excel - Szilvia

It probably all started at birth. (Pardon me while I get comfortable on the therapist’s couch.)

My dad is an engineer, and my mom is an artist and chef. I believe Excel is both art and science, so there is 
that. Also, I was born in the great state of Ohio. Every Excel community insider knows there is some seri-
ous Excel talent that flows through Ohio:  my co-author Bill Jelen, MVP Jordan Goldmeier, bloggers like 
Chris Macro, and Power Pivot pioneer Rob Collie for a brief time. Even Chandoo stayed there for a summer. 
Although I’m in Los Angeles now, I make sure to get back to Ohio every so often to visit my family and to 
drink the Holy Excel water to stay on my game.

My first “serious” day job as an out-on-my-own adult was for one of those fancy “Big 6” consulting firms 
at their Budapest office. I think they must have hired me only because I could speak the local language, 
as I had no real accounting or audit experience to speak of.  This is where I really cut my teeth on Excel, 
because those firms pretty much live and die by it.  Spending most of my days cranking out spreadsheets, 
I soon realized there was just something about Excel. Somehow it came naturally to me, and I kept stum-
bling upon new little tricks and features by accident. I found it fascinating that there were so many things 
Excel could do. I didn’t know at the time that most of the “normal” people around me did not share my 
fascination. But I kept going with it. I may have not understood all the ins and outs of debits and credits, 
but pivot tables and I were sure getting along great. I was finding Excel was making me more curious, and 
helping me understand a lot about business.

A few years and circumstances later, I wound up working for the Gap at their San Francisco headquarters.  
A finance manager there blew my mind when he walked me through me some VBA code that would help 
automate some reports I was doing. I never figured I would be able to decipher programming languages 
of any kind. I could not help myself, I just had to understand more about how it all worked. So began my 
foray into the Excel object model. It was addicting. I redesigned the entire payroll planning and reporting 
process for Old Navy finance with a VBA/pivot table-driven model. It was a solution used by corporate fi-
nance departments, and also by store managers out in the field across the country. I had to be mindful of 
the wide variety of skillsets of my end users so I found myself stepping in the role of accidental trainer as 
well. I believe I got one phone call asking me about the “foot pedal” (mouse).

A few years later San Francisco was no longer in the cards for me. The Gap was doing big-time layoffs, 
including most of their finance team, and including me. It wasn’t a great job market up north, but I still 
loved California. So I moved down to LA and did what everyone else does there: “fake it till you make it.” In 
other words, figuring things out without really committing to anything. Eager to try something different, 
I started to “fake” my way into a freelance consulting career by signing up with a bunch of temp agencies. 
So began a chapter I like to call the “Accidental Excel Consultant” years.

I would work for anyone needing anything remotely Excel related. Usually I didn’t last long because I 
always wanted to rip apart then rebuild all the Excel spreadsheets instead of taking orders from someone 
who inevitably wanted things their old and inefficient way, which often made me cringe inside until I 
could no longer stand it. So for the most part, I was getting in trouble because I was doing a great job – a 
job that I wasn’t hired to do. Other times my Excel habit would actually pay off, bosses were impressed, 
and would move me into more suitable roles.  But typically, I was sent back out onto the streets (well, back 
to my small West Hollywood apartment, just off Melrose and across from a retired seniors/swingers com-
munity home, but that story is for another book), until the next sucker came along to help me pay rent.

Then another few years later as I got better at the whole game, I could afford to start getting pickier about 
my assignments. One lucky one was at Westfield, the retail and commercial real estate giant. I was brought 
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in to help standardize and consolidate corporate overhead budgets for 40 departments – all in Excel! By 
this time I was getting really good, and realized that I had become that go-to Excel person in the office. 
A delightful, funny woman (and now friend), Nancy Kiriro, also worked there. One day she suggested we 
organize an afternoon training session for a few fellow finance employees “so you can show them how you 
do all that stuff in Excel.” We did, and after a very successful day of tons of Excel demos and a few laughs, 
they wanted five more days. XSzil was born. And Westfield continues to be one of my favorite clients.  They 
still bring me in for training and consulting gigs, almost a decade later.

There was one other day that stands out in my Excel-life as a turning point. Appropriately enough, it took 
place in Ohio.  After several life-saver tips I picked up from the MrExcel.com message board over the years, 
I learned that Bill Jelen was doing a seminar in Ohio. I was due for a parental visit, so it made sense to co-
ordinate the two trips (Okay, so maybe I also kind of wanted to meet MrExcel). So I showed up that day at 
the University of Akron and introduced myself.  I learned some new stuff, and there was of course other 
stuff I already knew (*pats self on back*). But then, Bill learned something new too. Because in the middle 
of a longish demo he was doing on pivot tables, I piped up, “Are you going to show them that ‘show 
pages’ thing?” I asked casually.  And then it happened. I don’t even recall what he said exactly, but he had 
never heard of Show Pages. Bill was stumped. I. stumped. MrExcel. (Was I sitting in row 2? It’s a blur, but I 
must have been.) Bill told me he was going to feature that tip on his next podcast. Since that day, I always 
chuckle at the shout-outs he gives me in his books whenever the subject of Show Pages comes up. We’ve 
become colleagues and friends over the years, so here I am co-writing this book.

Much has transpired since my “Accidental Consulting” days. These days it’s quite on purpose. This golden 
era Excel is experiencing right now means I get to let my Excel [freak] flag fly high with each new busi-
ness opportunity. I work with company leaders, managers, accountants, worker bees… all with the aim of 
better leveraging the world’s most powerful business intelligence software system. 

Life is good.
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The Tech Intelligentsia in Leo’s Green Room

A long time ago, in San Francisco, there was a cable channel called TechTV. Leo Laporte would do two 
shows, live, every afternoon: The Screen Savers and Call for Help. The latter was similar to the Car Talk show 
on National Public Radio, with people calling in with their tech problems and Leo Laporte troubleshooting 
their W-Fi network right on the air. Between calls, there were a number of interesting tech segments and 
two guests per show.

As a guest, you would get six minutes to show an interesting trick or technique. At the end of the six min-
utes, Leo would say something great about your book and hold it up for the camera. I made a total of 86 
appearances on the show.

Leo Laporte and Bill Jelen on the set of The Lab with Leo Laporte. Photo Credit: Sean Carruthers, globalhermit.com.

My first two visits were at the San Francisco studio, where I met a very young Kevin Rose and Roger Chang. 
When the show moved to Toronto, Canada, Leo would film one week of shows a month. It was an easy 
37-minute flight from Cleveland to Toronto, so I went up almost every month and would appear on two 
shows a month.

My favorite episode was my 26th, when I showed how to add subtotals to a data set. On the face of it, this 
had to be the most boring six minutes in the history of television. But the next day, viewer e-mail started 
streaming in. That segment was a hit. My favorite e-mail was from a woman who had been manually 
adding subtotals every morning, taking almost 2 hours each day. She saw the episode, tried the trick, and 
was done in one minute! She quipped, “The best part is that my manager doesn’t watch your show!” She 
had just gained 1 hour and 59 minutes of “free” time to get other stuff done.

In Toronto, a co-host for many years was Amber MacArthur. Amber was always on the leading edge of 
technology. She was constantly in-the-know about what was new and upcoming. She is the one who ad-
vised me to grab the MrExcel handle on this new site called Twitter and introduced me to YouTube in the 
very early days.
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This is also where I first heard about podcasting. Amber and Mike Lazazzera was doing a weekly 
CommandN video podcast. Leo was doing a weekly This Week in Tech audio podcast. Sean Carruthers and 
Andy Walker were doing The Lab Rats. 

Leo is the one who suggested a 2-minute podcast every weekday. So, on July 23, 2006, I started producing 
the Learn Excel from MrExcel video podcast and putting it out on iTunes. Thanks to Amber and Leo and 
the gang, I had video content on iTunes even before the iPod could support video. A few months later, I 
found my podcast on the front screen of iTunes as a Top 10 tech video podcast. That was easy…since there 
were probably only 11 people doing video podcasts back then. Of course, the podcast later morphed into 
my YouTube channel, where I now have 1,900 Excel videos. It would be daunting to build that large of a 
collection of videos today, but by building them slowly, one at a time, it worked out.

Later, the show moved to Vancouver. Again, it was groundbreaking: The Lab with Leo Laporte was shot in 
HD before anyone had HD televisions. Matt Harris and Sean Carruthers made the move to Vancouver. Kate 
Abraham took over as co-host. Since Vancouver was a five-hour trek from Akron, producer Matt Harris let 
me do four shows each month.

Whether in Toronto or Vancouver, they were taping four shows a day. That meant I was hanging out in the 
green room with leading tech personalities. Security expert Steve Gibson was super-friendly. I remember 
asking Merlin Mann for life hacks. My favorite, though, was Dick DeBartolo, MAD Magazine's maddest 
writer. I've taken some improv classes, but Dick DeBartolo has the quickest wit of anyone I've met. Once I 
introduced myself as MrExcel, he pulled out his business card and autographed it, "To Mister Access...".

Leo Laporte, Bill Jelen, Amber MacArthur and Dick DeBartolo of GizWiz.biz on the set of Call for Help in 2006.
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“Do You Want to Write a Book?”

Printed books are not dead!

I started MrExcel as a consulting firm, but I wanted to write a book. I was in a 2002 seminar listening to 
marketing maven Ivana Taylor, and she offered the advice that I needed a $20 product to sell at my web-
site. Before Ivana, people had two choices: get their answer from the MrExcel Message Board for free or 
pay me a few hundred dollars for a custom Excel macro. Ivana pointed out that I needed to give people a 
chance to hand me a small amount of money. That idea worked well. Book sales outpaced consulting.

I hate rejection. I did not want to start trying to convince publishers that I could be the next J-Walk. So, 
I wrote my first book, Guerilla Data Analysis Using Microsoft Excel. My first print run was 10 copies at the 
CopyMax in Akron. I put them on my website and soon sold out. I took the $100 in profit from the first 
print run and printed another 10. Eventually, I found a place that would produce 100 copies with a real 
cover instead of the spiral binding. The Holy Macro! Books publishing company was born.

I was following advice from small-press guru Dan Poynter and reading Publishers Weekly magazine. I really 
wanted my book in the pages of Publishers Weekly, so I took a shortcut and bought an ad in the magazine.  
(Note:  a few years later, Publishers Weekly (PW) did feature the cover of my book, The Spreadsheet at 25 
worth of a mention in the Upcoming Releases section.) The PW ad sales rep pointed me to Independent 
Publishers Group (IPG). This changed everything. Another small-ish publisher, Chicago Review Press, real-
ized that small publishers could benefit from working together and formed IPG. More than 200 niche pub-
lishers are part of IPG. IPG handles selling my books into the book trade. They warehouse the books. They 
ship books. This is a beautiful relationship: I don’t have to worry about storing books in my garage. I can 
focus on finding authors and producing interesting books.

As I travel around, my ears always perk up when I hear that someone wants to write a book. I’ve published 
books by a lot of Excel MVPs and Office experts but also some other books like a rasslin' memoir from the 
Reverend Billy C. Wirtz and Harriers, a book about running Cross Country in high school. It spent a few 
years in the top 10 for the Running category at Amazon. Amazingly, that book was written by cousins Joe 
and Paul Shivers, and they wrote the book in high school. Our next non-Excel project is We Report Space, a 
photo book written by a group of Social Media covering Florida rocket launches

I also write books for the QUE imprint at Pearson, the world’s largest publishing house. I appreciate that re-
lationship. But I have fun with the books produced here at Holy Macro! Off-the-wall titles like M is for (Data) 
Monkey are par for the course here. Good-quality content on the inside allows for a bit of light-heartedness 
on the cover.

Here is a list of books that I hope to write and publish one day. Thanks to Marie Leone, my former editor at 
CFO Magazine who brainstormed many of these!

●● Excel for Human Resources, Excel for the Hospitality Industry, Excel for Call Centers, and so on.
●● 27 Minutes to Excel: The Concise Guide for that Job Interview where you have to "Know" Excel
●● Excel for Search Engine Marketing
●● Option Explicit? A Cage Match with Jordan
●● Beginning Excel Book in Spanish (clearly, I need to learn more Spanish, or find a co-author)
●● 25 Excel Projects - a book detailing start-to-end projects without VBA
●● Household Excel - from high school to retirement. Schedules. Budgets. Grocery Lists
●● Elementary Excel - projects for the K-6 classroom
●● Stay-at-Home Excel - 50 home-based businesses to start with the help of Excel
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Live – On Stage – In Person: The Power Excel Seminars

That poster from Hatch Show Print  on my website sort of started out as a joke. I was flying through 
Nashville and saw a display of old country 
music letterpress posters on the wall. The 
little sign by the posters said they were pro-
duced on a 100-year-old hand-cranked 
press and that the company was still operat-
ing in Nashville. I called them and hired 
them to produce a “concert” poster for my 
live Excel seminars. They had to think I was a 
little nuts. The print shop manager, Jim 
Sherraden, often did an informative presen-
tation about the history of Hatch, and he 
cited my poster as the first to list a website 
URL.

I do my half-day or 1-day seminar for ac-
counting groups across the country. Every 
large city has a local chapter of the Institute 
of Managerial Accountants or the Institute 
of Internal Auditors. The people who belong 

to these groups usually need 20-30 hours of continuing education (CPE) each year. If you join the organi-
zation and go to 12 lunch meetings, half of your CPE is done. The organizations will often sponsor a 1- or 
2-day event with speakers so their members can earn the remaining CPE at one time. I often am invited 
to speak at these events. The poster on the door lets people know that they are not in for the usual tax 
update. (I don’t mean to offend the wonderful people going through the new tax laws…someone’s got to 
do that.)

Excel is used on 750 million devices. I’ve met a lady in Appalachia who used Excel to design original quilt 
patterns. I’ve met people who have designed workbooks in Excel that train people how to fly 737 jets. 
From quilts to jets, Excel is used everywhere. 

When you hand the world’s most flexible software to 750 million people, everyone finds interesting things 
to do or interesting ways to use Excel. I love traveling to do the in-person Excel seminars because I get to 
meet these people. At every seminar, someone has an interesting story of how they are using Excel. At 
every seminar, I always learn a few new Excel tricks from the people in the seminar. I joke that my job is col-
lecting the cool and obscure tricks in Excel from people along the road and passing them on to people fur-
ther on up the road. Many of the amazing tricks in this book came from people in my live Excel seminars.

This is truly a win-win. I have fun doing the seminars. The audience get to take home a cool Excel book. 
Among the 75 tricks that I show in a day, hopefully everyone will find a few that they can take back to work 
to start becoming more efficient the next day. Plus, people earn the CPE hours without hearing about any 
tax updates. Even at the Association for Computers and Taxation, where their annual meeting is all about 
tax updates, they bring me in to do a 2-hour session to offer a little levity between the tax updates!
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The Excel Master Pin

Do you own one of the highly-coveted Excel Master pins?

When I do my live Power Excel seminars, I always encourage the audience to “show me up.” Someone in 
that room is going to have a better way to do some-
thing in Excel. I used to  offer a small prize to the first 
person to teach me something during the seminar. I 
would also predict that the first person to show me 
up that day walked into the room and sat in row 2.

I have no idea why they always go to row 2. But I no-
ticed early on that the best Exceller always chooses 
a seat in row 2. They want to be close. But not front-
row close. Almost every time, the first cool idea from 
the audience comes to row 2. (On the times when 
the first tip comes from another row, I quip, “Did you 
arrive late, and row 2 was already full?”)

Over the years, the prize varied from an Excel func-
tion clock to a free book or a laminated tip card. But 
the most popular prize was a tiny enamel pin: “Excel 
Master. Ask me your Excel questions.” I handed out a 

few of these at each seminar. When I go back to a city a few years later, it is cool to see someone showing 
up with that pin.

“I Just Got a Promotion Because of Your Website”

It is gratifying when I hear this. Once you pass the 40th percentile of Excel skills – once you move beyond 
AutoSum and start to tap into Excel’s power – there is a clear path to dramatically better Excel skills.

In a lot of companies, Excel is used for entering data on a grid with maybe a total at the bottom. If you 
work at one of those companies and can add subtotals to your skill set, you can now do in a minute what 
someone else might spend an hour doing.

Learn how to create and customize a chart, and you can summarize data into information.

Take the steps to learn how to create and customize a pivot table, and you gain the ability to find truth in a 
sea of numbers. 

Compared to your co-workers, you can now make Excel sing and dance and produce faster results than 
anyone else. Your manager’s manager will often notice, and you will become a trusted resource – the 
person who can figure out how to get answers to questions.

It is really gratifying when someone comes up to me and says they picked up some knowledge from one 
of my videos or the message board and used that to get a new job.

One guy said he had a job delivering pizzas. As he drove, he had a laptop continuously streaming the 
YouTube channel from ExcelIsFun and my channel. When I met him, he was in row 2, stunning the audi-
ence with great Excel tricks.



EXCEL FUN	 257 

4

The Excel Function Clock was Born on a Slow Friday Afternoon

It was a Friday afternoon at work and time was dragging. I would look at the clock, do some VLOOKUPs, 
then look back at the clock and barely a minute had passed.

it struck me that it would be funny if someone made a clock where the 3 was replaced with the Excel func-
tion =PI(). This simple function with no arguments returns 3.14. So, =PI() wouldn't be exactly at 3. It would 
have to be just a bit beyond the 3. The solution would be to use the INT function to return just the integer 
portion of PI(). =INT(PI()) returns just 3. Perfect! I am sure I pitched both of these ideas to Kevin Adkins, who 
probably didn't think it was a funny as I did. That never deters me, though.

Over a few evenings, I started collecting functions for the other numbers on the clock. I tried to go with 
things that were useful but a bit obscure. After, all what fun would it be to have =SUM(2,-1) for 1? Most 
people already know SUM. After writing all 12 functions, I actually found the graphic designer who de-
signed the clocks for the old Signals mail order catalog. The Excel function clock was on Call For Help a few 
times. Once, Leo Laporte attached it to a lanyard and wore the clock as if he were rapper Flavor Flav. It was 
funny stuff. 

Here are the 12 formulas:

1. =MIN(1,10). Min returns the minimum number. Since 1<10, the function returns 1.

2. =MONTH(23790). That is the serial number for my birthday, February 17, 1965. That is month number 2.

3. =INT(PI()).  =PI() would've been 1/7 of the way past 3, so =INT returns the integer 3.

4. =LEN("FOUR"). I used LEN daily. =MID(A2,LEN(A2)-7,2) gets the last 2 characters. How long is FOUR? 4.

5. =SQRT(25). The square root of 25 is 5.

6. =FACT(3). Factorials are used to calculate lottery probability. The Factorial of 3 is 3x2x1 or 6.

7. =GCD(77,49). Middle school match is simpler with Excel. The greatest common divisor of 77 and 49 is 7

8. =2^3. The ^ raises 2 to the 3 power. =2*2*2 is 8.

9. =PMT(9%,9,-53.96). If you borrowed $53.96 from the bank to buy some MrExcel books and had to pay it 
back over 9 years with a 9% interest rate, each yearly payment would be $9.

10. =LCM(2,5). Another one for the 7th graders. The Lowest Common Multiple of 2 and 5 is 10.

11. =ROMAN(2). Hmm. My fascination with =ROMAN() began before my 40th book. The =ROMAN(2) is II, 
which looks sort of like 11. Just like XL sounds sort of like Excel.

12. =COLUMN(L1). tells you the column number of a cell. L is column number 12.

If you are thinking you need to get one of these for yourself, head over to http://mrx.cl/excelclock.
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A Brilliant Idea - TrainerTage (Trainer Days)

In 2013 and 2014, I was invited to Lucerne Switzerland to speak at a conference called TrainerTage. The 
conference is in German, but they told me I would be fine if I spoke slowly in English. 

But something odd happened: Mary Ellen Jelen and I flew to Switzerland. It was time for my first session. 
When I showed the Double-click the Fill handle trick, no one gasped. Every time that I do this trick for the 
IMA, a few people in the audience gasp. But here, in Switzerland, no one gasped. 

At the end of my hour-long session (with my very best tricks), Tanja Kuhn explained they needed a higher 
level. As I came to realize, this conference was designed for people who did Microsoft Office training across 
Europe. Every one in the room also traveled every week to train others in Office. I was clearly out-matched.

Every January, trainers from Switzerland, Germany, and the Netherlands gather for very high-level ses-
sions. Each member of Tanja's team researches a new feature in Office and presents it to their peers.

I became friends with many of the people there. 

My Excel 2013 In Depth book was a 1200+ page book - over five pounds of Excel. In Germany, the equiva-
lent book is written by Dietmar Gieringer. Dietmar and I hit it off. I would sit in his seminars, understanding 
very little German, but able to follow what Dietmar was doing in Excel and learning new tricks.

Clockwise from above: Dietmar Gieringer,  
Andreas Thehos, Dominik Petri,  
Tony DeJonker (AlwayExcel.com) 
The TrainerTage trainers: Kai Schneider,  
Dietmar Gieringer, Bea Lengyel , Tanja Kuhn, (Bill Jelen), 
Pia Bork, Ute Simon, Dieter Schiecke, Marcus Hahner.
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I Don’t Have a Corner on Excel Knowledge

I’ve written 40 books about Excel, but there is so much more to learn. Every time I watch someone else do 
an Excel presentation, I learn new tricks. 

Excel consultant Andrew Spain did a short five-trick session at my seminar in Huntsville, Alabama. Two of 
those tricks were brand new to me. (My favorite: If you forget to hold 
down Ctrl while dragging the fill handle to extend 1 into 1, 2, 3, you can 
toggle Ctrl on and off at the end of the drag. While the tooltip does not 
update, the mouse cursor toggles a small + to indicate that you are fill-
ing instead of copying.) That's Andrew Spain and me on the left.

Thomas Fries does a training program for people who have been dis-
placed in the job market. His seminar gives them a hand up so they can 
say they have Excel skills on their resume. I dropped into his class one 
day for five minutes and learned two new things.

During the days of the Call for Help TV show in Toronto, I discovered that you could buy group tickets for 
the Toronto Blue Jays on Tuesdays for $2 each. (And 
that’s $2 Canadian – about US$1.80!). I bought a bunch 
of tickets and invited anyone who used MrExcel.com to 
come to the baseball game. Duane Aubin, Freddy 
Fuentes and John Cockerill were there – you can ask 
them. No one from that night remembers the score be-
cause we sat in left field discussing the best way to do 
VLOOKUP! 

Also in this photo - Tracy Syrstad from MrExcel Consulting. 
Duane Aubin in the back right helped me write The 

Spreadsheet at 25. In the white shirt towards the right is our dear departed friend Nate Oliver - NateO at MrExcel.com.

Photo credit: Freddy Fuentes

There were some people in the next section who overheard our conversation and started heckling that 
they used Lotus. It turns out that they were from a local accounting company and had also bought $2 
group seats; I ended up sponsoring their company baseball team. (They even let me have one at-bat, 
where I hit the ball about one meter and managed to beat the throw to first base.) At the bar after the 
baseball game, we talked about Excel, and I picked up a few new tricks from the Toronto Excellers. 
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New in Excel 2016 - Waterfall Charts & More

For twelve years, I worked at a company doing data analysis. One of my regular tasks was to analyze the 
profit on sales proposals before they went out the door. I did this with a waterfall chart. For me, the water-
fall chart never would have to dip below the zero axis. I used a few tricks to make the columns float and 
drew the connector lines in by hand using a ruler and a black pen. 

Excel 2016 finally offers a built-in waterfall chart type. Select your range of data and create the chart. You 
need to choose which columns are Totals and need to touch the axis. It is very simple.

I wrote about waterfall charts in my monthly Excel column for Strategic Finance magazine. People wrote 
in saying that my method would not work for a cash flow analysis where the balance would dip below 
zero. They were right, you had to go through an insane amount of hoops to have a column dip below zero 
before Excel 2016. Now it all simply works with one click in Excel 2016.
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New in Excel 2016 - Forecast Sheets

Another great feature in Excel 2016 is the the Forecast Sheet function. Select a time series. Excel will look 
for seasonality and produce a forecast and a confidence interval.

There are various settings to control how Excel should look for seasonality.

Excel use new formulas to fill in the future months below your time series.
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I Love Weird Excel Things

If you have a weird bug in Excel, I love to hear about that. If you have some brilliant idea that would make 
Excel better, I love to hear about that, too.

I recall working in 1990s. I used Excel every day. I had an arrow on the floor pointing to Redmond. I would 
face that way and probably use a few expletives whenever I would beat my head against the wall with 
something that could have been better in Excel.

“If Excel would just do this, it would make my life so much easier.”

If you use Excel 20 hours a week, I am sure that you have thought of improvements that would make Excel 
easier for you.

When I ran across one of these ideas, all I could do was face northwest and wonder why the Excel team 
hadn’t done this yet. The Internet was not prevalent. You couldn't bounce over to the Excel Team blog and 
leave a comment like you can today. By the way, the Excel team does read those comments: https://blogs.
office.com/excel/.

I launched MrExcel.com and wrote my first Excel book before I ever met anyone from Redmond. When I 
finally made the call and was granted a two-hour meeting with David Gainer, I was shocked to see that 
my first book was on the conference room table. But it wasn’t just there: It had dozens of sticky notes and 
highlighted sections. 

“Uh oh,” I thought, as my mind raced through all those places where I had criticized Excel for not doing 
what I wanted.

But David was awesome. Smart. He listened. He shared some of his ideas and vision for where Excel should 
be going. Before, they were just nameless people in Redmond. Now, I actually had a face and a name.

And here is what I’ve come to realize: I have great ideas about what should be in Excel. I know that I can 
pass my ideas on to the Excel team, and they get put on the big whiteboard of what should happen next. 
There are 100+ ideas on that board, and for each release of Excel, eight might make it to the product. 

Each release of Excel might have a focus. For example, the calculation engine was improved in Excel 2007. 
If you had a great idea on the board in 2005-2006 and it was not calculation related, you weren’t going to 
see your feature get added to Excel.

There are resource constraints. Excel has to ship the same day as the rest of Office. At some point, you have 
to pick and choose which features get added and which stay on the whiteboard for another time.

I first complained about the blank cells in the row fields of pivottables in my first book in 2002. That feature 
was not fixed in 2003 or in 2007. But I kept asking, and eventually it came. It was fixed in 2010 with the 
amazing Repeat All Item Labels. I was a little disappointed that the tooltip for the feature did not say, “We 
put this in so Bill Jelen will stop bugging us,” but I knew that I had a small part in convincing the Excel team 
to put that feature in there.

So – one very cool thing about my job is having a conduit to pitch new Excel ideas to the people who can 
actually make it happen. I understand many won’t happen and others won’t happen for a few versions. But 
some do happen.

The next time you see me at a seminar, pass those ideas and frustrations along to me, and I will pass them 
on to the keeper of the great Excel idea whiteboard.
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The People at the MrExcel Message Board Answers 800,000 Excel Questions

When I launched MrExcel.com in November 1998, I would get up every morning and answers yesterday's 
e-mailed questions before heading in to work. Initially, it was a question or two each weekday. But, by May 
1999, I was getting more questions than I could answer in an hour. I was answering questions from 5 AM 
to 6 AM and then heading in to work. I either had to start getting up at 4 AM or find another way.

I downloaded WWWBoard from Matt’s Script Archive. I asked people to post their question at the message 
board. And I asked that, after posting, they look at the last few questions to see if they could help someone 
else out. It was like the take-a-penny, leave-a-penny tray at a cash register. If you need help, post a ques-
tion. If you can help someone else out, help them out. It worked. People started posting and answering 
questions.

In the early days, I noticed a few people would stop by almost every day and answer a question or two. 
Ivan F. Moala. Cecilia. The late Dave Hawley.

One day, at work. I was stumped. I went out to my own message board, and described my problem. An 
hour later, Ivan F. Moala from New Zealand had posted an amazing answer. I knew I had something.

The board transformed over the years, morphing into bigger platforms. I was on a $10-a-month hosting 
plan at Pair Networks in Pittsburgh. One day, I get a call from them wondering what I was doing. “You are 
on a $10-a-month plan, but you are using as much traffic as our $1,000-a-month plan!” Apparently, the 
MrExcel Message Board had taken on a life of its own.

Today, the amazing people at the MrExcel Message Board have answered 800,000 questions about Excel. 
We’ve attempted to keep every question live on the site. There are some massive competitors who have 
competing forums, but they have no problem wiping out their history. I run into people all the time who 
say they use my forum. I ask what their handle is. “Oh – I’ve never had to post – I just search. Every answer 
is already there.”

The MrExcel community is staffed by volunteers. Over the years, various experts have worked tirelessly 
as moderators and administrators. My sincere thanks to Andew Poulsom, barry houdini, Colo, fairwinds, 
Ivan F Moala, Joe4, Jon von der Heyden, Juan Pablo Gonzalez, NateO, PaddyD, Peter_SSs, Richard Schollar, 
RoryA, Scott Huish, Smitty, Starl, SydneyGeek, VoG, Von Pookie, zenou, and Zack Barresse. Suat Ozgur and 
Scott Pierson handled the tech issues with the board.

As far as the people answering questions, over 30 people have answered more than 10,000 questions at 
the board. This is a staggering contribution to the Excel community. Thanks to Andrew Poulsom (below 
left) and Aladin Akyurek (below right) with over 70,000 posts each. Norie and Jonmo1 have over 60,000 
posts. Joe4, Smitty, Peter_SSs, RoryA, Richard Schollar, Rick Rothstein and barry houdini have contributed 
more than 20,000 posts. Many of the experts ar MrExcel.com are awarded the MVP Award in Excel from 
Microsoft.

If you ask Google any Excel question, the odds are pretty good that one of the top answers will be from 
MrExcel or one of the pirates who have stolen questions from our site. If you can’t find your answer on 
Google, it is free to post a new question. Make sure to give the post a title that describes what you are 
trying to do. Even in the middle of the night, someone will likely have an answer.
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How Did You Get So Good with Spreadsheets? - Bill

As I look back, there are four main events that caused me to be really good with spreadsheets. I errone-
ously started calling myself MrExcel after only the first two had happened.

1. In 1985, two professors at Notre Dame were doing a research project to compare learning methods. Half 
of the MBA students were taught Lotus 1-2-3 using a traditional method. The other half watched a 4-hour 
program on interactive laser disk. All of the students then took a 25-question test about Lotus 1-2-3. As 
the teaching assistant for Dr. Khalil Matta, it was my job to grade the 25-question test. After grading many 
tests, I noticed that none of these MBA students would ever score higher than 66% on the test. After 
months of watching this, I thought to myself, if I sit down with the test at a computer running Lotus 1-2-3 
and figure out the answer to all 25 questions, I would be better with spreadsheets than that year’s graduat-
ing class of MBAs. So - thank you to Gary Kern and Khalil Matta.

2. After college, I got a job working in the M.I.S. department at Telxon in Akron, Ohio. I was writing COBOL 
programs to support the accounting and finance departments. Back then, if you could knock out a rush 
program in 8 hours to answer a question, you were a hero. I heard the Finance department was looking 
at a 4th generation query tool called EZIQ that would allow them to query mainframe data and run their 
own reports. This was a relief to me, as I would have to do less of their rush reporting. But then, the second 
bit of news. They were going to hire an analyst to run the reports for them. I interviewed. They lured me 
upstairs. 

After moving to Finance, I discovered that EZIQ was not able to produce the reports that the CFO wanted. 
But there was another option in EZIQ - to take the mainframe data and download it to a spreadsheet. 
Even back in 1989, the most powerful button in this 4th generation reporting software was Export to 
Spreadsheet. I was creating reports out using all sorts of data analysis tricks in Lotus 1-2-3 from 1989 to 
1994 and then in Excel from 1995 onward. Every day, I was running new reports. It was a great job - a lot 
of variety. I was running reports for Finance, Accounting, Operations, Order Entry, Sales, Marketing, and 
sometimes even the manufacturing plant. This is where I became really good with Data Consolidate, 
VLOOKUP, Subtotals, Pivot Tables. My thanks to Mark Hauser for hiring me out of the IT department. 

I managed to get some budget for the Inside Microsoft Excel journal and absorbed that every month. I now 
learn that much of that was written by Excel MVP Bob Umlas, the same guy who tech edits my books. I’ve 
published two of Bob’s books as well.

3. In 1998, my buddy Kevin Adkins started calling me MrExcel. He hatched this plan for me to write a book. 
Every day, Kevin was supposed to come in with a new Excel question. After 100 days, I would take all of 
those questions and write a book. It was a great plan, but Kevin did not come up with enough questions. 
After a month, we had only 3 questions. I needed a way to generate new questions.

At the same time, our hated competitor made a hostile takeover bid to buy Telxon. I was about to be out of 
a job. So, on Thanksgiving weekend in 1998, I launched MrExcel.com. The stated purpose: “Send me your 
Excel questions. I will send you the answers. The best question each week will appear on the website. The 
best questions will appear in a book.” That was only partially true. In the back of my head, I thought, “If I 
can get 50 people who use Excel to send me an e-mail, I will have 50 places to send my resume when the 
takeover is complete.”

The site went live on Friday. Somehow, I was picked up by the Excite.com search engine and appeared in 
their top 10 results for Excel. Wednesday morning, I woke up to find 2 Excel questions in my inbox. I ea-
gerly opened the first one. It was from an engineer. He was asking about features of Excel that I had never 
used. I thought, “what a horrible way to start” and clicked Next to go to the other e-mail. This time, it was a 
scientist, and I had no clue what the answer was. My website is calling me MrExcel, and I am 0 for 2 on day 
one. What a mistake.
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But over the next six months, I would wake up every day at 5AM and answer the e-mailed questions for an 
hour. If I did not know the answer, I would use Excel help to figure it out and send the answer back. While 
Telxon had trained me to be really good at transforming mainframe data into information, answering 
questions every morning taught me a lot about other facets of Excel.

Oh - and the suitor backed out of their bid to take over Telxon. I continued to work at Telxon during the 
day and was MrExcel at night.

MrExcel.com became my full-time gig in the year 2000. New management at Telxon were packaging the 
company for sale. They asked me to move to Cincinnati. We even found a house. But then they accidentally 
sent me the WARN letter saying my facility was closing and offering a six-month buyout. I took the buyout, 
figuring I could do Excel consulting for five months and then start looking for a job if it was not working. 
There was only one day that I woke up and did not have a project to do. I loved the 2-4 hour projects. I 
never wanted to move in to a company and work for weeks or months. I liked the quick hit of a macro to 
solve a problem and then move on.

When your day is comprised of doing two-hour consulting jobs, you get to meet a lot of interesting people 
and interesting companies. I've done VBA programs for stock day traders. I've done VBA programs for 
people who think they have a new way to beat the casino or race track. (As an aside, any gamblers should 
check out the Excel Simulations book by Dr. Gerard Verschuuren. This is a fun book that spans topics from 
gambling to genetics.). I've been lucky to get a gig with the Harlem Globetrotters. As a kid, I always hoped 
to play basketball for the Globetrotters. Several issues made that a dubious goal. (I scored a total of 4 
points in an entire season of 5th grade basketball). But - I am thrilled to be creating pivot tables for them. 
My friend Jerry Kohl is always thinking of innovative ways to use Excel at his Brighton company. Today, I 
am often too busy writing or traveling to do VBA consulting, but I have a great team of consultants who 
build VBA macros to automate taks for clients around the world.

I started getting requests to do seminars around the Akron area. I would go in, show subtotals, pivot 
tables, and so on. High-level stuff. One day, while doing a seminar at the Greater Akron Chamber, someone 
asked me a really simple question. While I showed them =PROPER(A2&" "&B2) to join first and last names 
together, I noticed the people were more interested in this simple little formula. I started making the semi-
nars very interactive. I invited people to “show me up” by surprising me with new tricks in Excel that I did 
not know. This became a fun part of the seminars. I always remember where some of the best tricks came 
from. Dave in row 1 in Columbus, Indiana, showed me the right-click, drag right, drag left menu. Derek in 
row 6 in Springfield, Missouri, showed me how to sort subtotals so the largest customer is at the top. Dan 
in row 2 in Philadelphia showed me the hack to AutoFilter a pivot table. Ctrl+Drag the Fill Handle to fill 1, 
2, 3 came from the right side of the auditorium in Kent, Ohio, but I don’t remember her name. The list goes 
on and on.
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Excel Around the World

Clockwise from top left: Highclere Castle, 
London phone booth, Amsterdam MVP 
meeting, PASS BAC,  
Brian Kamimoto aka Brian from Maui, 
Derek Fraley (from row 6!) and Olen 
Greer, Robert Jelen before my Daytona 
Beach seminar, Mary Ellen Jelen with a 
leatherback turtle hatchling in Trinidad, 
Areef Ali in Trinidad, Mark Rosenkrantz 
and Ernst Schuurman in Amsterdam, 
Mel, Bryony, Richard, Jon, and Russ in 
London, Bill with the Hatch Show Print 
poster at Stonehenge.
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The Rock Bottom Brewery in Bellevue Washington

Once a year, Excel gurus from around the world descend on the Rock Bottom Brewery in Bellevue, 
Washington, for a week of Excel discussions. I’ve met many friends here. If you have a favorite Excel blog or 
author, I’ve probably met them at the Rock Bottom Brewery.

Now, the big problem that we have: The Rock Bottom Brewery closes each evening, and we have nothing 
to do during the day. Luckily, we found a few meetings over at Microsoft where we can hang out with the 
project managers who are working on the next version of Excel.

This is generally a horrible experience for new Excel project managers. They walk into a room with 24 Excel 
experts. They show the great feature that they’ve been working on. And then the people in the room pro-
ceed to tell them how much we love the feature by piling on twenty-seven ways to make it better. And we 
are passionate. We’ll will make pitches about why our proposed features are the right features. I suspect 
most Excel PMs leave the room with some PTSD. The experienced Excel project managers don’t present at 
the MVP Summit. They sit in the back of the room and watch. Because out of the hour-long discussion that 
erupts, a few good valuable nuggets make sense. They make it into the product. As a participant, it is easy 
to get frustrated that “the Excel team isn’t listening to ME,” but in fact, it is an honor to be in that room and 
to have some hope of making an impact on the vast sea of Excel ideas.

So the next time you use Flash Fill or create an Excel 2016 waterfall chart, hoist a pint to the Rock Bottom 
Brewery in Bellevue. 

Photo credit: Allie Rutherford  To protest that Power Pivot was not included in all editions of Office 2013, I ran over to the Microsoft Company Store 
and bought enough Pivot shirts to outfit all of the Excel MVPs attending the Summit. We showed up for the Meet the Excel Team wearing these 
shirts. I will note that soon after, Power Pivot was added to the stand-alone boxed edition of Excel 2013. 
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Index

Symbols
--  105
3D charts  228
3D Map  129
3D sum  14
15 minute rule  13
^ for exponent  257
#N/A error  107

A
Able2Extract Pro  132
aBoBoBook  5, 208
Abraham, Kate  253
Absolute reference  86, 164
Acampora, Jon  194
Access Analytic  16, 32, 78, 92, 171, 219
Actual+plan  74
Adaept Information Management  16, 78, 92, 

171
Add-ins dialog  124
Add to Selection  136
Adkins, Kevin  257, 264
Agarwal, Ashish  136
Akron, Ohio  254
Akyurek, Aladin  263
Albert, Peter  1, 3, 57, 58
Alexander, Mike  236
Algebra  168
Ali, Areef  29
Allington, Matt  167, 195, 224
All Systems Go Consulting  7, 78, 114, 171
Alt+;  40
Alt+=  135
Alt+DEF  109, 137
Alt+EDC  88
Alt+EDR  89
Alt+Enter for word wrap  136
Alternate drag & drop  91
Alternate row shading  192
Alt+ESV  137
Alt+F1  28, 136
Alt for snap to grid  137
Alt+OCA  35, 137
Alt+Tab  203
Alt+TI  124, 137
Alt+TMS  137
AlwayExcel.com  258
Amazon.com  254
Analysis ToolPak  97
Analytic Minds  16, 78, 171
AND  100
Andrae, Amy  1, 3
Anna  133
Apfelbeck, Rod  112
Apostrophe to stop formula  224
Application key  91
April Fool’s Day  133
Aqua Man  148
Areef Ali & Associates  16, 78, 171
Arendt-Theilen, Frank  1
Armstrong, Ron  93
Arnott, Myles  89
Arrange All  16
Array constant  115
Array formula  19

for range of dates  102
for unique values  212

Association for Computers and Taxation  16, 
37, 78, 171, 255

Asterisk on grand total  47
Asterisks, fill cell with  211
Atkins, Matt  162

Atlantic City  166
Aubin, Duane  259
AuditExcel  167
AutoComplete  135, 150
AutoFill  12
AutoFilter  4, 44
AutoFit  137
Autofit columns  35
AutoSave versions  25
AutoSum  147, 148
AVERAGEIFS  209
Azzarto, Fr. Tony  1, 214

B
Baak, Charley  57
Babin, Jo Ann  23
Back into answer  119
Bacon-infused bourbon  236
Badran, Alaeddin  201
Bakri, Galeb  73
Banded rows  223
Bansal, Sumit  224
Banuilos, Lorna  1, 209
Barker, Bob  119
Barresse, Zack  vii, 1, 195, 223, 263
Bartz, Jeremy  1
Bastick, Liam  242
Baylis, Dave  212
BeatExcel  112
Bellevue, Washington  268
Benninga, Simon  1, 122
Berghaus Corporation  16, 78, 171
Bernath, Matthew  136, 137
Besse, Chelsea  ii, 102
Best_excel  212
Bezenšek, Mitja  134
Big Mac  106
Binary search algorithm  117
Bing  153
Birthday  103, 257
Bits of Confetti  16, 78, 92, 171
BizNetSoftware  120
Blessitt, Sean  224
Blockhead Data Consultants  16, 37, 92, 171
Bluefeather8989  208
Bob from accounting  231
Bonner, Caroline  60
Bonus formula  100
Boolean logic  101
Bork, Pia  258
Bott, Ed  91
BradEdgar.com  16, 37, 171
Brandt, Arnout  224
Breden, Melanie  58
Bricklin, Dan  124
Brighton  265
Broken link  231
Brown, Derek  58, 132
Browser View Options  72
Budget versus actual  81
Budget Wand  16, 78, 171
Bullets  221
Burkett, Lisa  224
BurkleHagen Studios  ii
Buy versus rent  170
Buzbee, Dawn Bjork  135
Byrne, Michael  136
Bоробьев, Александр  42

C
Caballero, Miguel  47
Café  92
Calibri  242
California Blazing Chile Farms  4, 114, 171
Call centers  254
Calleia Company  4, 7, 78, 171

Call for Help  252, 257
Cambia Factor  4, 92, 114, 171
Camera tool  62, 190
canalyze_it  213
Canes, Brian  96
Canton Ohio  98
Caps Lock

Removing  93
Captain Excel  134
Carey, Drew  119
Carmichael, D.  3
Carruthers, Sean  253
Car Talk  252
Cats  140
Cecilia  263
CELL  13
Cell styles  93

Modifying  21
CFO magazine  254
Chandoo  239, 250
Change all sheets  14
Chang, Roger  252
CHAR  139
Charles, Neil  136
Charts

Comparative scatter  32
Ctrl+T  53
Custom labels  63
Display in millions  27
in 1 Click  26
Paste new data  29
Pictographs  224
Remove data  30
Secondary axis  64
Sparklines  68
Two pie  224
Value from cells  63
with REPT  145

Check writer  211
Cher  2
Chicago Review Press  254
Chis, John  33
CHOOSE  195
Choos, Jimmy  168
Cinnamon syrup  232
Cintellis  134
Circ du cell A  242
Clarity Consultancy  37
Clark, Khalif John  224
Cleveland, Ohio  137
Clippy  228
Clock  257
Coblentz, Marion  98
COBOL  108
Coca-Cola  228
Cockerill, John  49
Cockpit simulator  255
Cocktail

Book  225
Dependent list  186

Collapse Ribbon  72
Collie, Rob  81, 85, 96, 195, 209, 237, 250
Colman, David  100, 214
Colo  263
Color Scale  122
Columbus, Indiana  90, 265
COLUMN  205, 257
Columns

Change sequence  35
Move  36

Comer, Steve  43
Comments

Format as shape  224
Comparative scatter chart  32
Compare

Lists  60
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Side by side  15
Worksheets  17

Computer America radio  vii
Conditional Formatting

Banded rows  223
for Duplicates  223
with Formula  143

Conditions, multiple  208
Consolidate  214
Constraints  125
Construction Intelligence & Analytics  4, 37
Contextures.com  48
Convert to range  192
Copy Here As Values Only  91
CopyMax  254
Copy worksheet  12
Cordell, Trace  35
Corpse Reviver  230
Corrie, N  35
Coulson, Jeffrey P.  60
COUNTA  174
Count distinct  80
COUNTIF  208
COUNTIFS  209
Count without COUNT  224
CPASelfStudy.com  16, 37, 58
CPE  255
Create relationship  79
Create Table dialog  50
Cross Country  254
CSE formula

for Unique values  212
CSV, save as to rid merged cells  223
Ctrl+`  136
Ctrl+.  134
Ctrl+’  137
Ctrl+[  136
Ctrl+*  135
Ctrl+1  118, 134
Ctrl+5  134
Ctrl+Arrow  134
Ctrl+B  138, 236
Ctrl+Backspace  135
Ctrl+C  138
Ctrl+D  3
Ctrl+Enter  135, 147
Ctrl+I  138
Ctrl+N  20, 138
Ctrl+PageDown  135
Ctrl+Shift+Enter  213
Ctrl+Shift+L  137
Ctrl+Spacebar  36
Ctrl+T  55, 138

for Chart data  52, 53
for Pivot data  49

Ctrl+U  138
Ctrl+V  138
Ctrl+W  137
Ctrl+X  138
CTroy  218
Culbertson, Aaron  96
Currency format  210
CurrentRegion  224
Custom lists  10
Custom number format  210
Custom sort  33

D
Dalgleish, Debra  48, 246
D'Amico, Bob  ii
Dan from Philly  47
Danny Moon Esq  152
Dashboarding  67
data2impact  4, 92
Data Automation Professionals  54
Data Consolidate  214

Data Model
Budget versus actual  81
for Top 10  47
Replaces VLOOKUP  78

Data Pig  236
DataSolverz.com  4
Data Table  120
Data Validation  171

can be defeated  176
Dependent  186
using Custom number format  211

DATEDIF  224
Date formatting codes  212
Date rollups in pivot table  41
Dates

Copy instead of fill  9
how Stored  103

Date stamp  135
DAX formula language  83
DAX on the beach  233
DAY  102
DeBartolo, Dick  253
de Bruin, Ron  137
DecisionModels.com  117
Decker, Joerg  193, 224
de Diego, José  134
Defaults

Providing in validation  182
Default settings  20
DeJonker, Tony  258
Delete all unsaved workbooks  26
Deloitte Canada  4
Denis, Othneil  15
Deo, Edwin  86, 132
designprovaction  ii
Developer tab  153, 154
Dietterick, Michael  37, 39
DiffEngineX  224
Ditto  137
DoctorSpreadsheet.com  277
DOLLAR  224
Domeyer, Mark  112
Double espresso  164
Double negative  105
Double underline  77
Dow, John  112
Doyle, Pete  157
Drag-race  243
Drawing with X/Y  224
Drill down in pivot table  224
Duplicates

Remove  82
with Cond. Formatting  223

Durran, John  60
du Soleil, Oz  195, 223, 242

E
Easter Sunday formula  224
EDATE  224
Edgar, Brad  212
Edit Directly in Cell  224
Edwards, Peter  224
Eikeland, Snorre  57
Ekim  106
Elementary Excel  254
Embed table in formula  115
Employee calendar  99
End-of-Table marker  50
Eonta, Karen  ii
Errors, suppress  207
Escobar, Miguel  129
Esquibel, Melissa  60, 195
Evaluate Formula  104
Exact match VLOOKUP  107
Excel4apps  4
Excel 2013 In Depth  258

Excel 2016  260
Excel by Joe  208
Excelcampus blog  194
Excel Design Solutions Ltd  4
Excelerator BI  4, 92
Excelfie  192, 243
Excelforo  135
Excel function clock  257
Excelicious Café  194
ExcelIsFun  78, 256
ExcelKOS  112
Excel libre  228
Excel master pin  256
ExcelNewss  134
Excel Strategies, LLC  4, 7
Excel Tables book  57
Excel team  268
Excel Team blog  262
Excel-Translator.de  16
Excelvis  243
Exponent  257
Export to spreadsheet  264
Extract uniques  212
EZIQ  264

F
F1 Key missing  93
F2 & Esc  92
F3  173
F4  86
F5  137
FACT  257
FACTDOUBLE  ix
Factorial  257
fairwinds  263
Falernum  235
Farmers market  98
Federice, Nancy  57
Feechan, Glen  89
File list with Power Query  127
File types  22
Fill blank cells

with 0  216
with value above  166

Fill down  3
Fill handle

Custom list  10
for a Series  8
for Formula copying  1
Right-click  10
with Ctrl  8, 259

Fill outline  166
Fill series of 100K  12
Fill weekdays  10, 96
Filter

by Selection  4
Color used headings  224
Visible sum  6

Filter Connections  70
FIND  13
Find & Replace formats  222
Fintega Financial Modelling  16, 41, 42, 219
Fishel, Shelley  3, 89
Fisher, Roger  60
Fishman, Justin  112, 208, 224
F-Keys Ltd  16, 37, 277
Flash Fill  206

after Consolidate  216
Flavor Flav  257
Fliss, Mike Dolan  96, 134
Ford, Mark  197
FORECAST.ETS  261
Forecast sheet  261
Forgot to save  23
Format as Table

before Data Model  78
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Format Cells dialog
Protection  118

Formula
Bar  244
Copying  1
Highlight all  92
Highlight with CF  224
in Slow motion  104
Protect  118
R1C1 in VBA  156
Select  118
to Values  90
Visualize  221

FORMULATEXT  19, 202
Foster, Colin  138
Fraley, Derek  37, 265
Frankston, Bob  124
Friday the 13th  102
Friendly names  149
Fries, Thomas  49, 135, 259
Frontline Systems  16, 42, 124
Fuentes, Freddy  259
Full screen

Open Excel as  223
Function Arguments dialog  94
Function clock  257
Fx icon  94
Fylstra, Dan  124, 195

G
Gainer, David  86, 132
Games in Excel  224
Gap, the  250
Garcia, Mario  49, 86
Garcia, Rob  129
Garcia, Yesenia  60, 195
Gardner, Alexa  134
Gay, Joy  235
GCD  257
General Electic  137
Germany  258
GetPivotData

Preventing  42, 74
Syntax  76
Uses for  74

Get & Transform  127
Giannotti, Tony  131
Gibson, Steve  253
Gieringer, Dietmar  258
Gilbert, Dawn  3, 35
Gilliland, Donna  112
Gilmer, Stephen  208
Ginger syrup  237
Girvin, Mike  100, 115, 129, 134, 136, 195, 212, 

213, 238
Glaser, Judy A.  86, 96
GL Wand  16, 210
Goal Seek  119, 168
Goldmeier, Jordan  146, 151, 195, 224, 250
Gonzalez, Juan Pablo  263
Google Docs  x
Go To dialog  167
Go To Special  40

Constants  93, 224
Formulas  93
Row Differences  224

Govier, Roger  132
Graceland  243
Grammar analogies  152
Grantham, Rick  49, 195
Grave accent (`)  92
Greatest common denominator  257
Green tea syrup  229
Greer, Olen L.  224
Gridlines  67

Hiding  72

Removing  142
Group and Outline buttons  37
Group dates  41
Group mode  14
Grove, Harlan  106
Guttman, Alex  242

H
Hager, David  137
Haggarty, David  86, 100
Hahner, Marcus  258
Hahn, Patty  112
Hangover cure  230
Hannelly, Paul  60
Hanschitz, Sabine  60
Hansen, Arly  132
Harlem Globetrotters  16, 42, 58, 265
Harriers  254
Harris, Matt  253
Hartville Marketplace  16, 37, 59, 98
Harvest Consulting  16
Harvest, Peter  60
Hatch Show Print  255
Hauser, Mark  264
Hauser, Ray  129, 167
Havermans, Alex  112
Hawley, Dave  263
Haworth, Jared  ii
Hazlett, Bill  136
Heffa100  136
Hemlin, Jean-Yves  58, 60
Hendrick’s gin  237
Henning, John  49, 112
Hepplewhite, Jonathan  132
Heyman, Greg  49
Hicks, Chris  167
Hidden cell, Selecting with F5  137
Hide Excel  72
Hide Ribbon  72
Hiding data with ;;;  211
Higbed, Jon  100
Hjortsjö, Carl  60
Holidays  96
Holy Macro! Books  254
Hooker, Carl R.  35
Hospitality industry  254
Hot, Jeneta  135
houdini, barry  263
Household Excel  254
HowToExcel  16, 210, 224
Huish, Scott  263
Human resources  254
Hybrid Software  16, 37

I
Icon Sets

Up/Down markers  61
Idora Park  125
IF  76, 100

for Icons  141
Nested  142
Nested versus lookup  114
with AND  100

IFERROR  207
IFNA  208
IIA  ix
IMA  ix
IMA Houston chapter  16, 37
Improv  253
Include Filtered Items  47
Independent Publishers Group  254
INDEX  19

Returning entire column  224
versus VLOOKUP  111
with :  219

INDEX/MATCH

VLOOKUP left  112
Indiegogo  v
INDIRECT  103, 179, 188
INDZARA  208
InfiniteDriffter  197
Insert Function icon  94
Insert key

Removing  93
Institute of Internal Auditors  255
Institute of Managerial Accountants  255
INT  257
Interest rate  95
Intersection  148
Interview, job  254
iPod  253
ISERR  207
ISERROR  207
ISNA  207
ISNUMBER  224
Italian leather slingbacks  168
iTrainerMX  77
iTunes  253

J
Jancsy, Dennis P.  49
Jazzy Vegan  182
Jelen, Bill  152, 251
Jelen, Mary Ellen  258
Jelen, Robert  86, 96, 235
JEVS Human Services  16, 42, 78
Jimmy Choos  168
Jitterbug Jelen  145, 235
Joe4  263
Johnson, James N.  132
Johnston, Barbara  167
Joiners  82
Join tables  78
Jones, Chris  157, 162
Jones, Sarah Lucia  ii, 24
Jonmo1  263
Juhasz, Szilvia  58, 59, 195
JulianExcelTips  134
Juliet Babcock-Hyde CPA  16, 37
justAjar Design Press  113

K
Kamimoto, Brian  266
Kardashian, Kim  243
Karpfen, Michael  60, 214
Kazmdav  5, 208
Kellett, Matt  134
Kennedy Space Center  130
Kent, Ohio  9
Kern, Gary  264
Khalilov, Elchin  134
Killeen, Jay  112
Killer formula  102
Kiriro, Nancy  251
Knowles, Don  57
Knutsford_admi  3
Kohl, Jerry  265
Kosmakos, Dawn  ii, 60
Kryuchkova, Olga  15, 29, 49, 93, 134, 135, 144, 

151, 207, 213, 224
K_Tizy55  162
Kuhn, Tanja  258

L
LaFrenier, Leonard  100
LaFrenier Sons Septic  16, 114
Lake Local School District  17, 210
Lane, Greg Lambert  3
Lanza, Richard B.  100
Lapajne, Andrej  134
Laporte, Leo  vii, 252, 257
LARGE  224
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Laugh track  157
Lazazzera, Mike  253
LCM  257
Leaf_xl  223
Least common multiple  257
Lee, DeLisa  49
Legg, Colin  89
Lehrbass, Kevin  60, 195
LEN  257
Lengyel, Bea  258
Lenovo  91
Leone, Marie  254
Lesko, Todd A.  96
Lewis, Laura  137, 167, 224
Lilley, Geoffrey G.  37, 39, 210
Linked Cell with Ctrl+[  136
Linked picture  62
Links, Finding  224
Loan payment  94, 170
Lobello Jr., Anthony J.  100
Locked property  118
Logan, Francis  3, 57
Logical test, multiplying by  101
Long, Crystal  134, 135
Long, Jeff  60
Loos, Celine  96
Lotus 1-2-3  ix, 124
Lucas, Martin  60
Lucerne, Switzerland  258
Lugh Information Services Consulting  54
Luhdorff, Mark E.  49, 58
Lutz, John T.  49
Luzern  258
Lynn, Audrey  106
Lythe, John  151

M
MacArthur, Amber  252
Mac, Danny  115
Mack, Chris  223
Macro

Deleting  159
Recording first  153
Shortcut key  154

Macro, Chris  250
Macro recorder  151
Madonna  2
Magic cell  44
Malik, Sagar  224
Manager 15 minute rule  13
Mann, Merlin  253
Mann, Mike  49
Mapping Excel data  129
Margins  21
Marriott, Dave  137
Martinez, Paul  167
Mary Maids  17, 114
MATCH versus VLOOKUP  110
Mathews, Emily  132, 214
Mattam Khalil  264
Matthews, Patrick  112
Mattiza, Shannon  ii
Matt’s Script Archive  263
Matz, Allen  209
MAU Workforce Solutions  17, 42
Maynard, Lynda  132
Mayoh, Dan  219
McCarthy, Patricia  40
McClellan, Robert S.  35, 86
McCready, Steve  134
McDonalds  242
McGunigale, Diana  49, 86
McLean, Ken  91
mdhExcel  224
Melbourne, Florida  235
Melrose  250

Melton, Beth  26
Meonske, Norm  12
Merged cells

for Sparklines  71
Remove by CSV  223

Merge Shapes  223
Merritt Island, Florida  130
Met, Melih  91
Mexican Coke  228
Michael, Colin  57, 81, 129
Microsoft  268
Microsoft Anna  133, 145
MID  13
Mika, Robert  2, 214
MikeAsHimself  208
Miller, Jade  2
Millers, Pedro  223
Millions  211

Chart display units  27
MIN  257
M is for (Data) Monkey  129
Mixed reference  87
MN Excel Consulting  17, 114
Moala, Ivan F.  263
MOD

for Easter  224
model_citizen  134
ModelOff  93, 219
Moede, James E.  57
Momrik, Al  223
MONTH  257
Months, filling  8, 10
Moon, Danny  203
Moore, Walter  ii
Move Columns  36
Move or Copy, alternative  12
MrExcel.com  17, 92

Consulting  54, 265
Multiple Consolidation Ranges  217
Multiplication table  164
Mvmcos  115
Myers, Bradford  138
myexcelonline.com  17
Myexcelonline.com  59, 114
MyOnlineTrainingHub.com  17, 92
MySpreadsheetLab  17, 58, 277

N
Name

Create from Selection  150, 187
Manager  182
Paste  136
Shift+Enter in  12

Named
Formulas  178
Ranges  149

NAND  101
Narcissists  163
NASA  130
Nashville, TN  255
Nassi Shneiderman diagrams  176
NateO  263
NeedForExcel  34
Netherlands  258
NETWORKDAYS  96
NETWORKDAYS.INTL  96
New Hope Laundry  17
New versus New...  22
New Window  17
NFL  ix
N function  105
Nichols, Nichelle  133
Njoko, Nathi  209
No fill  66
Non-contiguous cells  135
Norie  263

Normal distribution  243
NOT  101
Notepad formulas  224
Notre Dame  264
NPV Error  224
Number format

Keyboard shortcut  136
Numbers, filling  9
Nuss, Simon  2, 58

O
Oakland beer  238
OFFSET  224

versus INDEX  218
versus Tables  174

Ohio  251
Oldcorn, Richard  2, 209
Old Navy  250
Oliver, Nate  259, 263
Oluwa, Schmuel  134, 135
O'Mara, Tim  135
OneDrive  72
Open Sky Martial Arts  17, 37
Option Explicit  254
OR  101
Orange County Health Department  43, 92
Ortenberg, Michael  3
Osman, Abshir  209
Ozgur, Suat  263

P
PaddyD  263
Papal naming using ROMAN  ix
Parentheses color  114
Parkinson, Cat  224
Passwords are unreliable  118
Paste Name  173
Paste Options  18
Paste Special Formulas  77
Paste Values  90, 167
Patel, Keyur  57
Paterson, Jon  3
PDF

to Excel  221
PDF to Excel  132
Pearson Education  254
Peev, Igor  131
Pele  2
Peltier, Jon  134, 195
Penny pitching  122
Peppercorn & horseradish shrub  236
Personal Macro Workbook  158, 159
Peter_SSs  263
Peton, Paul  57
Petri, Dominik  258
Petrova, Boriana  115
Petry, Mike  112
Phare View Concepts  43
Phillips, Robert  2
Photos from Dropdown List  223
PI  257
Pie chart with two pies  224
Pierson, Scott  263
Pieterse, Jan Karel  221
Piñata  92
Pivot Power add-in  48
Pivot table

asterisk  47
Autofilter  45
Change Data Source  49
Compare lists  60
Count distinct  80
Count instead of sum  49
Data model  47
Date rollups  41
default layout  48



	 273 

I

Default theme  21
Drill down  224
for Dashboards  70
Grand totals  42
Group Field  41
Multiple Consolidation Ranges  217
New data  49
Number format  48
Refresh  51
Repeat All Item Labels  48
Replicate for each  58
Slicer Connections  70
Top 5  43
Value filters  43
with Data Model  78
with GetPivotData  77
Year-over-year  41

PMT  96, 257
Podcast, origins  253
Polakovic, Peter  2, 210
Pop out an array  104
Porat, Meni  151, 224
Portable formulas  83
Postelnik, Shlomi  2
Poulsom, Andrew  263
Power Map  129
Power Pivot

Add-in for 2010  80
Budget versus actual  81
Replaces VLOOKUP  78

Power Pivotini  234
PowerPivotPro.com  81
Power Query  127

to Rearrange columns  36
Unpivot  197

Poynter, Dan  254
Precedents  224
Present value  244
Price is Right, The  119
Price Waterhouse  101
Print Preview Full Screen  162
Prize  106
Probation date  99
Profology.com  43
Pro Football Hall of Fame  98
Program key  91
Promotion at work  256
Proper case  1
Protect formulas  118
Protection  176
Protect Sheet  118
PtrSafe  160
Publishers Weekly  254
Puls, Ken  129, 135, 195

Q
QAT  157
Quarters, filling  9
Quarter & year, filling  9
QUE  254
Quiceno, Alejandro  81
Quick Access Toolbar  161

Icons to add  162
Quick sum  223
Quilt patterns in Excel  255

R
Radakovitz, Sam  2, 7, 86
Raiff, Peter  135
RANDBETWEEN  92
Random selection  224
Random walk  122
Rayudu, P B.  39, 214
RC Columns  237
Recover unsaved workbooks  23
Reekers, Martijn  93

Relationships  82
Creating  79

Relative references  164
Remove Duplicates  82, 212
Rempel, Michael A.  167, 223
Rent versus buy  170
Repeat All Item Labels  48, 262
Repeat with F4  86
Reports Wand  42, 43, 58
REPT  145, 244
Resource Optimizer  43, 210
Reynolds, Micheal  96
Ribbon, collapse  72
Ribbon Commander Framework  43
Rieb, Cecelia  57, 96, 224
Right-click  138
Right-click key  91
Riley, Will  96
Ringstrom, David  39, 214, 223, 224
Roasted lime juice  228
Rock Bottom Brewery  268
Rocket launch  254
ROMAN  ix, 257
RoryA  263
Rose, Kevin  252
Rosenberger, Dave  265
Rosenkrantz, M.R.  60
Rosenstock, Bobby  113
Rosenthal, David  201
Rothschiller, Chad  207
Rothstein, Rick  263
Roto-Rooter  43
Routt, Michelle  ii
ROW  19, 102, 205
Row 2  256
Row differences

with Go To Special  224
Ruble, Scott  131
Running total  54

Sum for 1st row  54
Russel, Scott  209
Russian nesting dolls  205
Russo, Marco  195

S
Sadeq, Aiman  49
Safety Elements Ltd.  43
Salem Historical Society  17, 37, 210
Sales tax  86
San Francisco, CA  250, 252
Sasur, Paul  134
Sausage  180
Scale to Fit  20
Scatter chart  32
Scelba II, Victor E.  100, 214
Schiecke, Dieter  258
Schneider, Kai  258
School of hard knocks  151
Schulz, Todd  189
Screen Savers  252
Scrollbar maximums  223
Scrollbars, hiding  72
Seaman, Paul  26, 32
Search engine marketing  254
Search for a function  94
Seasonality  261
Securities and Exchange Commission  116
See all formulas  92, 136
Seeley, Michael  ii, 96, 214
Select all sheets  14
Select entire column  136
Select Formulas  118
Select non-contiguous  143
Select Visible Cells  162
Selfie  243
Serving Brevard Realty  42, 43, 131

Set As Default Chart  28
Settings, default  20
Shapes, Merge  223
Sharing Link  72
Shaw, Glenna  223
Sheet tabs, hiding  72
Sherraden, Jim  255
Shift+Drag  36
Shift+Enter with Name box  12
Shift+F11  137
Shivers, Joe & Paul  254
Shoe lovers  168
Show formulas  92
Show Report Filter Pages  58
Side by side

Compare  15
Sideways, turn  18
SIGN  61
Signals catalog  257
Simon, Sven  93, 135
Simon, Ute  60, 258
Simple syrup  233, 239
Simplex LP  125
Singh, Avi  85
Sitoy, Ryan  209
Skip Blanks  224
SkyWire, Inc.  43
Slicer Connections  70
Slicers  68
SlinkyRN  43
Slipstream  21
Slow motion formula  104
SmartArt  221
Smith, Chris  263
Smitty  263
Snap to grid  137
Solver  124, 170
Solvexia  277
Sorting

Custom  33
Left to right  35

Sort with a formula  224
Sound files  159
Spacing

using Custom number formats  211
Spain, Andrew  9, 60, 210, 259
Spain Enterprise  7, 37
Spanish  254
Sparklines  68
Sparkline swizzle  229
Speak Cells  132
Spearing sum  14
Spider  140
Sprakes, Wendy  29
Spreadsheet at 25, the  259
Sprebitz, Rene  167
SpringBoard  43, 114
Springfield, Missouri  37
SQM  22
SQRT  257
SQRTPI  ix
Sriracha salt  236
Stacked Column  232
St. Amant, Scott  117
Starl  263
Start screen  22
Status bar totals  223
Stay-at-Home Excel  254
Stent, Graham  49
Stephen, Eddie  100
Stewart-Seume, Bryony  91
Stop Recording  152
St. Peter's Prep  43
Strategic Finance  vii
Strever, Gerald  193
Strikethrough  134
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SUBTOTAL  7
Subtotals

Adding  37
Copying total rows  40
Filling text field  39
Formatting  40

Sullivan, Katie  60, 221
Sullivan, Kevin J.  37, 39, 210
Sullivan, Mike  3
SUMIF  208
SUMIFS  208
Summing visible  6
SUMPRODUCT  102, 209, 243
Sum through sheets  14
Super Bowl  ix
SurtenExcel.com  37, 43, 210
Susen, Peter  39
Svensen, Erik  214
Swinford, Echo  223
SydneyGeek  263
Symons  5, 208
Synchronous Scrolling  16
Syrstad, Tracy  3, 58, 152, 259, 263
Szabó, Kris  195, 196

T
Tableau  x, 176
Tables

Chart data  52
for Dynamic ranges  174
for Formula copy  2
for Pivot data  49
Running totals  54
versus OFFSET  174

Takher-Smith, Seren Kaur  3
Tallman, James  3, 214
Tarzia, Michael  112
Taylor, Ivana  254
TechTV  252
Telxon  264
Template for charts  28
Tennessee Moon  42, 43
Tequila  232
TEXT  82
Text numbers

Converting  137
Text to speech  163
TheExcelClub  157
Thehos, Andreas  3, 115, 258
The Lab with Leo  253
The Lab with Leo Crew  17, 58
Theme  21
This Week in Tech  253
Thomas, Chad  ii
Thousands  211
Three triangles  61
thrivebookstore.com  114
Tilde (~)  92
Time stamp  135
Tiny charts  68
TODAY  102
TomateCaolho  112
Tomato water ice  236
TOMORROW  179
Top 10 AutoFilter  46
Top 80%  44
Top level budget  81
Toronto, Ontario  252
Total all sheets  14
Total visible  6
Trailing spaces  108
TrainerTage  258
Transpose  164
TRANSPOSE  18
Transpose data  18
Treacy, Mynda  67, 195

Trebas, Jeremy  197
TRIM  13, 108
Triskaidekaphobia  102
Tropical Haven dance hall  235
Troy, Anne  v, 3, 86
True/False, multiplying  105
Tufte, Edward  71
Turn data sideways  18
Tweets  246
Twitter  246, 252

U
UDF in Hyperlink  224
Umlas, Bob  ii, 106, 136, 166, 231, 264
Ungroup sheets  14
Uniques, extracting  212
University of Akron  59, 251
University of North Carolina  17, 42, 210
Unpivot  197
Unsaved workbooks  23
Up/Down markers  61

V
Valley of the Dolls  151
Value from cells  63
Vance, Larry  3
Vancouver, British Columbia  253
van den Brink, Johan  136
Vanilla espresso-infused bourbon  238
Vanilla-infused aged rum  228, 239
VBA

CurrentRegion  224
Events  163
Launch with hyperlinks  224
macros  151
UserName  224

VB editor  155
Verschuuren, Gerard  265
Vertex42  6, 73, 114
Vertical bar  145
Very hidden  224
View new window  17
Visible cells  40
VisiCalc  ix, 124
VLOOKUP

binary search video  117
Changing 3rd argument  110
Embedding in name  180
Embed table  115
ends in False  107
Explained  106
Left of key  112
#N/A error  107
Numbers as text  109
Range match  114
Replace with Data Model  78
Sort by popularity  116
Sorted?  115
Speed  116
to Left  194
Trailing spaces  108
versus INDEX  148
versus MATCH  110
with True  114
with Wildcard  224

Vodka  229
VoG  263
Voice  133
Volatile

OFFSET  218
von der Heyden, Jon  263
Von Pookie  263
Vukas, Bernard  193

W
Wade, Darrell  167

Wag More Dog Store  17, 38, 210
Walkenbach, John  152, 158
Walker, Andew  137
Walker, Andy  253
Walsh, Anne  17, 195
Wärnelid, Rickard  3, 137
Waterfall chart  260
Waterton, Alex  3
Weaver, Adam  3
Web App  72
Webster, Russell  3
WEEKDAY  102
Weekdays, filling  10
We Report Space  254
Wernick, Jonathan  3
What-If, using Data Table  120
White, Steven  106, 167
Whyte, Gavin  135
Wildcard VLOOKUP  224
Wilde XL Solutions Ltd.  7, 17, 42, 176
Wilkin, Shirlene  189
Williams, Charles  117
Williams, James  3
Williams, Tracia  19
Wilson, Kitty  ii
Wilson, Ryan  1, 73, 195
Wingdings  139
Wirtz, Billy C.  254
Wirz, Patrick  1, 3
Wisse, John C.  1, 2
Wittwer, Jon  73, 120, 224
WM Squared Inc.  17, 42
WordArt  242
Word wrap with Alt+Enter  136
Work calendar  99
WORKDAY.INTL  96
Worksheet copy  12
Worksheet name from formula  13
Wrestling memoir  254
Wright, Paul  224
WSJ stock chart labels  212
WSLCB  17
WWWBoard  263
www.ExcelTricks.de  17, 42

X
XLSB opens faster  22
XLStudioWorks  134
xlVeryHidden  224
XLYOURFINANCES, LLC  17, 59
XOR  101
X-Y chart  32

Y
Year-over-year  41

in Chart  63
Year & quarter

Filling  9
Years, filling  10
Yesenita  17, 210
YESTERDAY  178
Young, Colleen  224
Youngman, Henny  242
YouTube  252, 253

Z
Zelany, Nathan  89
zenou  263
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Excel Classifieds / Excel Resources

Customized training, automation, data and document solutions in MS 
Office including VBA. Visit SpainEnterprise.com or call (256) 384-5324.

World’s most powerful Excel manipulation tool.  
NOT FOR THE MEEK.  
Visit www.solvexia.com for further details.

For The Health of Your Business  
“Talk To The Doc!”  
DoctorSpreadsheet.com

F-Keys Ltd – Microsoft Training and Exam Centre,  
Canterbury Kent UK Tel: +44 (0) 1634 512345  
www.f-keys.co.uk working smarter not longer.”

Smart Tech for Hard Workers…  We take Project Controls to new heights, 
by integrating the data you already collect, to help you make better-in-
formed decisions! Construction Intelligence & Analytics www.cia.nyc

Subscribe to my YouTube channel and learn  
how to solve data puzzles in Excel.  
https://www.youtube.com/user/MySpreadsheetLab

If you need a way to track business expenses, but don't need the head-
aches of Quickbooks or Peachtree, check out profitspreadsheets.com

Easy-XL enables casual Excellers to summarize, pivot, merge, match, 
combine, split, slice and dice data like a pro. www.Easy-XL.com

Thanks Bill for being at Office Trainertage 
Tanja Kuhn 
KUHN INFORMATIK AG, www.kuhninfo.ch 
Schulung und Programmierung für Microsoft Office



 

 

 

 

 

Do you need to learn Microsoft Excel? We have dozens of video 
tutorials to teach you how to become an expert with Excel in 
no time.  
 
Our lessons are presented by Richard 
Rost, a Microsoft MVP and author of The 
Complete Idiot’s Guide to Excel 2010. 
 
Use this special link to watch our Level 1 
Excel lesson absolutely FREE of charge: 
http://599cd.com/XMRXL 
 
In addition to Excel, we also have lessons available for 
Windows, Word, our specialty, Microsoft Access, and lots 
more.  
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